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System Requirements 
AlbumGen will run on Windows 32 or 64-bit versions, starting with Windows Vista 

and up to the current Windows version 11. For Windows Vista, Service Pack 2 is 

required to be installed. Windows XP is not supported. 

A minimum of 2 GB of memory is required. It’s recommended that your video card 

support at least the common laptop screen size of 1366 x 768 and the minimum 

monitor screen size of 1280 x 1024. A screen size of 1920 x 1080 will provide a 

better workspace environment when working with album pages. 

AlbumGen requires a minimum of 80 MB of disk space to perform the installation, 

including retention of the original installation package after the setup is completed. 

Album files will require additional disk space, however the size of a typical album 

file in the version 3 format will typically be less then 0.5 MB in size per album. 

Adobe Acrobat Reader (or a similar PDF viewer) is required to display the user 

guide. 

A printer capable of handling the selected page size of the album pages will be 

needed to be able to print albums. 

Microsoft .NET Framework version 4.5 or later must be installed on your PC. If you 

need to update your version of the framework, you may do so via the following 

link: 

https://dotnet.microsoft.com/en-us/download/dotnet-framework 

An internet connection is required to register/activate a trial version of AlbumGen 

or to download any application update packages. 

Additional Online Help 
The SoftPro website will be regularly updated with the latest information and 

updates to AlbumGen including online video tutorials to guide you through common 

tasks in AlbumGen. 

 

SoftPro also maintains a FAQ (Frequently Asked Questions) page on the website. 

 

https://ezstamp.com/support/albumgen-frequently-asked-questions-faq/ 

 

  

https://dotnet.microsoft.com/en-us/download/dotnet-framework
https://ezstamp.com/support/albumgen-frequently-asked-questions-faq/
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Support, Questions and Comments 
Technical Support: Many of the most commonly asked questions about our products 

are available on our website in the FAQ (Frequently Asked Questions) or Support 

pages at https://ezstamp.com. If you still have questions after having read the 

product manuals, guides or on-line help, please contact us.  We welcome any 

questions, comments or suggestions you may have about our products. Customer 

service and prompt attention to your needs is a priority at SoftPro. 

Telephone / Fax  705-254-6201        

Mailing Address  SoftPro 2010 Inc.  

118 Palomino Dr.  

Sault Ste. Marie, Ontario  

Canada  P6A 0B2   

Questions / Support mariost22@gmail.com  or  staff@ezstamp.com  

Priority Remote Support 
Upon request, we are pleased to offer Remote Support which allows us to establish 

a secure, remote connection into your PC & assist you in solving problems or 

questions you may have. This can also be used as a training session to demonstrate 

how to perform certain functions or show you how to use our software more 

effectively.  

Here's how it works.   

• Contact us and ask for Priority Remote Support. We will set up a time, 

usually right away. You MUST have internet access to use this service. Once 

the Remote Control Software is installed on your PC, you will be provided 

with a user ID & password for this session. We will need these codes to 

initiate the session 

• We will contact you via phone or email, & then we will take control of your PC 

to solve issues or demonstrate what you need help with. You will be able to 

watch everything we do and ask any questions that you may have. You can 

close the connection at any time.  

• Is this safe and secure?   Absolutely. The entire connection is encrypted and 

safe and used by large corporations worldwide.  

• To initiate a Priority Remote Support session, please call us at 705-254-6201        

or email us at mariost22@gmail.com 

  

https://ezstamp.com/
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AlbumGen Installation 
AlbumGen may be provided on physical media or a downloadable self-extracting 

archive. If provided as the latter format, you will need to first extract the AlbumGen 

deployment files to a temporary location and then run the setup application. The 

downloadable AlbumGen package is named Agen3Installer.exe. When you run 

this program, you will see a simple window with an extraction path for the 

installation files, which you may change to any location via the Browse button. 

 

 

When the extraction is complete, navigate to the file extract location and execute 

the program file named AGen3Setup.exe. 
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Depending on your Windows security settings and/or any software with security 

monitoring for application installations (i.e. Antivirus software), you may be 

prompted to allow the setup application to be launched. 

 

 

The setup process uses 3 steps which are navigated via the Back and Next 

buttons. These steps are summarized below. 

Installation Location 
Use the Browse button or type in a new location if you would like to set a path 

other than the default one assigned by the setup application. The default location is 

consistent with other applications provided by SoftPro such as EzStamp and EzCoin. 

Backup Path and Album Files 
There are two locations defined for album backup files (local backups as opposed to 

Cloud backups) and for the version 3 album files. For version 2 users of AlbumGen, 

this location should not be same one used for your version 2 AGP album files. Both 

locations can be changed at any time within the AlbumGen application after 

installation. 

Confirming Installation 
You will start the installation by clicking on the Install button. Once installed, you 

will have options to view a small “read me” file and create a Desktop shortcut. 
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Existing AlbumGen Installation Options 
When running the setup application, a check is made if an existing version of 

AlbumGen (version 3 or higher) exists on your PC. If one is detected, an additional 

window with 4 options will be provided. 

Reinstall AlbumGen and Keep Settings 

The current application files will be replaced with the version from the installation 

package. Keep in mind that if you have downloaded online updates from SoftPro, 

you may possibly install on older version of AlbumGen. 

Clean Reinstallation 

This option will remove all current configuration settings which you may have 

changed to customize the default behavior of AlbumGen. 

Remove AlbumGen 

This option removes AlbumGen from your PC. Any existing album files will not be 

removed. 

Extend the Trial Period 

AlbumGen is provided as a free demonstration version with a limited trial period of 

30 days. If you wish to continue to use the application in the demonstration mode 

for another 30 days, you must contact SoftPro to request an extension. Once the 

extension is granted, you must have an active internet connection and provide your 

email address in the setup application when prompted to complete the trial period 

extension. 

Trial Period and Product Registration 
A new installation of AlbumGen is provided as a demonstration version. This is the 

same installation for a fully registered version of the application. You will need to 

provide an activation code from SoftPro to register AlbumGen. This registration 

process requires an internet connection. 

The following list summarizes the differences between a demonstration and 

registered version of AlbumGen. 

• Backup archives created with the trial version may not be restored or created 

with a registered version of AlbumGen or vice versa. 

• Album files created with the trial version may not be opened with a 

registered version of AlbumGen or vice versa. 

• Cloud backup services may not be used with a trial version. 

• Trial albums are limited to 10 pages per album file. 

• Free application updates are only available to the registered version. 

The trial period lasts for 30 days from the time of installation. If you require 

additional time to evaluate the trial version, you must contact SoftPro. After 30 

days, most application options will be disabled. 
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Product Activation 
A new installation of AlbumGen is provided as a demonstration version. This is the 

same installation for a fully registered version of the application. You will need to 

provide an activation code from SoftPro to register AlbumGen. This registration 

process requires an internet connection. A 16-character registration code (in 4 

parts) will have been provided to you. Access the activation window using the 

following menu option in AlbumGen. 
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This will present the window below. Please enter the following 3 items of 

information: 

• The 16-character registration product key. 

• Your email address. The email address you use is tied to your AlbumGen 

registration with SoftPro and must be the same one you provided SoftPro 

when requesting the product key. 

• Any password of your choosing. Please do not share this password with 

anyone else. You must enter it twice to mitigate any typing errors. 

 

Note that an internet connection is required to register your AlbumGen registration 

profile with SoftPro. 
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Trial Period and Expiration 
The trial period for AlbumGen is 30 days from the time of installation. Once the 30 

days has passed, you will see the following window: 

 

You will either need to register AlbumGen with a valid product key, or request an 

extension on the trial evaluation period by submitting a request to SoftPro. 

Extending the trial period is done via the AlbumGen setup application and can only 

be done once SoftPro has granted a trial period extension. 
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Registration Update 
If you have any issues with starting AlbumGen related to invalid product 

registration, you may try and re-register your product key, using the AlbumGen 

Registration Update option from the Help menu. 

 

The existing product key may be changed if necessary, and the email address and 

password must be re-entered. SoftPro may have updated your registration profile 

for AlbumGen to assist with this issue, so you may need to confirm the product key 

and email address first. 
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Application Updates 
SoftPro may issue periodic updates for enhancements and/or bug fixes. You may 

receive an update reminder that an update is available for download, provided you 

have an active internet connection. 

You can check for any updates using the Check for Updates option from the Help 

menu. 

 

Click on the Check button to verify if any new update content is available for 

download. If there is new content, click on the Notes button to see the summary of 

this new content. 

The Patch Version, Issue Date and Download size will contain information for this 

content update. 

Click on the Update button to start the download process. Once completed, the 

AlbumGen application will be closed and the update application will be started. The 

update application will display the current patch notes and provide a button to 

apply the update. 
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AlbumGen Help System 
AlbumGen application help is provided as both a PDF user guide (this document) 

and context-sensitive help in most application windows. 

Main User Guide 
The main user guide, which is this document, is provided as a PDF reference and 

accessed from the AlbumGen PDF Reference option from the Help menu. 

Window Context Help 
Context-sensitive help is by application window. Most dialog windows in AlbumGen 

will have similar content to the AlbumGen PDF document, specifically targeted to 

the window activities. Access to this context-level help is done via a menu option as 

shown below, or for windows which have no menu choices, by pressing the F1 key. 

Some of the simpler windows in AlbumGen will not offer context-sensitive help. 
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AlbumGen Workspace 
When you launch AlbumGen, the main application window will appear as shown 

below. This will be referred to as the album workspace in other help topics and 

always implies the main AlbumGen screen and the area within this window 

containing the current page content of an album file. 

 

The main workspace window is composed of the following areas: 

1. Title bar – shows the open album file with optional description. 

2. Application menu bar. 

3. Top toolbar – this button group may not be customized. 

4. Side toolbar – this button group can be customized. 

5. Alignment options window – 1 of 7 possible floating windows. 

6. Information status bar. 

7. The workspace for album pages. 

 

Application Title Bar 

The title bar contains the name of the album file by default. To add the album 

description to the title bar, enable the description option in the AlbumGen General 

Settings window. 

If an album file contains pending changes to save, an asterisk will appear to the left 

of the album name. 

  

file:///F:/SoftPro/AlbumGen3/HELP/2023-02-02/Pages/General%20Settings.htm
file:///F:/SoftPro/AlbumGen3/HELP/2023-02-02/Pages/General%20Settings.htm
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Menu Bar 
The main AlbumGen menu strip provides access to menu and keyboard shortcuts 

for most tasks when working with albums. All menu choices are assigned a letter 

for keyboard access once the menu is accessed via the Alt key. Example: Hold 

down Alt and press F then O to open an album from the file menu’s Open Album 

option. Your version of Windows may have the underscore not displayed under the 

key letter for access. In Windows 10 for example, you would need to turn on the 

underline access keys as shown in the screen sample above as per the Windows 

Keyboard settings below: 
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Top Toolbar 
The top toolbar contains shortcut buttons for the most frequently accessed tasks. 

This toolbar may not be customized. The following actions are provided in this tool 

along with the associated default keyboard shortcut. 

Right click on any active button in the toolbar for a popup help summary window, 

which will show the current keyboard shortcut in case it’s been changed from the 

default value. 

Button Action Shortcut Description 

 

Open Ctrl + O Open an album file. 

 

Save Ctrl + S Save album changes. 

 

Print Ctrl + P Print album pages. 

 

Undo Ctrl + Z Undo last change. 

 

Redo Ctrl + Shift + Z Redo last change. 

 

Insert 
Page 

Shift + Ins Insert a new page 

 

Copy Ctrl + C Copy selected objects to the Windows clipboard. 

 

Cut Ctrl + X Copy selected objects to the Windows clipboard and 
remove them from the page. 

 

Paste Ctrl + V Paste page or object content from the Windows 
clipboard. 

 

Zoom 

Tool 

Z Enable or disable Zoom mode. 

 

Pan 
Tool 

X Enable or disable Pan mode. 

 

Set Zoom n/a Set a custom magnification zoom level. 

 

Position 
Size 

Shift + L View or set selected object location and size properties. 

 

Properties Shift + P View or set selected object general properties. 

 

Text 
Content 

Shift + T View or set selected object text properties. 

 

Image 
Link 

Shift + I View or set Image link properties for selected shape or 
image objects. 

 

Page 
Setup 

Shift + F3 View or modify Page setup properties 

 

Settings n/a Show the Context menu for application setting options. 

 

Preview Ctrl + 1, 2, 3 Show the Context menu for page preview options. 

 

First Page Ctrl + Home Go to the first page in the album. If the cover page is 
enabled, the cover page will be displayed. 

 

Previous 
Page 

Ctrl + Page Up Go to the previous page. 
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Button Action Shortcut Description 

 

Go To 

Page 

Shift + G Go to a specific page. 

 

Next Page Ctrl + Page Down Go to the next page. 

 

Last Page Ctrl + End Go to the last page in the album. 

 

Page 

Comments 

Shift + C View or change the page name, bookmark or comments. 

 

Object 
Comments 

 View or change the selected object name, bookmark or 
comments. 

 

Help F1 Display this document with the associated PDF document 
viewer on your PC. 

 

Side Toolbar 
The side toolbar contains additional shortcut buttons and closely resembles the 

same side toolbar from version 2 of AlbumGen. This toolbar may be customized as 

needed with different custom button sets. The default set of actions are shown 

below. 

Button Action Shortcut Description 

 

New 
Rectangle 

R These 6 objects are shape types. Aside from the shape of 
the border style, the remaining attributes are the same. 
 
A polygon is a special case where you choose the number 
of sides (3, 4, 5, 6 or 8) is a regular or irregular format. 
 
The first 5 shapes remain in AlbumGen for backward 

compatibility with version 2 album files. 

 

New 
Diamond 

D 

 

New 
Ellipse 

E 

 

New 

Triangle 

A 

 

New 
Inverted 
Triangle 

Shift + A 

 

New 
Polygon 

Y 

 

New 

Text 

T This type consists of one or more lines of text with both 

horizontal and vertical alignment. Text content can 
contain multiple fonts, colors and sizes. A text object 
may only be rotated at 90 degree angles. 

 

New 
Paragraph 

P Paragraphs are similar to text objects except that the 
text content is contained in a border frame. Paragraph 

text is justified and filled to fit inside this frame, which 
can contain an optional border style. 

 

New 
Label 

L Labels are simple one line text objects, which can only 
use a single font, color and size. A label can be rotated at 
any angle. 

 

New 
Horizontal 
Line 

H Horizontal and vertical lines are based on pattern styles 
which are drawn either horizontally or vertically. They 
may contain multiple colors and are based on templates 
chosen from a style list which can be customized for 
additional styles. 

 

New 
Vertical 

Line 

V 

 

New 
Plain 
Line 

N This is a single line format for a solid or dashed style, 
using one color with various types of line endings. Plain 
lines can be rotated at any angle. 
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Button Action Shortcut Description 

 

New 

Image 

I This is a simple container for an image. The image object 

may be rotated at any angle. 

 

New 
Table 

Ctrl + Shift + T A table is a grid of text cells in row and column format. 
Tables are not to be confused with a spreadsheet where 
the cell content can contain formulas and calculations can 

be performed on individual cells. The table is just a 
container for text in a grid format. 

 

New 
Object 
Group 

Shift + S Create a new group of objects from the current selected 
object. Only applies to shape types and paragraphs. 

 

Placement 
Settings 

S Customize the settings per object for placement, resizing 
and movement. 

 

Replace 
Attributes 

Shift + R Choose one or more object attributes from a selected 
object to apply to other selected objects of the same 

type. 

 

Bookmark 
Objects 

B Bookmark selected objects. Any selected objects which 
are already marked will be unmarked. 

 

Nudge Directional Arrow 
Keys 

The 8 directional arrow buttons will move the selected 
objects by the nudge amount. 

 

Nudge 
Amount 

n/a Sets the incremental movement amount for the 8 
directional arrow buttons to nudge selected objects. 

 

Alignment 

Window 

n/a Show or hide the object alignment window. 

 

Page 
Navigation 
Window 

n/a Show or hide the page navigation window. 

 

Shape 
Attribute 
Window 

n/a Show or hide the shape attribute adjustment window. 

 

Object Info 
Window 

n/a Show or hide the selected object information window. 

 

Thumbnail 
Window 

n/a Show or hide the page thumbnail preview window. 

 

Search 
Results 
Window 

n/a Show or hide the page/object search results window. 
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Album Workspace 
The main workspace for album pages is initially blank. You will need to create a 

new album or open an existing album. Unlike version 2 of AlbumGen, a default 

unnamed album is not created for you. 

Status Bar 
The status bar at the bottom will only show content when an album file is opened, 

when you hover over a toolbar button, or are selecting options from the menu.  

Busy Indicator 

The small colored box at the very left will be green when AlbumGen is not currently 

performing any task which would otherwise prevent you from running a new task. 

For example, displaying a new page with many large images may take a few 

seconds before the page can be fully displayed. When a task is running which may 

take time to complete, this indicator will flash in shades of red. 

Current and Total Pages 

The next indicator is the current page displayed and total pages in the album. You 

may click on this indicator with the mouse as a shortcut to the page selection dialog 

window. 

Current Zoom Level 

This is the current zoom factor for page display. The value can range from 10 to 

2400 percent. You may click on this indicator as a shortcut to the custom zoom 

selection dialog window. 

Mouse Position 

The mouse cursor position is display in either inches or millimeters, depending on 

the Display Units value from the Options menu: 

 

Button or Menu Help Hint 

When you hover over a toolbar button or move through the main menu choices, a 

help hint summary message will appear in the status bar. 
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Object Off Page Indicator 

AlbumGen allows objects to be placed up to one page width or page height off the 

page to allow for extra workspace area to compose page content. Objects off the 

page will not prevent an album page from being printed – they simply will not 

appear on the printed page. 

 

If you click on the Off Page indicator, you will see a confirmation message to 

position any off-page objects to the top left corner of the page. 

 

If you confirm this message, all off-page objects will be positioned at the 0,0 page 

origin. 

Objects are considered off page if their position coordinate is outside the page 

bounds. Depending on the type of object and any applicable alignment (i.e., Text 

Objects), the objects area may be partially on the page and would not necessarily 

be off the page. 

Non-Printing Page Objects 

Any object on the page can be set to a non-printing status. When set, these objects 

will not appear on printed pages. They will also not appear on any page preview 

window unless you enable an option in the AlbumGen General Settings. If you 

click on the “NP” indicator, this will select all the non-printing objects. 
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AlbumGen Album Files 
Version 3 of AlbumGen uses a new file format different from album files from 

version 2 of the application. You will need to upgrade any version 2 albums to the 

new format and add them to AlbumGen 3 before you can open them. Refer to the 

Upgrading Version 2 Albums section. 

Album files are composed of 1 or more pages of content. 

A page contains specific attributes such as border styles, header and footer areas 

and a size with an orientation. Each page may have it’s own size and orientation 

and all other attributes may be different from any other page. 

In version 3, you may also enable a cover page and a table of contents. 

Each page may contain one or more objects from the available types listed below: 

• Shapes (Rectangle, Triangle, Diamond, Ellipse, Polygon) 

• Paragraphs 

• Multiline Text 

• Horizontal and Vertical Pattern Lines 

• Images 

• Labels 

• Plain Lines 

• Tables 

The first 4 bulleted types are the same as in version 2 of AlbumGen (polygons are a 

version 3 enhancement). The remaining 4 types are new to AlbumGen. 

Version 2 album files are always assumed to be located in the Albums subfolder 

where the application is installed. 

In Version 3, album files are stored within a default location under your Windows 

Documents folder based on the current user logged into your PC. You may change 

this album location using the File Locations application settings option. 

Version 2 album files use an extension of .AGP. Version 3 album files use an 

extension of .AGPX. These two formats are not compatible with each other. To 

open a version 2 album file, you will need to use the Upgrade Albums option from 

the file menu. 
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Creating a New Album 
Use the New Album option from the File menu to create a new album with a 

single blank page. 

 

All fields are optional except for the album file name. You are not required to enter 

the file extension of .AGPX, as this will be automatically added when the album is 

created. 

Descriptions are optional but recommended, as this additional field of information 

will be visible in various windows such as the browsing history. 

The Save To location is the value set when you ran the AlbumGen installation, and 

will default to a folder within your local documents location. You may change this 

location using the Browse button or from the AlbumGen File Locations settings 

option. 

Passwords can protect your document from being opened or modified by others. 

You should take care with passwords – SoftPro will not be able to provide you the 

password to any album file in case you forget it. However SoftPro can remove the 

password for you on request if this situation should arise. 

The remaining fields are optional, and are carried forward from version 2 of 

AlbumGen album files. 

Cover pages can be enabled via the check box at the bottom. If you forget to check 

this option when creating a new album, you can enable or disable a cover page at 

any time. 

  



AlbumGen 3 User Guide  P a g e  | 21 

Once you click on OK, the initial page setup window will be shown. You may change 

any of the default settings for the first page. Any changes you make to the page 

setup will automatically be used the next time you add new pages to an existing 

album or create new albums. 

 

The default page after a fresh installation of AlbumGen 3 will set a new page as 

follows: 

• Letter size paper (8.5 by 11 inches), portrait orientation. 

• One inch borders except for the right edge, which will be ½ inch. 

• An inside border of 5 millimeters to be consistent with AlbumGen version 2. 

• Header and footer size of ½ inch. 

• No title text areas defined. 

• A single line border style with a weight of 3/300 inch. 

For users of AlbumGen 2, the page border weight was defined as a value from 1-4, 

where 1 = 3/300 inch and 4 = 6/300 inch. Version 3 of AlbumGen allows the border 

weight to go to smaller weights of 1/300 and 2/300 inch. 
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Opening Existing Albums 
There are several ways album files can be opened. 

Open File Dialog 

Open an album file using the Open Album option from the File menu. This 

provides a standard Windows file browser dialog where the initial location is always 

the album file path defined in the AlbumGen File Locations settings window. 

All album files will have an extension of .AGPX. You may not open version 2 

AlbumGen album files (extension .AGP) with version 3. You must use the Upgrade 

Albums option to convert version 2 album files to version 3. 

Album History Browser 

Use the Browse Albums option from the File menu to view all recent albums 

opened in AlbumGen. This is an historical chronological list of album files that have 

been opened, as opposed to every album file from every file location from where 

you may have accessed an album file. 

Recent Albums List 

AlbumGen will show up to 8 of the most recently opened album files from the File 

menu. 

 

The recent file history can be up to 1,000 files in size. Any additional album files 

can be viewed or modified from the Recent Files Opened menu option shown in 

the sample above. Use the Clear List option to remove the recent file list. Note 

that the browsing history accessed from the Browse Albums option is not related 

to the Recent Files Opened list. 

Reverting all Changes 

The Revert option from the File menu will discard all changes made to the album 

file since the last save was made. This restores the album state to the last saved 

version. 
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Album Recovery 
Album files can be automatically saved and recovered by two methods based on the 

Album Backups settings from the Options menu: 

 

 

Auto-Save for Recovery 

This setting is enabled by default based on 10 minute intervals without any change 

activity on the current open album. If you make one or more changes, an automatic 

save to a temporary backup album file will be made every 10 minutes, unless you 

resave the file changes yourself. When you save changes, this file is removed until 

10 more minutes passes during which one or more changes are made. If you make 

no changes to an album file, then the automatic save will never occur. 

This type of automatic save is intended to allow for recovery of your changes in 

case of unexpected closure of the AlbumGen application, such as a power loss. 

When AlbumGen is started, a check for any auto-recovery albums is made. A 

window will be presented with an option to recover or delete the automatic backup. 

The recovery will not be restored on top of the original album file, but instead have 

a restoration sequence added to the end, as shown in the restored album name in 

the title bar: 
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You must select each album file in the list, and choose either the Restore or 

Discard option, then click on the OK button. 

Unless you are running 2 or more copies of AlbumGen at the same time, with 

changes pending on multiple album files, you will never see more than one auto-

recovery album at a time. 

You can disable this feature or change the time interval from the Album Backup 

settings window. 

Auto Backups 

This feature is also enabled by default, with an 8 hour time window between 

performing an automatic backup. This option allows you to keep from 1 to 10 

backups of an album file under a reserved subfolder where the original album 

resides. The subfolder is always named __BAK__ with 2 lead and trailing 

underscores. An auto-backup album file will have a different file extension of the 

letter “B” followed by a 2 digit backup number, where B01 is the most recent 

backup. 

The way the auto backup system works is based on when you open a given album 

file. Once you open a file, a check for any previous auto-backup file is made. If 

there is no backup file, then a new one is automatically placed into the __BAK__ 

folder with an extension of .B01. If an existing backup for .B01 is detected, the 

elapsed time between current and time of that backup is measured. If it meets or 

exceeds the backup window, then the current B01 backup is replaced with a new 

version. If only one automatic backup level is used, then the B01 file will simply be 

replaced any time 8 hours or more has elapsed between opening that album file. 
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If more then one backup level is used, then the backups are cycled in a series. An 

example best illustrates this. Assume the settings are for 3 automatic backups 8 

hours apart. And start with a first time open of an album file. 

First album open on September 12 @ 8 AM 

__BAK__ will contain an album with extension .B01 with the timestamp 9/12 8:00. 

Album opened again September 12 @ 1:30 PM 

No changes to the backup as only 5.5 hours has elapsed against the .B01 file. 

Album opened again September 12 @ 9:45 PM 

Since 13 hours and 45 minutes has elapsed since the .B01 file was created, a new 

auto-backup will be generated. 

The .B01 file will be moved to a .B02 file, still with the timestamp of 9/12 8:00. 

A .B01 file is created from the album opened at 9:45PM. The __BAK__ folder will 

now contain 2 backup files. 

Album opened again September 13 @ 10 AM 

The .B02 will be moved to a .B03 file, the .B01 file will be moved to a .B02 file and 

a new .B01 will be created based on the album opened. 

Album opened again September 14 @ 2:30 PM 

Since the limit is 3 auto-backup files, the .B03 file, which is the oldest backup, will 

be deleted and the other files will cycle to new version of .B01, .B02 and .B03. 

Deleted auto-backups are physically removed from your PC – they do not end up 

gathering space in the Windows Recycle Bin. 

Note that this series of backups assumes that the album file content has changed 

each time. A check is always made on the album content before generating an 

auto-backup. If the content doesn’t change from the most recent backup, then no 

new backup is generated. 

Restoring an automatic backup can be done from the Restore an Auto-Backup 

option from the Utilities menu. 

Saving Changes 

Pending Changes Indicator 

When you make a change to the album, an asterisk will be placed to the left of 

album name in the application title bar. When you choose the Save or Save As 

option from the File menu, the asterisk will no longer appear. 

Renaming Albums 
You are free to rename an album from outside the AlbumGen application using any 

application such a File Explorer. However, the browsing history will lose track of the 

album, along with the recent file history and this will cause them to be removed 

from either of those file lists. If you rename an album using the Properties option 

from the File menu, then the browsing history and/or recent file list entries will be 

updated accordingly. 
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Deleting Albums 

You may remove albums from outside of the AlbumGen application, but the same 

condition will arise as with renaming albums when pertaining to the browsing 

history and recent file lists. You should remove albums using the Album Browser 

window, but this is not mandatory. 

Album Browser 
This option is available using the Browse Albums option from the File menu. 

 

It shows recent accessed files with a specific sort order, as indicated by the field 

header in a contrasting background color, in this case white on black. 

Clicking on any of the field headers will sort the album list on that column. Clicking 

a second time on the same column reverses the sort order. 

The field columns shown in the album list are summarized as follows: 

File The name of the album file 

Description The optional description 

Size The size of the file 

Version The content format version of the album file. AlbumGen can 
open any version starting with 3.0 as long as the application is 

regularly updated to handle versions higher  than 3.0. 

Opened When this album was last opened in AlbumGen. 

Created When the album was first created. 

Modified When the album last had at least one change saved. 

Pages The number of album pages, not including the cover page or any 

table of contents. 
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Images The number of image links across all pages. Images are not 

stored in album files – only the location and name of the image 
is stored. 

Pwd This is an indication if an album is protected by a password. 

Comments This is an indication if the album contains summary comments. 

Location This is where the album currently resides on your PC. The 
browsing history keeps track of all locations where an album was 

opened from. 

 

If you have never opened an album file or you manually copied an album to a folder 

outside of AlbumGen, it’s possible that some of the fields will not contain album 

information: 

• Album creation date 

• Album last opened date 

• Number of pages and image links 

• Version of the album file format 

• Description 

This information is stored as part of the album history for each file and is obtained 

from opening the album file. By using the Refresh option in the browser, all of this 

information will be updated by opening each album file. 

The exception is the Opened value. This value is stored with the browsing history, 

and until an album is opened, it’s marked as “Never” opened. If you remove an 

album from the history (without removing the album file) and later refresh the list 

so that it appears again, it will once again show as Never opened. If you want to 

keep reliable information about when you last opened an album file, you should not 

remove the album file from the browsing history. 

Browse Album Files 
Button Action Shortcut Description 

 

Open 
Album 

Ctrl + O Open the selected album file in the main AlbumGen 
workspace window. You may also double click an entry in 
the list to open it. 

 

Open 
Location 

Ctrl + E Open the folder for the selected album file in File 
Explorer. 

 

Album 
Properties 

Ctrl + P Show the properties for the selected album file. Changes 
may not be made to the properties from the browser 

window. 

 

Refresh 

Albums 

F5 Inspect the contents of all album files and refresh the 

information in the browsing history. 

 

Save To 
File 

Ctrl + S The album list will be saved to a tab-delimited text file. 

 

Remove 
Albums 

Ctrl + Del Remove albums from the browsing history and optionally 
send the album files to the Windows Recycle Bin. 

 

Add  by 
File 

Ctrl + F Add all album files found in a specific folder by browsing 
for files with an extension of .AGPX. 

 

Add by 
Folder 

Ctrl + D Add all album files found in a specific folder using the 
Windows folder browser dialog. 
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Button Action Shortcut Description 

 

Close Ctrl + W Close this window and discard any changes. 

 

Help F1 Show the help topic for this window. 

 

Refresh List 

This option will open every album in the current browsing history and verify 

existence and content. By default, any albums which are never opened or checked 

for content will not contain any details for the following fields: 

• Description 

• Created 

• Pages 

• Images 

• Version 

• Password and Comment Indicators 

If an album file is moved or deleted from your PC outside of AlbumGen, then it will 

automatically be removed during the refresh. 

Remove Albums 

There are two ways to remove an album. Select one or more albums and choose 

the Remove Albums option from the menu. 

 

Remove from List 

The album will not be removed from your PC. 

Remove Albums 

The album will be removed along with the list entry. Album files removed will be 

sent to the Windows Recycle Bin, where they can be restored as needed. 

 

 

Album Properties 
This option is available from the File menu and always applies to the file album 

currently opened. 
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Note that saving any album property changes will also save any pending album 

page content changes at the same time. When you click the OK button, you will be 

given an option to cancel the save if this scenario happens. 

 

Name The album file name, without an extension. You may change the 

name at any time, as long as it’s not being used by an existing 
album in the same location. 

Description An optional description. Unlike file names, you may use any 
characters of your choosing. 

Email Optional value. 

Author Optional value. 

Company Optional value. 

Comments Comments can contain up to 16,000 characters. 

Version This is the content version of an album file. Album files with a 
newer content version might not open under an earlier release of 

AlbumGen. Ensure that you check for updates periodically to 
keep AlbumGen on the most recent version. 

Created This is when the album was created. Unlike the timestamp under 
the file in the Windows folder, this date and time are persistent 
no matter what happens to the file time stamp stored on your 

PC. 

Updated This is when a save was last made to the album file. 

Cover Page Check this option to enable a cover page for the album. Uncheck 
it to disable the cover page. The cover page always exists for an 

album. The check option turns the cover page on or off without 
removing any current content you may have added. 
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Image Cache For images which may be larger than a certain width or height 

which you may configure, smaller versions of the images will be 
retained in a special “cache” folder. This cache folder will retain 
these smaller images only as long as the caching option remains 

enabled. This will dramatically improve performance when 
navigating pages, using page previous options and zooming in 

and out of the current page in the AlbumGen workspace. 
 
The current size of the cache is indicated. If you want to clear 

the cache, click on the Clear Cache button. More information 
about caching can be found under the topic for the 

Performance Settings option under the Options menu.  

Password You can add a password to an album to protect it from being 

opened or modified. Note that the password is stored in such a 
way that it may not be determined from the album file in any 
manner. Therefore you should always remember this password 

and not share it unintentionally. SoftPro will not be able to 
recover the password if you forget it, but it can be removed if 

requested. 

Read Only By checking this option, the album is marked for not allowing 

any changes to be saved. You can modify content, but the Save 
and Save As options will be blocked. 

 

  



AlbumGen 3 User Guide  P a g e  | 31 

Upgrading Albums 
For users migrating from version 2 of AlbumGen to version 3, you will need to 

upgrade the version 2 .AGP album files to the version 3 format which has a 

different file extension of .AGPX. 

Use the Upgrade Albums option from the File Menu. 

 

You will first need to get a list of version 2 album files using either of the browse 

options. If you have previously upgraded any albums, the most recent file location 

(shown under Source Albums) will be retrieved automatically. 

The Browse by Folder and Browse by File options will use a folder dialog and file 

open dialog window respectively. Choose whichever option you are more 

comfortable using. 

You can set the location for the upgraded albums (shown under Target Albums) 

using the Change Target Album Location option. Note that this is the default 

album file location you set when running the AlbumGen installer. If you change this 

location, then it will change the default open album location from the main 

AlbumGen window accordingly. 
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Validating Content 
Album files may not be upgraded until they are verified for content and any 

possible errors. Select the albums you want to verify and then select the Verify 

Albums menu option to check each selected album. The following content 

validation tasks are applied to each album: 

• Must be a version 2 album file. 

• Check for any font references which are not installed on your PC. 

• Check for any image links where the location path isn’t detected on your PC. 

• Look for incomplete pages, albums or bad formatting of page objects. 

Once validated, any error conditions will be highlighted in red. 

 

Note that missing fonts and bad image paths will not prevent the album from being 

converted and in fact the content will remain as is. When you open the converted 

album in version 3 format, you will get warnings if image paths or fonts are missing 

and will be provided options to make changes as necessary. 

Other error conditions will likely result in lost pages or objects within the pages. 

AlbumGen will try to recover bad data as best as possible, but if the original AGP 

file is too damaged, then there could be significant data loss during the upgrade. 

To view all the errors encountered during either a validation or upgrade, select an 

entry from the list and choose the View Error Log menu option. You may also 

double click any file to view the errors. 
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Performing Upgrades 
Select the albums you want to upgrade and then choose the Upgrade Selected 

Albums menu option. You will be provided a confirmation window as shown below: 

 

 

You may override the current email address, author or company in every selected 

album file by entering a value into one of the provided fields. If you leave the fields 

blank then the values from existing version 2 albums (where entered) will be 

transferred as is to the version 3 file. 

Actions 
Button Action Shortcut Description 

 

Browse by 
Folder 

Ctrl + B Use a folder browser dialog to set a new location for 
source album files. 

 

Browse by File Ctrl + F Use a file browser dialog to set a new location for 

album files. Only the version 2 file extension of .AGP 
will be recognized. 

 

Change Target 
Album Folder 

Ctrl + L Sets a new location for the destination for upgraded 
files in the .AGPX file format. 

 

Verify Ctrl + V Verify that selected album files for any errors. 

 

View Errors Ctrl + E The upgrade/verification process will log all errors 

encountered for each album. This option will view 

the error report for the selected album. 

 

Start Upgrade Ctrl + F1 Upgrade selected album files to version 3. 

 

Close Ctrl + W Close this window. 

 

Help F1 Show the help topic for this window. 

 Edit Shortcuts  Modify the keyboard shortcuts for this window. 
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Printing Albums 
There are several places in AlbumGen where a print option is available. Regardless 

of location, the print options window is the same. From the main application 

window, use the Print option from the File menu. 

If you would like to preview pages before printing, it’s recommended to use the 

Print option from the page preview window instead, as the Print Pages window 

shown below will not provide a preview option. 

 

Selecting a Printer 
On a fresh installation of AlbumGen, a verification of installed printers on your PC is 

performed to determine the printer name and the available paper types supported. 

This verification results in a printer profile being created for AlbumGen. This profile 

ensures a more efficient printer and paper selection when you are ready to print. 

If you add or remove printers after installing AlbumGen, you will need to refresh 

the printer profile. 

Selecting a Paper Size 
Once a printer is selected, you will need to choose a paper size. The paper size 

selected must be at least large enough to contain the page size of all pages to print. 

For example, if a page in the album is legal size (8.5 x 14 inches) and you have 

selected a letter paper size, you will not be permitted to print. AlbumGen does not 

perform any type of scale to fit action on an album page. 
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If you print on a paper size that is larger than the page size, there will be extra 

white space to the right and bottom of the paper – album pages are never printed 

centered on the paper as this would render the left/top margins as ineffective. 

Paper Sizes on Selected Pages 
Depending on the pages chosen to print, the various paper sizes involved in the 

selected pages will be shown on the right. Use the IN and MM buttons to choose 

what units to show the paper sizes in. A paper size for a page is not necessarily the 

page size in an album. When a page is in landscape mode, the page width and 

height are transposed. 

Use this paper size list to determine what paper size must be loaded into the 

printer. 

Album Page Selection 
The choices for page selection may not all be enabled depending on where the print 

window was displayed from and what pages may have been pre-selected or 

bookmarked. 

All Pages Will print every page in the album. 

Current Page Will only print the current page. 

Selected Pages Some tasks in AlbumGen will allow you to select pages from 
a list. This list in turn can be passed into the print window. 

Marked Pages Some tasks in AlbumGen will allow you to bookmark pages. 

Range of Pages When selecting this option, a start and end page number 
must be provided. 

Custom Selection Custom selections allow ranges and individual pages using 
hyphens and commas. For example to print pages 1, 3 and 
7 to 10, you would enter 1,3,7-10. 

 

Even/Odd Page Printing 
Even and odd page printing is provided to allow albums to printed on both sides of 

the paper. When choosing this type of printing, the total pages affected to print 

depends on whether it’s an even page number (2, 4, 6, etc.) or an odd page 

number (1, 3, 5, etc.). 

For example, if you have 96 pages in an album and choose the even pages, then 48 

pages would be printed. 

When choosing even page printing, options will be enabled to flip the margins 

and/or the header and footer title text, so that the binding edge is consistent on 

both the back and front side of the paper. 

Cover Page and Table of Contents 
If you have enabled a cover page or table of contents, you can choose any 

combination between these 2 page types to print. By default, the cover and TOC 

pages are not selected for printing. 
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Printing and Number of Pages 
The total number of pages to print will be shown at the bottom. This number is 

impacted by the page range method, even/odd settings and the cover page/TOC 

option chosen. 

Click on the Print button to start printing. A window will be shown with progress 

status and an option to stop printing. 

 

 

Printer Profiles 
If you have added or removed printers on your PC and you don’t see the printer in 

the dropdown list at the top of the print options window, click on the Refresh 

Printers button. This will build a new printer profile for AlbumGen with all of the 

paper size settings for each printer. This will also remove any printers from the 

profile which are no longer installed on your PC. 
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Album Workspace Guide 
This section provides a detailed summary of the features and options for the main 

application album workspace. This help topic is also available as a special context 

document accessed from the Workspace Guide menu item under Help. 

The workspace contains the content for a given album page and is represented by 

the area not including toolbars, the main application menu and the bottom status 

bar or any of small support windows which can be positioned over top or outside of 

the application window. This area is outlined in red in the screen example below. 
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Item Description 

(1) Rulers are optional guides to show both the current page size and the 
position of the mouse cursor within the page. The (0, 0) position mark can 

be changed using the Grid Origin options from the Options menu: 

 
 
The coordinate and size units can be either inches or millimeters. The 

default is millimeters to be consistent with version 2 of AlbumGen. The 
display units can be changed from the Display Units options from the 

Options menu: 

 
 
Rulers can be turned off using the Display Guides menu option. 

(2) Any area within the workspace that isn’t occupied by the album page is 
shown in one of two colors depending on the presence of scroll bars. If the 
entire page is visible in the workspace, then this color is referred to as the 

backdrop area which is not taken up by the album page. When scroll bars 
are present, the backdrop area is replaced with a fixed size page 

boundary which defaults to a dark gray color. This page boundary is 
always 3 inches to each side of the album page. The boundary provides 
extra room to pan or scroll the album page. 

(3) The margin area represents the margins for the current album page as 
defined in the Page Setup window accessed from the Page menu. 

Margins and borders can be set to a specific color using the Workspace 
Colors settings. Pages with image borders will not show a margin area 

color as this will affect the visual quality of an image-based border. Only 
simple pattern border styles or borderless pages will show the margin 
color. You can disable the margin color from the Display Guides menu 

option. 

(4) Border areas are a feature from version 2 of AlbumGen which provides a 

reserved blank area inside the page margins where object alignment 
options relative to the page will take a border into account along with the 
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Item Description 

margin to avoid having objects rest against borders which fit within the 
margin space. Unlike version 2 of AlbumGen, you may freely move objects 

outside the bordered page space, or even off the page itself. The border 
color can be disabled from the Display Guides menu option. 

(5) The area within the margin and border space represents working page 
area. It will always use a white background. Objects can be placed inside 
or outside this area. In fact, you may move objects up to one page width 

or height away in any direction to allow for temporary placement of 
objects while organizing the page contents. 

 

Page/Object Grids 
Version 2 of AlbumGen provided a single Grid Spacing option, which was an 

invisible grid for object placement, movement and resizing with the mouse. A 

nudge amount was also provided, which was used with the cursor keys to move 

objects. 

You will have 4 distinct choices in version 3 of AlbumGen, accessed from the Page 

Grid options from the Options menu. 
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Grid Size 

 

The grid size is a visual guide only and not directly tied to the mouse click or drag 

options when working with placing, moving and sizing objects. 

There are separate spacing options for inches and millimeters. When enabled, the 

grid will be shown using a unique color which you can change using the 

Workspace Colors menu item from Options (Application Settings). The grid lines 

will always be drawn starting at the selected Grid Origin (page, margin or border). 

The screen sample below is based on the border origin. 
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Movement Alignment 

 

This setting is used when moving selected objects with the mouse. By default this is 

set to match the visual grid and default value from version 2 of AlbumGen: 5 

millimeters. The movement setting is independent for inches and millimeters. Using 

the No Grid option will move objects by individual screen pixels based on the 

current zoom magnification level. This spacing value can be overridden on a per 

object basis using the Placement Settings option under the Object menu. 

Drag Sizing Amount 

 

This is the incremental amount an object will be resized when click and hold the left 

mouse button on a single selected object while dragging in any direction. The 

default value is 5 millimeters to match that in version 2 of AlbumGen. This resize 

value can be overridden on a per object basis using the Placement Settings 

option under the Object menu. 
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Nudge Amount 

 

The nudge amount is used with the keyboard as opposed to the mouse. Use the 

cursor keys to nudge selected objects in any direction by the amount set in this 

window. Unlike other grid settings, the nudge amount can be any value between 

1/100 and 10 millimeters by entering the value directly in the text field. If the 

display units are in inches a similar range will be used for the nudge amount. 

Object Placement Customizations 

The page grid options can all be overridden using object-level customizations. This 

allows for each type of object to have their own page grid settings. This option is 

selected under the Placement Settings option from the Object menu. 
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Display Guides 
You can enable or disable the 4 visual display guides from the Options menu. 

 

 

Display Units 
Most windows in the AlbumGen application will use the display units setting from 

the Options menu for all size and position information. Some windows may have 

override settings to allow inches or millimeters to be used without changing the 

workspace units setting in the main menu. 

 

The default value is millimeters to match version 2 of AlbumGen. Note that album 

files always store size and position information in inches. The display units setting 

doesn’t affect the contents of album files. 
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Grid Origin 
The grid origin affects placement of new objects and is reflected in how the ruler 

units are displayed. The default setting is the border to keep this consistent with 

version 2 of AlbumGen. The visual page grid lines (if enabled) will shift their origin 

to match the setting defined here. 

 

 

Placing Objects 
The left toolbar contains shortcut buttons for object placement which are also 

accessed via menu choices under the Object menu (New submenu). Single 

character shortcut keys are provided by default for most object types. 
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Many of these object types will be familiar if you are migrating from version 2 of 

AlbumGen. The Polygon, Label, Image, Table and Plain Line types are new to 

AlbumGen version 3. 

With the exception of the Label type, objects can be placed by either clicking once 

or by clicking and holding down the left mouse button while dragging a rectangular 

area.  

Clicking once without dragging will create an object size which by default will be the 

same width and height as the previous object placed of that type. Unique 

placement options per object type can alter this default behavior. 

Icon Key Object Cursor Description 

 

R Rectangle 

 

This group constitutes the shape set which is a carryover 
from version 2 of AlbumGen. A shape contains a border, 
image, and text areas above and below the border frames 
and text areas inside the border frame both below/above 

the image and also over top of the image. Polygons are a 
new border frame type which allows for 3 to 8 sides. 

 

D Diamond 

 

 

A Triangle 

 

 

Shift + 
A 

Inverted 
Triangle 

 

 

E Ellipse 

 

 

Y Polygon 

 

 

T Multiline 

Text 

 

Multiline text may mix fonts, colors and font attributes 

(size, bold, italic, underline) within the same text object. 
Text can be rotated at 90 degree angles. 

 

P Paragraph 

 

Paragraphs are similar to text objects in except that they 
are framed within a rectangular area and have a border 
style. Paragraphs may also have word wrap and 
justification options applied. 

 

L Label 

 

Labels are simple one line text objects, using a single font 

style. They may be rotated at any angle. 

 

I Image 

 

Images are simple containers to hold an image reference. 
There are no other special attributes to an image object. 
They may be rotated at any angle. 

 

Ctrl + 

Shift + 
T 

Table 

 

A table is visually similar to a spreadsheet, consisting of 

rows and columns of data cells. However, there are no 
attributes related to the mechanics of a real spreadsheet. 

For example, there are no formulas to apply to a table cell. 
The table object is an object strictly for formatting simple 
text content in row and column format. 

 

H Horizontal 

Line 

 

Horizontal and vertical lines are based on pattern styles 

and are a carryover from version 2 of AlbumGen. 

 

V Vertical 
Line 

 

 

N Plain Line 

 

Plain lines are single lines which can be a solid or dashed 
format with variable thickness and predefined or custom 

line endings, rotated at any angle. 



AlbumGen 3 User Guide  P a g e  | 46 

Placement and Cancellation 

When you choose an object placement from the menu, keyboard or shortcut 

button, the mouse cursor will change accordingly to indicate the object type. 

If you want to cancel out of placement, there are several ways to do this: 

• Right click with the mouse and a popup menu with a single item named 

Cancel Placement will appear. 

• Press the Esc key to cancel placement. 

• Choose the same object shortcut a second time (i.e. if you pressed R on the 

keyboard to place a new rectangle, press R a second time to cancel). 

• If you have already started a drag selection to set a custom object size, then 

hold down the Ctrl key before releasing the mouse button. 

The placement position is based on the page grid alignment option. If you click 

outside the page area, this will automatically cancel the placement. 

The current page grid Movement Alignment determines the position of the object 

relative to the nearest grid point. Note that this alignment may be different than 

the visual grid (if enabled), but the default value would be 5 millimeter alignment 

points relative to the current grid origin, to match version 2 AlbumGen behavior. 

Placement customizations may override this default behavior per object type. 

Click Once vs. Click and Drag 

In version 2 of AlbumGen some objects were drag-size only and some with click-

only. With the exception of the Label, all other object types can be a single click to 

use the previous/preset object size or click and drag. 

When you place an object, it will have a specific width and height. This size is 

retained for the next time you click once (to set a size) unless you enable specific 

options to change this behavior using the Placement Settings item under the 

Object menu. 

Most objects may not be placed on a drag-size unless the mouse has moved at 

least 5 millimeters or ¼ inch depending on the display units. If the size drag is less 

than this, the placement will be considered click once. 
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Position and Size Object Popup 

This option is enabled from the Workspace Settings. 

 

When enabled and pressing the left mouse button, a small popup label is displayed 

like a sticky note in the upper left corner of the placement position and remains 

there until the mouse is released. It indicates the current position and size of the 

selection rectangle for the object when the mouse is released. This popup is 

disabled by default. 

 

 

Object Properties on Placement 

When you release the mouse button when placing an object, the properties window 

for the object type will be displayed. You must change any attributes for this object 

before it appears on the page. 

AlbumGen retains the object attributes from the previous placement in most cases 

(text content is generally not retained between placements) so that you can usually 

fill in the minimal required attributes and click the OK button from the properties 

window. 

If you cancel from the properties window, the object placement will be cancelled.  
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Placement Settings by Object 

This feature is accessed from the Placement Settings item under the Object 

menu. It may also be accessed by the shortcut button in the left toolbar: 

 

 

 

Each object type has specific size and placement settings which can supersede the 

default placement and/or resize behavior. By default, the Page Grid settings are 

used and there are no other specific override settings applied for any object. 

Click on any of the object types on the left to view or change the settings for that 

object. Note that all size and position information in this window is based on the 

Display Units set in the Options menu. 
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Start Position Grid Alignment 

This determines the starting position of the object on the page for alignment to a 

specific grid spacing. If None is chosen, then the object’s position is the pixel click 

point on the screen based on the current zoom magnification level. Page Grid is 

the default and will use the Page Grid settings for all objects. Other will allow you 

to choose any of the predefined alignment options from the dropdown list. 

Drag Size Grid Alignment 

When using the mouse to click and drag edges of the selected object frame, this 

setting determines the spacing increment to use. Note that drag resize of objects 

can only be done if a single object is selected. You may not resize a selection or 

group of objects by dragging with the mouse. 

Drag Movement Alignment 

This option applies when moving selected objects from one location to another.add 

Click-Once Placement Size 

When placing a new object with a single mouse click, the size can be either based 

on the previous object placed or on a fixed size defined under this setting. 

Drag-Size Constrained Aspect Ratio for Placing New Objects 

When you place a new object by dragging a size rectangle, you can do so with a 

constrained aspect ratio. This will ensure the ratio of the object’s width to height 

doesn’t change while dragging to set the object size. 

Drag Movement for Multiple Objects 

This setting allows you to keep a separate drag movement amount when multiple 

objects are selected. 

Click-Once Placement Font Size 

Text objects don’t actually have a width or height. Instead they have an alignment 

point (centre, left or right edge of the text) and a vertical start point from which 

text is drawn. For this reason, the click once setting only allows you to reuse the 

starting font point size or a specific point size. Keep in mind text objects can have 

multiple fonts and sizes for a single object, so this font size is based on the first 

font used. 

Label objects only have a single font size, so the placement choice is always applied 

for the text content. 

Click-Once Placement Length 

For line and plain line objects, this determines the length of the line. For plain lines, 

the rotation of the previous line is always applied on the new object. 
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Templates and Setting Duplication 

The Load and Save buttons are provided to allow retention of placement settings 

as template files. 

Click on Default to set all object type settings to the default values. 

If you would like to copy specific settings from one object type to another, click on 

the Copy button. 

 

You can choose which setting to copy and to which target object types they will be 

copied to. 
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Object Basics 
When placing a new object, it will automatically be selected and be considered the 

top-most object. 

All objects on an album page have a back to front priority when overlapped objects 

occur. The topmost object is always the newest object placed and the bottommost 

object is the first object placed on the page, unless the ordering of objects is 

changed using the send to front/back options. 

Any object which is selected will be shown outlined with a dashed rectangle and up 

to 8 anchor points: one at each corner and one at the midpoint of each edge. 

Depending on the size of the object’s frame and the current zoom magnification 

level, less anchor points may be shown. 

Selection anchors have a “hover” point for the mouse cursor to change to either a 

movement or resize type when the hover point is withing a certain range of the 

anchor (default is 7 pixels). 

If you zoom objects out to low magnification (i.e. well below 100%) that are small 

in size, less than the 8 expected anchors will appear, and at some point, the object 

will be so small that only a single anchor will be displayed. You will need to zoom in 

to the point when the anchors can be selected for moving and resizing actions. 

 

The color of an anchor point has significance as per the table below (these are 

default colors which may be customized). 

 

This is the first object selected when no objects are currently selected. 

 

This is any other selected object which is not the first object selected or 

grouped with any other object. 

 

The selected object is grouped with at least one other object and is not the 

first object selected in the group. 

 

There are 2 objects which overlap on the same position and depending on 

the object type, also on the same object size and rotation. If pasting a 
copy of an object on top of itself, both objects will be shown with anchors 
in this color until one of the objects is moved to a new location. 
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Conditions for Selecting Objects 

There are specific conditions by which objects can be selected and deselected. 

• Click on an empty spot in the album page and drag a selection rectangle 

around one or more objects. The selection rectangle needs to fully enclose 

the inside border frame (the “size” of the object) to be selected. The border 

(if defined) and the text above and below the object (if defined) don’t count 

towards the frame for selecting an object. Unless you are clicking inside the 

selection rectangle with the anchor points, you aren’t clicking on an object. 

• Left or right click on an object without holding down any qualifier key on the 

keyboard. 

• Hold down the Ctrl or Shift key while left clicking to select or deselect the 

current object without affecting the selection of any other objects. 

• Click any empty spot in the album page where no object is positioned without 

holding down any qualifier key to deselect every object on the page. 

• When selecting multiple objects at one time using drag selection without any 

current objects being selected, the topmost object, as defined by its 

'front/back' position, not necessarily by its 'top' visual position on the album 

page, will be set as the “first” selected object for alignment purposes. 

• If you right click any empty spot on the page, all objects are deselected and 

the page context menu will be displayed. 

• Clicking to select or deselect an object which is currently grouped with other 

objects will select/deselect all objects in the group. 

Note that these selection actions are not available when Zoom or Panning modes 

are enabled. 

 

Menu Selection Options 

Selection options are available from the Select submenu in the Edit menu. The 

table below shows default shortcut keys which can be customized. Selection options 

can also interact with bookmarked objects. These options can also be assigned 

custom shortcut buttons. 

Option Shortcut Description 
All Ctrl + A Select all objects on the page 

None Ctrl + D De-select all objects 

Inverse Ctrl + I Invert the selection of objects 

Bookmarked Ctrl + B Select all bookmarked objects and deselect all others 

Specific Type Ctrl + Shift + A Select all objects of a specific type 

Save Selection  Save the current object selection for later recall 

Re-Select  Recall the saved object selection 

Clear Bookmarks Ctrl + Shift + B Clear all bookmarked objects for the current page or on 
all pages in the album. 

Bookmarks to Search F Transfer bookmarked objects to the search results 
window 
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Specific object type selection will display the following window. Only objects of the 

specific type are selected. Any objects which aren’t present on the current page will 

be disabled from the choices. 

 

Moving objects 

For objects which can be resized as well as moved, select one or more objects and 

position the mouse cursor inside the object frame without hovering over any of the 

anchor points. For objects which can’t be resized, simply hover the mouse inside 

the border frame until the cursor changes. For multiple object selection, the cursor 

must be inside the frame of any of the selected objects. 

 

The movement amount will be based on the page grid settings or any custom 

placement settings for the object type. 
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Resizing objects 

Resizing by dragging with the mouse can only be applied for a single selected 

object. If you have an object group created from two or more objects, you will need 

to ungroup those objects first. AlbumGen doesn’t support uniform scaling of 

multiple selected objects by dragging with the mouse. 

Label objects may not be resized with the mouse. 

Text objects are resized by adjusting the scaling of the fonts depending on how 

much the rectangle is resized in any direction. If the object is resized to the extent 

where any font in the text would be larger than 144 points or smaller than 2 points, 

the resize action will be rejected. 

Paragraph objects which are resized only affect the frame size and not the text 

within the frame. You need to adjust the text using the paragraph properties for 

any type of text scaling option. 

Any images or shapes where the frame is rotated will always be a proportionate 

resize action to preserve the aspect ratio of the frame. If the object rotation is zero 

degrees, the resize of the width and height of the frame are independent values. 

To start a drag resize, hover the mouse cursor within range of any of the anchor 

points and the cursor will change to a directional indicator. Then hold down the left 

mouse button while dragging in any direction. 

Resizing where the objects aspect ratio of width to height must be preserved will be 

based on the shortest distance dragged with the mouse when dragging in two 

directions simultaneously. 

 

Resizing text objects which are center aligned or rotated shapes/images will 

proportionally resize the opposing edges when dragging. 
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Blocked Resizing 

There may be conditions where dragging in a specific direction will have no effect. 

This is due to specific object settings which would deny such a resizing action such 

as when images are linked to shapes with a Keep Width setting. The height in this 

case may not be adjusted in order to preserve the object aspect ratio when the 

width is resized. 
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Plain Line Resizing 

The plain line object type has a special method of changing the line length and 

rotational angle. 

You must hover the mouse cursor over an end point of the line. The end point 

doesn’t include the size of the extension type, in the case below being the arrow 

head. 

A cross hair cursor will appear for this type of resize. 

If you click and drag any line that is at a 0, 90, 180 or 270 degree rotation, the 

drag movement will preserve that angle. You can only change the line length. 

If you hold down the Shift key after you click with the left mouse button you can 

then drag the mouse in any direction, the line will unlock from it’s current angle and 

rotate to whatever angle you require. Once you start dragging, you may release the 

Shift key during the mouse drag. 

 

Selection Locks 

Selection locks prevent an object from being selected by any means other than a 

right-click action from the mouse. This option is available from the Object Locks 

submenu under the Objects menu.  
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Movement Locks 

Movement locks prevent an object from being moved, but not from being selected. 

This option is available from the Object Locks submenu under the Objects menu.  

 

 

Object Ordering 

All page objects have a specific order relative to one another when they overlap 

positions. This has the effect of the frontmost object fully or partially obscuring 

some or all of any objects beneath objects lower in the object order sequence. 

By default, as you place new objects on a page, they will always appear above any 

other object when they overlap. 

You can change the sequence of the object order using the Order submenu under 

the Objects menu or from the alignment floating window: 
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Object Grouping 

You can group 2 or more objects together to make a composite object using the 

Grouping submenu options under the Objects menu. 

 

When objects are grouped together, any specific settings for each object in the 

group are subject to a common change applied to all objects in the group, as long 

as they are of the same type. If objects in the group are of a different type (i.e. a 

paragraph and rectangle), you may not change any object properties. 

Shape objects are considered the same type in terms of properties, such as a 

rectangle and diamond. 

Grouped objects may be moved, but may not be resized by dragging with the 

mouse. 

Size Matching 

There are 3 menu options to allow selected objects to be matched on width, height 

or size to the first selected object. The selected objects must all be of the same 

type. 
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Bookmarks 

You can set or remove bookmarks on objects using the Bookmark item from the 

Object menu. Bookmarks are saved with the object when you save the album file. 

Non-Printing Objects 

You can mark any object as a non-printing type. When set to non-printing, the 

object will only appear in the page workspace area and not on printed pages. Non-

printing objects are also hidden on page previews unless you enable an option the 

workspace settings. An indicator is used to show non-printing objects, which can 

be disabled from the workspace settings. 

 

The indicators for an object are shown below. 

 

1. Non-printing object 

2. Bookmarked object 

3. Object has comments 

4. This was an EzStamp import without sizing information 
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Context Menus 
When right clicking within the workspace area, context menus will be displayed as 

an alternative to using the main menu, keyboard or toolbar buttons. The menu 

displayed depends on what was under the mouse cursor when the right button was 

clicked. 

Page Options 

Right click on any empty spot in the page where there is no object, or any place 

outside the edges of the page. 

Object Options 

Right click anywhere inside the frame of an object, whether it’s selected or not. The 

available menu choices are based on both the object type and number of objects 

selected. 

Zoom and Pan Options 

If zoom or pan modes are enabled, the context menu is related to workspace sizing 

options and changing between modes. 
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Object Properties 

When placing new objects the properties window for the object type is always 

presented to allow for customizations to be applied before the object is added to 

the page in the workspace. 

Once objects are present on the page, you can select them and choose from the 

properties option from the menu, a shortcut key or a shortcut button if defined in a 

toolbar or the custom shortcuts window. 

 

These options will present the object properties window and pre-select the tab in 

the window associated with the settings category. Depending on the object type, 

some of these categories will not be applicable. 

When selecting multiple objects, the window presented will be specific to 

adjustments for a group of objects. Table objects may not be adjusted for 

properties if more than one table is selected. 

You may not adjust properties for multiple objects unless they are all of the same 

type. 

Icon Shortcut Object Settings 

 

Shift + L Location and size 

 

Shift + P Properties 

 

Shift + Y Polygon settings 

 

Shift + T Text content 

 

Shift + B Border/Line style 

 

Shift + I Image link 

 

Shift + C Name, bookmark and comments 

 

You may also right click on selected objects and choose the settings item from the 

popup menu. 
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Workspace View Options 
There are several options on how to present and view content of the current album 

page in the workspace. 

Zoom Methods 

These options are available from the View menu. 

 

Along with the various zoom shortcut and fit options, there are 2 modes for 

zooming and panning using the Z and X keys. Choosing the same option a second 

time (i.e. pressing Z while in zoom mode) will cancel that mode. When either zoom 

or pan mode is enabled, the mouse cursor will change to a unique icon and the 

keyboard and mouse actions will change accordingly. 

Zoom Mode 

The mouse cursor will be shown as a magnifying glass icon with either a + or - 

symbol. The zoom in (+) is the default icon and a single click with the left mouse 

button will zoom in one level. By holding the Ctrl key down, the (-) symbol is 

displayed and the page will zoom out one level. 

Using the mouse wheel will scroll the workspace up and down if no other keys on 

the keyboard are pressed. Holding down the Shift key will scroll the workspace left 

and right. 

If you hold down Ctrl and use the mouse wheel, the workspace will zoom in or out 

by a fixed amount (10% is the default but can be customized). 

If you drag select a rectangle with the mouse button, the area within the selection 

rectangle will be magnified to the maximum extent possible. 

Pan Mode 

When pan mode is enabled the cursor will change to an opened hand icon. Click and 

hold the left mouse button down and this cursor will change to a “grabbing” hand. 

While still holding the left button down, drag in any direction to pan the workspace. 

This option has no effect if there are no scroll bars present. 
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Keyboard Scrolling 

The 4 directional keyboard arrow keys can be used to scroll the page in any of 4 

directions as long as there are scroll bars present and no other keyboard keys are 

being pressed at the same time and there are no current objects selected. 

Nudge-Based Movement 

The 4 directional arrow keys can be used to scroll selected objects on the page by 

the nudge movement amount, or by using one of the 8 shortcut buttons in the left 

toolbar. 

 

Clicking on the red “N” button will set the nudge amount. This is a shortcut for the 

menu option for Page Grid settings. If no objects are selected, then the non-

diagonal buttons will move the page in the associated direction, if scroll bars are 

present.  The diagonal buttons only move selected objects. 

Mouse Rectangle Drag Information 
This option is found under the Options menu and is named Last Mouse Drag Info. 

When you drag a selection rectangle anywhere in the current page of the album 

workspace and release the mouse button, the size and position of that rectangle is 

captured for display, allowing you to see the coordinate and size information. This 

can be used to take measurements of areas on the album page. 
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Floating Windows 
There are 7 support windows in version 3 of AlbumGen (version 2 only has the one 

window for alignment options). These windows float over the top of the main 

application window and can be positioned outside of the main window or even on a 

different monitor in a multi-monitor configuration. 

Six of the 7 windows can be shown or hidden using buttons on the left toolbar. The 

user-defined shortcuts don’t appear by default on the left side toolbar but can be 

added as a toolbar customization. 

 

 

Icon Window Description 

 

Alignment This presents the common alignment options, which 
are also found in the Alignment submenu under the 

Objects menu. An alternative all-in-one alignment 
window can be used via the All Options menu 

choice (default F8 key). This window also has some 
shortcuts for object groups, ordering, properties and 
resizing. 

 

Page Navigator This window provides a summary list for all pages in 
the album and the object summary for the selected 

page. When names are used for pages and/or 
objects, this navigator window aids in building a 

table of contents for an album. 

 

Shape Adjustments The shape object (rectangle, ellipse, diamond, etc.) 

type is complex and contains many attributes. Some 
of them are hard to visualize from within the object 
properties window, so this adjustment window 

provides some basic actions for fine tuning key 
settings. 

 

Object Info This window shows basic information for the 
selected object. If no objects or 2 or more objects 

are selected, this window will not display any 
information. There are also key shortcut buttons for 
accessing the various tabs in the properties window 

directly. 

 

Page Thumbnail  In version 2 of AlbumGen, this was a non-sizeable 

small preview area in the left side toolbar. Now it is 
a floating window which can be resized. In addition, 

each object type contains a different filled color 
value. 

 

Search Results The search facility is more robust than the one in 
version 2, allowing both page and object searches. 
Search results are presented in a list which can be 



AlbumGen 3 User Guide  P a g e  | 65 

navigated to see matching content by page or 

objects in either selected or bookmarked format. 

 

Custom Shortcuts This window contains up to 5 groups of shortcuts 

which can be added from the available list, which is 
the majority of options shown in the main AlbumGen 
menu. Options which are in the top toolbar may not 

be added as a custom shortcut. 

 

Position and Size 

Initially, each window is positioned in the top left corner of the workspace area. You 

will need to relocate each window to where you would like it to stay. When 

AlbumGen is closed, the position is retained along with its size, even if it’s on a 

second monitor. 

If for any reason, you can no longer see a floating window, you may try the Reset 

Positions option from the View menu. 
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Alignment Window 
The alignment window contains all of the alignment option along with shortcuts for 

object order, grouping and properties. 

First Object Selected 

When aligning objects to one another, the first selected object is the one which all 

objects selected thereafter will align to for any of the options which are object-to-

object alignment types. 

If no objects are selected and you drag a selection rectangle around multiple 

objects, then the topmost object in the selection will be considered the first object 

selected. In the summary table, this will be referred to at the anchor object. 

Aligning to Object Border vs Object Frame 

This alignment choice is found in the Workspace Settings: 

 

Shapes, paragraphs, images and tables can use border styles and these styles add 

to the width and height of the object. Alignment to the border size will treat the 

outside of the border as the “object size” for alignment purposes. When aligning to 

the object size, the outside border thickness is ignored. 

Text objects are aligned to other objects based on their horizontal and vertical text 

alignments. For example, horizontally aligned text objects are aligned at the 

midpoint of the text content. 

Line and plain line objects are aligned on the initial start point of the line. 

Labels are treated as a rectangle enclosing the text content. There is a small buffer 

of white space around labels, so the alignment of these objects will never appear 

flush with the edges of other objects. 
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Icon Option Description 

 

Object Left Edge Aligns the left edge of selected objects to the left 
edge of the anchor object. 

 

Object Center 
Horizontally 

Aligns the center of selected objects to the center 
of the anchor object. 

 

Object Right Edge Aligns the right edge of selected objects to the 
right edge of the anchor object. 

 

Distribute 
Horizontally 

Creates equal horizontal spacing between selected 
objects using one of 4 methods. Requires at least 
3 selected objects. 

• Space the objects between the left and 
right end objects equally. 

• Align the center points of each object 
evenly. 

• Create equal spacing based on the left 
edges of the selection. 

• Create equal spacing based on the right 

edges of the selection. 

 

Horizontal Tiling Creates an equal spacing from left to right for the 

selected objects. 

 

Horizontal Grouping Aligns the left or right edges of the selected 

objects to the opposing edge of the anchor object 
with a specific gap of separation. 

 

Object Top Edge Aligns the top edge of selected objects to the top 
edge of the anchor object. 

 

Object Center 
Vertically 

Aligns the center of selected objects to the center 
of the anchor object. 

 

Object Bottom Edge Aligns the bottom edge of selected objects to the 
bottom edge of the anchor object. 

 

Distribute Vertically Creates equal vertical spacing between selected 
objects using one of 4 methods. Requires at least 
3 selected objects. 

• Space the objects between the top and 
bottom end objects equally. 

• Align the center points of each object 
evenly. 

• Create equal spacing based on the top 

edges of the selection. 
• Create equal spacing based on the bottom 

edges of the selection. 

 

Vertical Tiling 

 

Creates an equal spacing from top to bottom for 

the selected objects. 

 

Vertical Grouping Aligns the top or bottom edges of the selected 

objects to the opposing edge of the anchor object 
with a specific gap of separation. 

 

Page Left Edge Shifts all selected objects so the left side of the 
leftmost object rests against the left page edge, 
margin or border, with an optional amount of 

white space. 
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Icon Option Description 

 

Page Center 
Horizontally 

Centers the object selection between the page 
width, margins or borders. 

 

Page Right Edge 
 

Shifts all selected objects so the right side of the 
rightmost object rests against the right page 

edge, margin or border, with an optional amount 
of white space. 

 

Page Top Edge Shifts all selected objects so the top side of the 
topmost object rests against the top page edge, 
margin or border, with an optional amount of 

white space. 

 

Page Center 

Vertically 

Centers the object selection between the page 

height, margins or borders. 

 

Page Bottom Edge Shifts all selected objects so the bottom side of 

the bottommost object rests against the bottom 
page edge, margin or border, with an optional 
amount of white space. 

 

Snap to Grid 
Horizontally 

Aligns all selected objects so the left edge of the 
object aligns to the default page grid and origin or 

a custom grid size or origin. 

 

Snap to Grid 

Vertically 

Aligns all selected objects so the top edge of the 

object aligns to the default page grid and origin or 
a custom grid size or origin. 

 

Bring to Front Brings all selected objects in front of all non-
selected objects. The front-to-back order of any 

selected object will remain the same relative to 
other selected objects. 

 

Bring Forward Brings all selected objects forward one spot in the 
current ordering sequence for the page. 

 

Send Backward Sends all selected objects towards the back one 
spot in the current ordering sequence for the 
page. 

 

Send to Back Sends all selected objects in back of all non-
selected objects. 

 

Same Width Makes all selected objects the same width as the 
anchor object. The objects must be of the same 

type. 

 

Same Height Makes all selected objects the same height as the 

anchor object. 

 

Same Size Makes all selected objects the same size as the 

anchor object. 

 

Create Group Place all selected objects into a group. When 

grouped, the objects will be locked together when 
moved with the mouse. You may not resize any 

objects in the group by dragging with the mouse. 

 

Disband Group Ungroup all objects in the currently selected 
group. 

 

Properties Show the object properties window. If multiple 
objects are selected, this option will only show the 

position and size window for the selection. 
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Alignment Options Window 

An alternate method of aligning objects can be found in the Alignment submenu 

under the Object menu. 

 

Choosing All Options will present a single window with a short help summary for 

each option. The current alignment choice will always be indicated with the green 

checkmark icon. 
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Distributed Alignments 

As this type of alignment may be hard to see visually, an example page with blue 

arrowed lines showing the spacing relative to the shapes and anchor points is 

provided below. 
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Thumbnail Window 
The thumbnail page preview is a floating, sizeable window. 

 

Simple shapes with different filled colors are used to indicate the position and size 

of objects on the page. A dotted outline indicates the margins and a solid outline 

indicates the overall page size. 

Clicking in the page area of the thumbnail window will scroll the main page 

workspace to center on that click point, assuming that there are scrollbars present 

in the workspace. If the full page is visible in the workspace, clicking the thumbnail 

window will have no effect. Default colors for objects types are shown below. 

 

Shape 

 

Text 

 

Paragraph 

 

Image 

 

Label 

 

Table 
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Object Info Window 
This window presents basic information about the current selected object. If 

multiple objects are selected, no information will be shown. The amount of 

information shown varies depending on the object type and its individual attributes. 

 

Location 

This is the current position of the object without regard to any borders or text 

which sits outside the frame size. The values are in the display units (MM or IN) and 

the number of decimal points is always rounded to 4 positions regardless of unit 

type. 

Selection 

This is the size that will be used for alignment purposes. The selection size is based 

on the type of object, any rotation, or border styles if applicable. 

Size 

This is the size of the object frame. 

Border Style 

If the object type uses border or line styles, this will be the name of the style. 

Text Color 

The text color shown depends on the object type. For shape types, there are 4 

possible text areas (Above Frame, Below Frame, Inside Frame and Over Object), 

as indicated in the 4 text type buttons at the bottom right. Clicking one of those 

buttons will show the first text color and font in use for that text area. 

Image 

This shows the file name of the image linked to the shape or image object without 

the location or file extension. 

Font 

This is the first font used for the object or text area. 
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Actions 

The buttons at the bottom are actions for the selected object. Some of these 

buttons will be disabled if the associated action doesn’t apply. 

Icon Action 

 

Adjust the properties for the selected item. 

 

Adjust the size and/or location for selected item. 

 

Adjust the text content for the selected item. 

 

View, Add or Change the Link to an image to the selected item. 

 

View comments for the selected object. 

 

Show all the fonts used for the current text area/object. Not enabled if 

the object/text area uses a single font. Clicking on this will show what 
fonts are being used for the text. 

 

Show the text font/color for the text above the shape frame. Not 
applicable for objects other than shape types. 

 

Show the text font/color for the text below the shape frame. 

 

Show the text font/color for the text inside the shape frame. 

 

Show the text font/color for the text over the shape image. 
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Page Navigator Window 
This sizeable window shows a list of the current album pages and a list of objects if 

a single page is selected in the page list. 

 

Names 

Any object or page can be assigned a name. Names are used for both informational 

purposes and in building a table of contents for the album. Names are optional, but 

you will not be able to build a table of contents without names. 

Bookmarks 

You can bookmark pages and objects for searching and information reasons. The 

difference between a name and a bookmark is that bookmarks are never used for 

table of contents creation. 

Comments 

Comments can be attached to both pages and objects. If comments are present, a 

small page icon will appear to the left of the page/object entry. 
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Showing a Page 

Double clicking an entry in the page list will display that page in the workspace. 

Selecting an Object 

Once a page is selected, the associated objects in that page will be displayed. 

Double clicking an object in the list will switch the page in the workspace (if 

necessary) and then select that object. 

Actions 

The buttons at the bottom are actions for the page navigation window. 

Icon Action 

 

Display the selected page. 

 

Display the page for the selected object and select it. 

 

Set the page name, bookmark or comments. 

 

Set the object name, bookmark or comments. 

 

Preview selected pages. 

 

Print selected pages. 
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Shape Adjustments Window 
The shape types (Rectangle, Diamond, Ellipse, Triangle, Polygon) have many 

attributes that can be a challenge to see changes from the object properties 

window. The Shape Adjust window provides several actions for each of the 4 text 

areas: 

Abv Above the object frame 

Bel Below the object frame 

Ins Inside the object frame 

Img Over the top of the image 

 

Only one of the 4 text areas at a time can be selected for adjustment. Click one of 

the 4 text labels to set the area for adjustments. Note that buttons are greyed out 

based on the area selected, not whether text content is present or not for the 

selected object and text area. 

Icon Action 

 

These 3 actions change the horizontal alignment of the text (left, 
center or right). 

 

 

 

These 3 actions change the vertical alignment of text inside the object 
frame or over the image. Center alignment on inside frame text when 
an image is present will force the text into a bottom alignment to 

match version 2 AlbumGen behavior.  

 

 

These 2 actions shift the inside frame or over image frame text left and 
right by the nudge amount. 

 

 

These 2 actions shift the text vertically up or down by the nudge 
amount. 
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Icon Action 

 

Allows you set specific shift amounts vertically and horizontally 
(inside/over image text only). 

 

This sets the amount of spacing between the image and inside frame 
text. If the shape has neither an image or inside text, this setting has 

no effect. 

 

This is a percentage adjustment for spacing between multiple lines of 

text for any of the 4 areas. 

 

For inside frame or over image frame text, this setting adds extra 
spacing above and below the text. This option is useful for background 

color fills for these two text types 

 

Change the font width so the text will appear expanded or compressed 

horizontally. 

 

Adjust the inside spacing (between the object frame and inside 

text/image content) and the outer spacing (between the object frame 
and the start of a border style). Outer spacing has no effect if there is 

no border style. Inside spacing has no effect if there is no inner text or 
image context. 

 

Apply font scaling to any text area as a percentage change. Negative 
values will decrease the font size. The scaling will not be allowed if any 
font size for the text area would be smaller than 2 points or larger than 

144 points. 

 

Set the nudge amount for the 4 shift buttons on this window only. This 

is not the same nudge amount used in the left toolbar. 
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Search Results Window 
This window shows the matching pages/object when running the Search utility 

from the Utility menu. Bookmarked objects can also be transferred into this 

window. 

 

Icon Action 

 

Show the selected page in the workspace area. 

 

Select all matching objects and deselect all others. 

 

Bookmark all matching objects and unmark all others. 

 

Select all bookmarked objects on the page. 

 

Clear bookmarks. 

 

Start a new search. 

 

Replace object or page attributes. 

 

Clear any current search results. 
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Custom Shortcuts Window 
This is a sizeable window which can contain any shortcut buttons which would not 

normally appear in the left or top toolbars. 

 

 

There are 5 shortcut groups accessed by the 1-5 buttons. The last button at the 

bottom displays the shortcut button editor, which is also accessible from the 

Options menu: 

 

Refer to the Configurations Options section (Custom Shortcut Buttons Window) for 

more details on how to assign shortcut buttons.  
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Size and Position Input 
While not directly related to the main workspace area, you will notice in many 

windows provided by AlbumGen expect a position or size value, in either millimeter 

or inch units, based on the Album Display units setting unless otherwise indicated. 

As an example, the page setup window expects a paper width and height for the 

page. If the expectation is inches, you may still enter millimeter values using a 

suffix of “mm” or “m”. The suffix is not case sensitive and spaces are not required 

between the suffix and the value. Therefore all of the below values are considered 

the same for 25.4 millimeters: 

• 25.4m 

• 25.4 mm 

• 25.4 MM 

• 25.4Mm 

The suffix can be specified in inches as “IN” or “I”, for centimeters as “CM” or “C” 

and millimeters as “MM” or “M”. 

Fractional Values 

If you enter values in inches, you can use fractional notation, and enter a whole 

number preceding the fraction with a “+” character. Assuming the expected units 

are inches, the suffix values are not used in the examples below: 

• 7/16 

• 2+1/8 

• 1 + 11/32 

If fractional notation is used, inches are assumed and the decimal point may not be 

used to represent a fractional amount. 
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Undo and Redo 
Version 2 of AlbumGen only had a single undo level for the most recent action with 

no redo capability. 

AlbumGen 3 has up to to 1,000 levels of undo and redo, with a default setting of 

100. 

Depending on the type of action, AlbumGen may save parts of the album content to 

a file cache before new tasks are performed, to conserve memory. Refer to the 

performance settings options for customizations to the undo and redo settings. 

If no undo or redo action is available, the shortcut buttons and menu options will be 

disabled. Note that redo is enabled only when you perform undo actions. Once you 

perform any other action other than undo, the redo list is cleared, as redo is only 

intended to step back and forth in the current undo list. 

Saving album changes doesn’t impact the undo/redo status for the album. You can 
save album changes and still undo previous actions as long as you don't close the 

album file. 

You can clear the undo history at any time from the option under the Edit menu. 

Copy Options 
Both page and object content can be copied to both the Windows clipboard and also 

to files. Shape, line, text and paragraph objects may also be copied to an image 

format. 

Object Copy to Clipboard 

Select one or more objects and select the Copy menu option, press Ctrl + C, or 

click on the shortcut button. The position of each object is preserved and can be 

used to paste the objects to the same position on the current page based on a 

workspace preference option. The Cut option (shortcut Ctrl + X) is the same as the 

copy option with the addition of removing the original image from the page. 
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Object Copy to File 

Select one or more objects and select the Copy to File menu option or press Ctrl + 

Shift + C. You will be prompted for a file name (without a file extension). 

 

These template files will be available from a browser window when choosing the paste from file option. 

Page Copy to Clipboard 

This option is available as the Copy Page option from the Page menu. This will place 

the current page contents into the Windows clipboard. Note that the clipboard can 

contain 4 different types of AlbumGen content: 

• One or more page objects 

• A complete album page 

• Stamp content exported from EzStamp 

• Objects copied in image format 

Only one type of content can be present in the clipboard – existing AlbumGen 

content will be replaced with new content for any of these 4 types. 

Note: Pages are copied or pasted using template files from the Page Setup window. 

Object Copy to Image 

There are 4 object types where the complete content of the object can be converted 

to an image format and placed on the Windows clipboard. 

• Shapes 

• Paragraphs 

• Multiline text 

• Horizontal and vertical lines 

There are rotation restrictions on all 4 of these object types. If you need to display 

one of these types at any rotational angle, you will need to convert it to an image 

first, and then place it on the page as an image object. 

The resolution (DPI) of the converted image is defined in the General Settings 

menu item under Options, with the default value of 300 dots per inch. 
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To link this image to an object (image or shape types), use the Clipboard option 

from the object image properties tab. 

 

 

 

You will need to provide a file name and location for this image, along with a choice 

of one of three file formats. 

Note that AlbumGen will check for a copied object image in the Windows clipboard 

as a priority over a normal image file copied to the clipboard from another 

application. 
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Paste Options 
The Paste option from the menu (shortcut Ctrl + V) will perform the following action 

based on the content. If there is no AlbumGen-compatible content on the Windows 

clipboard, you be informed with a suitable message. 

Pasting Single Objects 

The Workspace Settings contains an option to determine how single object paste 

actions will be performed: 

 

The default setting will require that you click with the mouse to set the new object 

location. A special icon will be displayed to indicate that a paste click is required. 

 

The paste location will depend on the click-once alignment options for the source 

object type and the page grid settings. 

If the mouse click option is not enabled in the Workspace Settings, then the object 

will be placed on top of the source location. The selection anchors will use a unique 

color to indicate that the pasted object is sitting on top of/overlaying the same 

object. 

 

Pasting Multiple Objects 

If two or more objects were copied to the clipboard, the paste action will always 

place the objects in their original source positions. 
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Pasting From File 

When you copy objects to a template file, you can paste their contents using the 

Paste from File option under the Edit menu. This will present a template browser 

window. 

 

The dropdown list contains the type of template copy that was made. If two or 

more objects are selected and copied to a template file, then the file will always 

appear under the Group of Objects entry. 

If a single object is copied to a template file, then the file will always appear in the 

appropriate list (Shape, Image, Line, etc.) for the associated object type. Select the 

corresponding type from the Object Type dropdown 

Option Description 

 

Rename the selected template file. 

 

Remove selected template files. 

 

Show the object(s) in a Page Preview window 

 

Paste the objects from the selected template file. You may also double-

click the file entry itself as a shortcut. 

 

Cancel and close this window. 

 

Pasted objects from a template file will always appear in the original locations from 

which they were copied. 
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Workspace View Options 
These options are all available under the View menu. 

Zoom and Pan Modes 
These 2 options enable/disable the zoom and pan modes. While zoom mode is 

active, the workspace cursor will be one of the following icons: 

     

While pan mode is active the workspace cursor will be one of: 

     

The zoom or pan modes can be disabled by choosing the same option from the 

menu, shortcut button or keyboard shortcut, or from the right click context menu 

by selecting the Normal mode option. 

Zoom and pan modes are described in detail in the Album Workspace Guide 

topic. 

Zoom in and Zoom Out 
Ideally, you will want to use the shortcut keys under the menu options (default Ctrl 

+ Ins and Ctrl + Del) the zoomed area will be wherever you have positioned the 

mouse pointer. Selecting Zoom directly from the view menu with the mouse pointer 

will zoom the page toward to the top left corner. 

Zoom Select Options 
The 100% option is based on your screen resolution setting and not any of your 

installed printers. This can vary depending on screen display scaling (i.e. 150% 

scaling on 4K display). Under normal screen scaling, the typical screen resolution is 

96 DPI, which means a 10 point font will typically be around 13 pixels tall. 

To make better use of workspace area, the Fit to Width and Fit to Screen options 

will ensure the page makes maximum use of the available space.  

 

The Specific Amount option will present a window to choose a zoom level. 
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Print Size 
This option is provided to see content at the size it would be on the physical paper 

when printed. This is based on the current printer chosen in the AlbumGen General 

Settings window: 

 

Printed output is directed to the default printer currently assigned in your Windows 

Printer Settings. You can choose to output albums to any printer from the print 

window, however the Print Resolution can only be set from the general settings 

window. You can choose any print resolution from 300 to 2400 dots per inch, even 

if that’s not the default print resolution assigned to the printer. 

If no printer is installed on your PC, AlbumGen will default the print resolution to 

600 dots per inch (DPI). 

AlbumGen relies on features within the Windows system to place text regardless of 

its destination - screen or printer. As screen resolutions may be significantly lower 

than the printer, coupled with zoom magnification levels in the workspace, as well 

as the choice of font and font size, on-screen text may appear less accurate than 

what appears on the printer. 

If you select a printer from the list, it will be checked for it’s print resolution, and 

create a zoom factor against your current screen resolution. In the example above, 

a 600 DPI print resolution and 96 DPI screen resolution is a zoom factor of 600 / 96 

* 100% = 625%. 

The selection rectangles for Text and Paragraph objects in the workspace are 

always based on the print resolution. Depending on the zoom level, the text may 

appear smaller than the print size as the font size stepping is not always going to 

show ideal text sizes for a given level of magnification. 

By default, the shortcut Shift + SPACE can be used to set the zoom factor to print 

size. 
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Zoom Detail 
In version 2 of AlbumGen, this option was tied to the Esc key and always applied a 

300% zoom factor. Zoom detail allows you to quickly toggle between the current 

zoom level of the workspace and a level that you specify in the Detail Zoom Level 

setting. The SPACE key is used to swap the zoom levels. You can adjust the detail 

zoom factor in both the Print Size window and the Workspace Settings. 

 

 

  



AlbumGen 3 User Guide  P a g e  | 89 

Show and Hide Options 
The remainder of the View menu is used to show or hide floating windows and 

workspace toolbars. 

 

The Reset Positions option is used to position one or more of the floating windows 

back to the upper left corner of the workspace area. Use this in case you are no 

longer able to see one or more of the windows. 
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Page Setup 
Album files must contain at least one page, not counting an optional cover page or 

any pages dedicated to a table of contents. 

Each page can have its own unique setup using the following key attributes not 

related to individual page objects: 

• Paper size and orientation 

• Page Margins and borders 

• Page Header and footer areas for title and subtitle text 

• Page Border styles based on lines and patterns or image borders using 

templates 

• Non-printable attributes for page name, bookmark and comments 

By default, new pages are created based on the attributes of the previous page 

created. This behavior can be changed to force a specific template to always be 

applied for new pages. 

The page setup window can be accessed from the Page Setup item under the 

Page menu. 

Paper Size and Orientation 

 

Each page can use a different paper size and orientation. The page size is derived 

from the paper size based on its orientation. 
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Select a paper size from the dropdown list. A default pre-defined list of paper sizes 

is provided by SoftPro. Additional custom sizes may be added to this list. Paper 

sizes are not based on the current printer selected in your installed printer list.  

There is no restriction on the paper size for a page in an album file. For example, 

you may build pages to a unique paper size which is smaller than the physical 

paper in the printer, with the expectation that the paper may need to be trimmed 

after printing. 

AlbumGen will not center printed pages if they are smaller than the paper size. 

There is no scaling (i.e., “fit to page”) option either. When you create album pages, 

they are always printed at 100% and the page size must be no larger than the 

paper size selected for the printer to be allowed for printing. 

Adding Paper Sizes 

For a new paper size to be added to the available list, you need to first enter a 

paper width and height which is not already assigned to an existing paper name. 

The width and height fields are based on the units set in this window. 

You can tell if a paper size is already present as you enter the width and height. If 

the dropdown list doesn’t indicate a paper name, then the size isn’t in the list. 

When you click on Add Size, you will be asked to name this paper size. The default 

will be Custom 1, Custom 2, etc., which you should change to a meaningful paper 

name. The paper name must not currently be in use. 

 

Custom paper sizes are always added to the end of the pre-supplied list and are 

sorted alphabetically. 

You can rename or remove custom paper sizes using the associated buttons for 

Rename Size and Remove Size. 
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Margins and Borders 

 

Margins define areas where you prefer to not to place page objects. However, you 

may still place objects inside margin areas, as margins are not restrictions for 

object placement, unlike version 2 of AlbumGen. They do act as alignment 

boundaries when using any of the page-specific alignment options for objects. 

To preserve the page setup behavior of version 2 of AlbumGen, the default 5 

millimeter border is present. The default 5 millimeter border space is provided as 

an additional white space area around the page margins for alignment purposes. 

The combination of margin and border is used to set the alignment perimeter for 

the page. Both values are optional on any of the 4 edges. Be aware that most 

printers are not capable of printing all the way to the edge of the physical paper. A 

small amount of the paper width and height on the edges will generally not permit 

any content to be printed. Unless you are certain that your printer can support 

borderless output, you should always set a margin and/or border. 

You should also set top and bottom margins if header/footer text will be used. 

The Header and Footer size is deducted from the margin space as the reserved area 

for titles and subtitles at the top and bottom of the page. The header/footer space 

must be equal to or less than the top/bottom margin space. If your pages won’t use 

titles or subtitles, then the header/footer values can be ignored or set to zero. 
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Image Border Margins 

Image borders are page border styles provided by SoftPro as a set of named 

templates with associated image-based content. As this content is always able to be 

scaled uniformly to different paper sizes, and with the number of variations of 

border widths of the image data, each image border in the pre-supplied library of 

templates has some specific attributes which may affect how the page is setup. 

• Paper width and height 

• Pre-defined margins based on the image content 

• Locked paper size 

When selecting an image border, you may see a message below the image 

margins: 

 

You will be unable to choose a different paper size than the one attached to the 

image border. 

The Image Border Margins button will switch the page margins to match the 

ones attached to the image border. There is no restriction on using margins which 

don’t align to the ones set by the image border. 

Default Margins 

Clicking on the Default Margins button will set the following values: 

Inches Millimeters 

Paper Width 8.5 Paper Width 215.9 

Paper Height 11 Paper Height 279.4 

Top/Bottom Margin 1 Top/Bottom Margin 25.4 

Left Margin 1 Left Margin 25.4 

Right Margin 0.5 Right Margin 12.7 

Border (All Edges) 0.197 (5/25.4) Border (All Edges) 5 
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Header and Footer 

 

There are 6 areas for placing titles and subtitles on a page, 3 at the top in the 

header space and 3 at the bottom in the footer space. 

The alignment is always left-centered-right for the header and footer text and may 

not be changed. 

Each area can have a title line and a subtitle line. The text content can only use one 

font style, size and color per area. If you need more control over font/text content, 

you will need to ignore the header/footer setup and place custom objects on the 

page where the header/footer would normally reside. Note that many of the pre-

supplied image border styles will not work well with header/footer text content 

unless you adjust the vertical offsets (negative values to raise the header, positive 

values to lower the footer) to not overlap the border content. 

Selecting a Title Area 

Only one of the 6 titles areas is shown at one time. Choose a Title Area and Header 

or Footer Position to display the current settings. The last area accessed when the 

page setup window is closed will be the default for the next time the window is 

shown. 
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Title vs Subtitle 

Each area can have a title and/or subtitle below the title, as per the example page 

below: 
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Font and Color 

Each area can use a single font and text color. The character width adjustment is a 

percentage increase or decrease of the character width to allow for expanded or 

compressed fonts. 

Macros 

Macros are special keywords contained in the title text or subtitle that are replaced 

with content as described for the macro. Click on the Macro 'Insert' command box 

to insert the appropriate keyword in the current text position. If the text field 

doesn’t currently have the focus with the I-beam edit cursor, clicking on the Macro 

button will add the keyword to the end of the text. You must be actively editing the 

text field in order for the keyword insert to occur 

 

The keyword text content which appears in the text field will be exactly as shown 

with the tilde character enclosing the key word. Keyword(s) will be replaced with 

the actual content as described in the Macro window shown above. 
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Vertical Offset 

This is a positive or negative value in the units defined under the Margins and 

Borders tab. This will shift the selected title/subtitle area upwards (negative value) 

or downwards (positive value) by the unit value entered. 

Subtitle Spacing 

This value increases or decreases the spacing between the title line and subtitle 

line. A value of 0 indicates the natural line spacing based on the font size. This 

value has no effect unless the title area has both title and subtitle text. 

Text Drawing Direction 

Depending on whether headers or footers are checked, the bottom left area of the 

dialog window will contain a checkbox with one of these two descriptions: 

Draw Text Upwards (for header text) 

Draw Text Downwards (for footer text) 

To ensure compatibility with version 2 of AlbumGen, the default text direction is 

downward for the header and upward for the footer. 

The sample below indicates the default direction for header text: 

 

The red outline is the header size defined to fit within the top margin space. Titles 

and subtitles will start at the top of the header area and draw downwards. 

If you prefer to reverse the direction of text, check the Draw Text Upwards option. 

When you do this, an additional text field with a spacing gap will be used to 

separate the text from the margin area. This spacing gap is useful to keep the text 

from the edge of any border applied to the page. The default gap size is 1/16 inch, 

or approximately 1.6 mm. 

 

For the footer area, the process is flipped. When the alternate draw direction 

(Downwards) is used, the text will begin at the bottom margin of the page, plus any 

additional gap space (i.e. 1/16 inch) applied. 
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Border Style 

 

Border styles are patterns of lines, dots or dashes which are comprised of a unique 

corner style, horizontal edge and vertical edge. In version 2 of AlbumGen, the 

border style could only be a single color. 

SoftPro provides pre-supplied border styles which carry over from the previous 

version of AlbumGen. The Borders Manager option under the Utilities menu allows 

you to create of new custom border styles which can be a single color or multiple 

colors. 

Page borders are optional. If you want to remove the page border, click on the 

None button under the Style dropdown list. 
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Color 

If the border style has only a single color. then you may change the color for the 

border. If the border style contains multiple colors, then the color may be changed 

only by using the Border Manager option under the Utilities menu. 

Weight 

The border weight is a value from 1 to 6, where each unit represents 1/300 of an 

inch. AlbumGen doesn’t use point sizes for border weights, however 1/300 inch is 

approximately ¼ point (1/288 of an inch). Version 2 of AlbumGen assigned a 

weight of 1 as 3/300 inch up to a value of 4 which was 6/300 of an inch. The values 

of 1 and 2 were added for a range of 1/300 to 6/300 inch. 

Default Border Spacing 

By checking this option, a standard border spacing, as entered in the input area 

below the check box, will be applied to all 4 edges inside the margins as long as a 

style is selected. This will override the border size set in the Margins and Borders 

tab. 

Unavailable Border Styles 

When an album file is opened, a check is made on all pages to see if there is a 

custom border style being used which is not defined in the Style list. This can 

happen if you are sharing an album from someone who uses unique custom 

borders. When this happens, a warning message will be displayed and the border 

style will be changed to a default one. 

Image Borders 

If an image border is selected for the page, any existing standard border style will 

be dropped. If a standard border style is selected, any image border assignment 

will be dropped. Image and standard borders may not co-exist. 
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Image Borders 

 

An image border is based on a template library file for each style. SoftPro provides 

several dozen image border files with the AlbumGen installation package. 

Image borders are defined with a specific resolution (typically 300 DPI, but higher 

resolutions are possible), paper size, and page margins. 

Image borders are fully color capable – however, most of the pre-supplied borders 

are black and white versions carried forward from the previous version of 

AlbumGen. 

Thumbnail previews are provided with a sample of corner and edge sections. 

Some supplied image borders can be defined with a “locked” paper size, which 

means that the paper size for the page must be the one defined with the image 

border. 

The margins are preset for the selected border style, but can be changed if required 

in the Margins and Borders tab after selecting the border style. 

Note: AlbumGen supports custom image border templates, but support via the 

template designer is not offered with the current version of AlbumGen. 
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Comments 

 

Pages can be assigned a name, which is any arbitrary text which can be placed into 

a table of contents (TOC). Table of contents pages can’t be generated without page 

and/or object names. The page name will appear in the page navigator window. 

A bookmark is any text phrase or keyword you want to associate with this page. 

The Search utility will allow you to search for pages by the bookmark text. 

Comments can be up to 16,000 characters in length, and will appear with a visual 

indicator on the workspace toolbar when comments exist for the page. 
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Templates and Previous Page 
The General tab of the page setup window has a section for Template and Current 

Page. 

 

When Current Page Setup is selected, any new pages created will use the current 

page setup from the main workspace. If Current Template is checked, then an 

alternate template setup is always used. This template is based on the page setup 

settings when you click on the OK button while Current Template is checked. The 

Default button will reset this template to default attributes. Use the Load and 

Save buttons for custom page templates. 

Templates are saved with a file name, and recalled using a browser window. 
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Page Preview 
There are 3 types of page preview accessible from the Page menu: 

• Single page shows one page at a time. 

• Side by side presents 2 pages at a time arranged horizontally. 

• Tiled preview presents pages in grid of rows and columns which can be 

modified using the Preview Settings found under the Help menu. 
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The preview window is shared between all 3 preview types. The size and position of 

the preview window is unique for each. 

Preview Settings 
The settings for the preview window can be found under the Help menu. 

 

Color Settings 

The background color is any area not taken up by the actual page content in the 

preview window. 

When you select or bookmark pages in the preview window, a status bar appears 

below the page and fills the entire page width. 

 

The color is based on the combination of selected and/or bookmarked statuses. 
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Tiled Preview Settings 

You can set the number of page rows and columns for the tiled preview mode. The 

default of 3 rows and 4 columns matches that from version 2 of AlbumGen. 

Image scaling reduction for large images is the same value set in the Performance 

settings window from the main Options menu and will be used to determine when 

file caching will be applied based on a maximum pixel dimension of the image. 

The graphics quality mode with a setting of low will provide a significant 

performance boost when showing pages, but at the expense of image quality. 

Unless your PC has performance issues, leave this option unchecked. 

If enabled, page labels will show the associated page number superimposed at the 

bottom of each page. Note, this only applies to the Tiled preview.  It is not available 

for the side-by-side or single page previews 

Single and Side-By-Side Settings 

The default scaling size for caching is double that for tiled mode at 1000 x 1000 

pixels maximum scaled image size. Low quality mode is off by default. 

Display Option for Missing Images 

If an image reference can’t be located, you have a choice on how the associated 

object will be displayed. 

Show Placeholder Image A red question mark (?) gradient image will appear 
(default) 

Show Text Label A label with the name of the image will appear 

Show Nothing Show a blank image area. (frame and text, if any, 
will be shown) 

 

When using the Show text label option, settings are provided for the text color, 

background color, font and font size. 

Preview Options 
Menu, keyboard and button shortcuts are summarized below. Keyboard shortcuts 

can be modified using the option from the Help menu. 

Icon Menu Item Shortcut Description 

 

Single Page Mode Ctrl + 1 These options switch between the 3 preview 
modes. 

 

Side by Side Page Mode Ctrl + 2 

 

Tiled Page Mode Ctrl + 3 

 

Print Current/Selected 
Print Page Range 

Print Marked Pages 
Print Cover Page 

Ctrl + P 
Ctrl + R 

Ctrl + Shift + P 

Will show the print dialog and choose the 
associated default print range setting based 

on the menu choice. Clicking the print icon 
presents a popup menu with the first 3 
choices. 

 

Select Page and Close F5 If single page mode is active, the current 
page will be shown in the main application 
workspace. For side-by-side and tiled modes, 

you must select a page first. 
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Icon Menu Item Shortcut Description 

 

You may also double click any page with the 

mouse. 

 

First Page  Ctrl + Home These are page navigation shortcuts to 
display the next/previous page or group of 
pages. 

 
While pages are being drawn, you may click 
on the status message which appears during 
the page rendering or press the Esc key to 
stop drawing after the current page is 
completed. 
 

If a cover page is enabled, the first page will 
be the cover page rather than page 1. 

 

Previous Page Ctrl + Page Up 

 

Go To Specific Page Ctrl + G 

 

Next Page Ctrl + Page 
Down 

 

Last Page Ctrl + End 

 

Previous Set  Ctrl + Up 

 

Next Set Ctrl + Down 

 

Mark 
Mark All Pages 

Ctrl + M 
Ctrl + Shift + M 

Bookmark selected pages. For the button 
shortcut, hold down Ctrl to mark every page. 

 

Unmark 

Unmark All Pages 

Ctrl + U 

Ctrl + Shift + U 

Remove bookmarks for selected pages. For 

the button shortcut, hold down Ctrl to 
unmark every page. 

 

Exit Ctrl + W Close the preview window. Note that the 
main AlbumGen window is hidden while the 

preview window is active, but reappears when 

the preview window is closed. 

 

Help F1 Context help for the preview window. 

 Save Marked Pages  This option will create a new album file with 

only the bookmarked pages. (Menu item: 

Bookmarked --> Save Marked Pages...).. 

 Copy Ctrl + C Copies the selected page to the Windows 
clipboard. You can use the Paste option from 
the main menu to add this page to the 
current album or a new album. 

 Save Ctrl + S Saves the selected page attributes as a 
template file which can be recalled using the 
Load option from the Page Setup window. 
The page content is not saved to the 
template. 

 Select All 
Select None 
Select Inverse 

Ctrl + A 
Ctrl + N 
Ctrl + I 

Shortcuts for page selection. Only affects 
pages currently displayed, not for the 
complete album preview. 
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Page Navigation 
These options provide various methods to switch to specific pages in the current 

album and are available under the Page menu. If a shortcut icon is available from 

the top toolbar it will be shown in the summary below. 

Icon Menu Item Shortcut Description 

 

Go To Page Shift + G Go to a specific page. 

 

First Page  Ctrl + Home Show the first page of the album. If a cover page 

is enabled, the first page will be the cover page. 

 

Previous Page Ctrl + Page Up Show the previous page. 

 

Next Page Ctrl + Page Down Show the next page. 

 

Last Page Ctrl + End Show the last page. 

 Bookmarks Ctrl + F1-F8 
Ctrl + Shift F1-F8 

Bookmarks are placeholders for a page. There are 
8 menu bookmark locations. 
 
You can use the menu items or shortcut keys to 

mark a page or select the marked page. The 
marked pages will be preserved when you save 
changes. 
 
The menu bookmarks should not be confused 
with named page bookmarks. 

 
The latter type of bookmark is a custom phrase, 
name or keyword to identify a page for searches 
and is displayed in the page navigator window. 

 

Go To Page Selection Window 

When you choose the go to page option, a window will be displayed: 

 

You can enter a page number, C or COVER for the cover page, or choose from the 

dropdown list for named pages, a menu bookmarked page, or pages with named 

bookmarks. 
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Album Page Changes 
These options are available under the Page menu. 

Inserting New Pages 

A new page can be inserted to the end or start of the album, or before or after the 

current page. Inserting a new page will use the same page setup as the current 

page, minus any page objects. However, new pages can be setup using a template 

instead of the current page, based on the option in the page setup window. 

 

Deleting Pages 

The page deletion window will show all current pages for the album in a list. 

 

The current page will be selected for deletion by default and indicated by the red 

checkmark icon. 

You can delete other pages by checking the Multiple Pages option. All pages will 

be deselected. At this point, you need to select pages from the list on the left and 

then click on Select. This will add checkmark icons to the selected pages, marking 

them for deletion. 

To unmark pages for deletion, use the Unselect or Clear All options. 

To commit the deletions, click on the Delete button. 

Click on View Page to view the current pages selected. 
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Reorganizing Pages 

This option allows you to revise the ordering of the pages in the album. You have 

the option to not move pages into the reorganized list. This in effect removes those 

pages from the album. 

 

The current page list is on the left. The re-arranged pages are on the right. If pages 

have been named, the name of the page appears in the rightmost column in the 

list. 

To move pages from the left to the right, select the pages in the left list then 

choose one of these methods: 

• Right click on the left list. 

• Click on the right arrow button in the middle toolbar. 

• Choose Assign Pages from the menu or use the shortcut Ctrl + Right. 

• You can move all pages over using the double-plus green button or the 

Assign All Pages from the menu. 

Once pages are assigned, they are removed from the available list. 

Removing pages from the assigned list is done using equivalent options (right click 

the selection, left arrow in the toolbar, unassign from the menu, Ctrl + Left 

shortcut). 

You can move pages up and down in the assignment list using the 4 up/down 

buttons in the middle toolbar (move to top, move up, move down and move to 

bottom). 

Swapping 2 pages can be done by selecting only 2 pages in the assignment list and 

clicking on the swap button. 
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Previewing pages on either side can be done by clicking on the bottom two icons in 

the middle toolbar. 

Click on the green checkmark button or choose save option from the menu to 

commit the assigned list as the new album page order. 

Any pages that you do not assign from the available pages (left) list will effectively 

remove them from the album. 

Erasing Page Content 

Erasing a page involves removing selective page and/or object content. 

 

Checking all options effectively leaves a blank page. 

Copying Pages 

This option will copy the current page to the Windows clipboard. Use the Paste 

option from the Edit menu to add this as a new page. When adding the page, you 

can selectively choose what content to add to the new page. 
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Copying Page Attributes 

The Copy Attributes option will allow you to selectively use attributes from the 

current page to any other pages. This is an efficient method to apply specific 

changes to the page setup on one page to some or all other pages in the album. 

 

All pages excluding the current page will be listed on the left. If pages are assigned 

names, they will appear in the right column. 

There are 4 types of page attributes to copy shown as checkbox options on the 

right. 

The Add/Select All options will add pages for receiving the attributes, indicated by 

the red checkmark icon. 

The Remove/Select None options will remove any checked pages. 

Click on View Page to preview the selected pages. 

Click on Copy to transfer the checked attributes to the checked pages. 

Click on Titles when Titles Areas is checked to set which of the 12 possible title 

areas for text content will be copied. By default, the complete title area set will be 

copied. The number of title areas to be copied is shown in parentheses to the right 

of the checkbox option. 
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Comments, Names and Bookmarks 

The Comments option in the Page menu allows viewing or changing the 3 non-

printable attributes of a page. This window is an alternative to the Comments tab in 

the Page Setup window. 

 

 

Page Names 

Pages can be assigned a name, which is any arbitrary text which can be placed into 

a table of contents (TOC). Table of contents pages can’t be generated without page 

and/or object names. The page name will appear in the page navigator window. 

Bookmarks 

A bookmark is any text phrase or keyword you want to associate with this page. 

The Search utility will allow you to search for pages by the bookmark text. 

Comments 

Comments can be up to 16,000 characters in length, and will appear with a visual 

indicator (an asterisk * preceding the album name) on the workspace toolbar when 

comments exist for the page. 
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Adding Page Objects 

Objects are added to the current page using options from the New submenu under 

the Object menu. 

When placing objects using the toolbar button, shortcut key or menu selection, the 

mouse cursor will change to an icon representing the selected object type. 

To cancel placement of an object, press Esc or press the new object keyboard 

shortcut a second time. If drag selecting a rectangle with the mouse to place the 

object hold down the Ctrl key while the Left Mouse button is depressed to cancel 

the placement. 

Click-Once Method vs Mouse Drag Method 
You can choose to place objects by clicking once with the left mouse button and 

then releasing the button without dragging. This will set the size of the object to a 

preset value or the size of the last placement for the same object type. 

If you click and hold down the left button while dragging in any direction a selection 

rectangle will be displayed. You will set the size by releasing the left mouse button. 

Page grid settings will determine the granularity of the selection rectangle and the 

initial upper left corner of the object. 

Default grid placement and sizing values are based on version 2 of AlbumGen. This 

means: 

• The start position for the object will align to the nearest 5 millimeters (or ¼ 

inch if using inches for units). 

• Drag sizing with the mouse will be in incremental steps of 5 millimeters or ¼ 

inch. 

Page Grid items under the Options menu can alter the grid spacing for both 

position and incremental step size. Placement Settings under the Objects menu 

can also be used on a per object basis. Refer to the Album Workspace Guide help 

topic for more information. 

Size and Position Label 
This option can be enabled in the Workspace Settings from the Options menu. This 

label is a small popup area that always appears at top left corner of the object 

frame when the left mouse button is held down while hovering over the object.  It 

shows the object’s position (X, Y) and size (W, H) in the current display units. The 

font size, colors and decimal places can be adjusted for this label. 
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Album Text Content 
Album pages and objects allow for text content with two distinct formats. 

• Plain text content allows for a single choice of font name, attributes, color 

and size, and only a single line of text. 

• Multiline text content allows for multiple lines of text, and each line can be a 

mix of fonts, sizes and colors. 

The following table summarizes text content sources in album pages. 

Content Source Type Notes 

Page Titles Plain Each title area can have a title line and subtitle 
line. The title and subtitle can have their own 

font, size and color settings and can be unique 
for each of the 6 areas around the page. 

Labels Plain Label objects are intended to easily place a 
single text line on the page. 

Text Multiline Text objects are unframed object types without a 
width or height and can be aligned both 

horizontally and vertically. 

Paragraph Multiline Paragraph objects are framed versions of Text 

objects with a set container size for the text 
content. Paragraphs can optionally use word 
wrap and full justification and a border style like 

shapes. 

Shapes Multiline A shape has 4 distinct text areas and each area 

is a multiline text format. For text areas inside 
the shape, they are constrained by the object 

frame size and without proper font scaling 
applied, can extend outside the frame and be 
clipped at the edges. 

 

Fonts 
If you share albums with someone else or between PCs, it’s possible that the 

installed fonts on your PC may not include fonts referenced inside the album file. 

AlbumGen will enforce font substitutions at the time the album is opened, as you 

must decide what to do when an album font isn’t installed. The current font 

substitution list can be viewed or modified from the Font Mapper item under the 

Utilities menu. 

The 3 common font technologies (TrueType, OpenType and Type 1 PostScript) will 

work with AlbumGen, however some fonts might not appear correctly for the Type 

1 format. AlbumGen relies on the font display functionality built into the version of 

Windows you are currently using for both display on screen and output to the 

printer. If a font behaves unexpectedly, you should remap it to an alternate font 

using the Font Mapper, or modify the object/page content to use a different font. 
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Multiline Text Entry 
For shape, paragraph and text objects, text content is entered using a simple edit 

window which is based on the Rich Text file format. AlbumGen isn’t intended to be 

a substitute for a word processor in terms of text entry, so keep in mind that there 

are several restrictions which are enforced: 

• No embedded images or any type of object content which isn’t strictly text. 

• No tabs are allowed. If you need tabbed style multi-column text content, you 

will need to use a table object or a combination object group consisting of a 

table and text/paragraph objects. 

• No checking for spelling or grammar. 

• Word wrap will only break on hyphens and spaces. Automatic hyphenation is 

not supported. 

• No bulleted or numbered lists. You will need to use table objects to create 

such lists. 

AlbumGen text content is based on fonts, colors, and sizes and nothing more. Rich 

text files support far more content. AlbumGen doesn’t store text content in rich text 

format. Any attempts to copy/paste non-text content from another application such 

as a word processor will have that content either filtered out or blocked. 

The edit window for text uses built in rich text edit components from the version of 

Windows you are using and is limited by its capabilities. 

Word Wrap and Line Breaks 
The text edit window by default wraps text according to the object type. 

For text areas of shapes and the Text object, the edit window never wraps text and 

a horizontal scroll bar will be displayed as needed. 

For paragraph objects, word wrap of the edit window is tied to the word wrap 

option for the object. 

When word wrap is used, it doesn’t reflect the word breaks for the paragraph object 

as the edit window size has no direct relationship to the size of the object frame. 

When word wrap is not being used, ensure that you place line breaks with the 

ENTER key where needed. 
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Text Edit Window 
Text content window is either a standalone sizeable format, or is embedded as a 

part of an object property’s window within the text tab. 

It will be seen as a window with a white background and a toolbar above this 

window. 

 

1 

 

Applies or removes the bold setting on the selected text. If there is 

no selected text, the next typed character will be bold (if the icon is 
red) or not bold (if the icon is cyan). 

 

Applies or removes the italic setting on text. 

 

Applies or removes the underline setting on text. 

 

Transfers the text content to a sizeable edit window. 

 

Inserts special symbols or characters. 

 

Changes the background color for the edit window. This is useful 

when choosing text colors like white or a color that is hard to see 
against the default white background. The background color setting 
is per text area. 

 

2 For text which uses a small point size, it may be hard to see the text on your 

screen in the edit window. Use this dropdown list to zoom the edit window 
text area to the chosen percentage. 

3 This is the color currently assigned to the selected text, or which will be 
assigned to the next typed characters. 

4 This is the font size currently assigned to the selected text, or which will be 
assigned to the next typed characters. If you enter a point size directly into 
this field, you must press the ENTER key to accept the change. 

5 This is the font name currently assigned to the selected text, or which will be 
assigned to the next typed characters. 

 

Shortcut Keys 

Aside from the usual shortcut keys such as those for copy and paste, there are 

some extra shortcut keys that can be used. 

Ctrl + B Bold on/off 

Ctrl + I Italic on/off 

Ctrl + U Underline on/off 

Ctrl + Ins Insert a special symbol or character at the current cursor position 

Ctrl + D Insert the 2 character prefix key for an En Dash 

Ctrl + E Insert the 2 character prefix key for an Em Dash 

Ctrl + F Insert the 2 character prefix key for a shifted non-breaking space 
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Special Symbols and Characters 

The special symbols window provides a convenient method to insert symbols from 

the 4 special font types (Symbol and 3 sets under Wingdings) along with five 

common groups under the current font chosen in the text edit window. 

To insert a character, first select a source from the down arrow button, then select 

a character in the list. Click on Insert to choose the selected character for 

insertion. 

You can also double click directly on the character in the top grid. 

Once a character has been used, it’s added to the recently used list at the bottom. 

Click on the down arrow button to choose a different character group. 

Use the Clear button to empty the recently used list. 
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Non-breaking Hyphens and Spaces 

When attempting to insert non-breaking hyphens (“En Dash” and “Em Dash”) or a 

non-breaking space (a Shifted Space, or character code 160), the values will not be 

saved properly from the text edit window into the album page file due to limitations 

of the rich text edit control not being able to handle them. They will in fact be 

converted to a normal dash and space respectively. You would typically see this if 

you pasted these characters from Microsoft Word, as they would appear as normal 

hyphens once pasted. 

 

 

If you need to use these characters, especially for the purpose of keeping a word 

from wrapping in paragraph text objects, you will need to use the special 2 

character combinations in the edit window, where the first character is always the 

vertical bar or “pipe” character: 

|D En Dash (“–” slightly longer than a hyphen “-”) 

|E Em Dash (“—” slightly longer than an En Dash “–”) 

|S Shifted Space (can be used to prevent word wrap breaks) 

|| To use the vertical bar or pipe character as a literal in the text content 

   

Example: to avoid the phrase “page 20-22” from breaking to a new line on word 

wrap, you can enter it as “page|S20|D22” into the edit window. 

To avoid having to key these character combinations, use the shortcut keys 

(Ctrl+D, Ctrl+E or Ctrl+F) described previously. If you choose these characters 

from the Insert Symbols/Characters window, the 2-character format will be placed 

into the edit window. 

Setting a Point Size Directly 

Selecting a point size from the dropdown list will change the selected text to the 

new point size. If you want to enter a value directly into the text field or choose a 

value not in the dropdown list, make sure to press the ENTER key after entering the 

point size to commit the change to the selected text. 

Multiple Font Styles, Attributes or Sizes Selected 

When selecting a group of characters in the text window, it’s possible that selection 

can contain more than one font style, font attribute (bold, italic, underline) or point 

size. 



AlbumGen 3 User Guide  P a g e  | 119 

The attribute icons will not appear in red to indicate bold, italic or underline unless 

all characters selected are the same for each of those 3 attributes. The point size 

will not be set in input field if there is more than one point size in the selected 

characters. The color and font name will remain as is, but will only reflect the last 

color/font name used while entering text content. 

Sizeable Text Edit Window 
The 3 object types which use multi-font text entry (Text, Paragraph and the 6 

shape types) have a fixed size edit window for text content as the properties 

window can’t be resized. 

If you need more space to see as much text content as possible, the sizeable edit 

window will take the current content from the object properties window. When you 

save the changes in the sizeable edit window, the text content will be transferred 

back to the object properties window. 

 

Click on Save to save the current text content to an RTF (Rich Text Format) file. 

Click on Load to place the contents of an RTF file into the edit window. 

Rich Text Content Restrictions 
The multi-font text content for AlbumGen doesn’t permit everything which can 

appear in a rich text format file. Only text content is permitted. Images and 

embedded object content are not allowed. 
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Shape Object Properties 
The properties window is accessed from the Settings submenu under the Object 

menu when you select only one object which is of the shape type (Rectangle, 

diamond, ellipse, triangle, or polygon). Selecting multiple shape objects will display 

a different window. 

Location and Size 

 

Undo/Default 

The bottom left button will undo any changes made and revert back to the settings 

at the time the properties window was first displayed if editing an existing object. 

For new object placement, the button is named Default and clicking in it will reset 

all settings for the object to default values. 

Sizes 

This button launches the Object Size Manager from the Utilities menu, allowing 

for custom sizes to be added to the Sizes dropdown list. 
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Preview 

This button will preview the current object by itself on the current page with any 

new changes, allowing you to view the impact of any pending changes before 

clicking 'OK' on the Shape Object Properties window. 

 

The menu and toolbar options for this window (except for the close button) are 

designed to support zooming and panning the preview area. 

The size and position of the page preview window, the current zoom level, and the 

page center point are preserved any time you use the preview mode on the same 

object until you close the Shape object properties window. This applies to 

properties windows for all object types. 
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Icon Menu Item Shortcut Description 

 

No Pan/Zoom N Disable either the zoom or pan tool mode if 

enabled. 

 

Zooming Tool Z Enable or disable zoom mode. 

 

Panning Tool P Enable or disable panning mode. 

 

Zoom Detail SPACE Zoom into and out of a detailed zoom level. 

 

Zoom to 300% 3 Zoom to 300% magnification. 

 

Zoom to Specific S Zoom to a specific magnification level. 

 

Fit to Screen Ctrl + S Fit the contents to the preview window area 

within and the current primary screen size. 

 

Fit to Width F11 Fit the width of the page to the preview area. 

 

Close F12 Close the preview window. 

 

Help F1 Help topic for the preview window. 

 Zoom In Ctrl + Ins  

 Zoom Out Ctrl + Del  

 Zoom to 100% 1  

 Zoom to 200% 2  
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Shape Position 

Shapes can contain an optional border style. The actual position for a shape is the 

upper left corner inside the border (if present). The location settings however allow 

you to set the position relative to the outside border. 

The values at the bottom of the window indicate the page position after rotation 

and shift amounts (set in this window as positive or negative adjustments) have 

been applied. The page position is also based on the page origin (page, margin or 

border). For example, with a left margin of 25.4 mm and a border of 5 mm, a 

horizontal location of 0 would be 30.4 mm relative to the left edge of the page. 

Shape Size 

The size of the shape is based on the frame width and height without regard to a 

border style or rotation angle. 

There are pre-supplied sizes provided by SoftPro selected from the dropdown list. 

To use a value from that list, select it and then apply it with the Set button. To add 

new custom sizes, click on the Sizes button. The Object Size Manager found 

under the Utilities menu is described in detail in a separate help topic. 

Frame Space Padding 

Inside padding is an extra amount of space between the object frame and the start 

of text/image content inside the frame. 

Outside padding is the maximum width of the border style if the border style has 

less thickness than this padding value. For example, if the border style has 

thickness of 2 mm and the outside frame padding is 5 mm, the amount of inner 

white space is 3 mm. If the outside padding were 1 mm, there would be no extra 

padding. 

 

  



AlbumGen 3 User Guide  P a g e  | 124 

Properties 

 

Shape Type 

Six of the object types available are shapes which and all share the same properties 

window. You can override the current shape type by choosing a new type from the 

dropdown list. Picking the polygon type will enable the settings in the Polygon tab. 

Shape Rotation 

The rotation angle affects the border style and in some cases the image inside the 

object frame. Text content is never rotated. Click on the down arrow button for 

preset angles, or type in any angle between 359.99 and -359.99 degrees in the text 

field. 

Fill Color 

The fill color doesn’t extend into any outside frame space padding as that padding 

is considered part of the border area and the border area is not filled with any color 

except those used by the border itself. 

Border Type 

There are 3 border choices. 

None The shape will not have a border. Without a border, it will 
appear outlined in a red dash on the page in the main 

workspace. 

Border Style Border styles are chosen from a dropdown list which can contain 

both styles pre-supplied from SoftPro or custom styles created 
using the Borders Manager option under the Utilities menu. 
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Brackets Brackets are 2 line segments which are joined together at the 

vertex of the shape. For rectangles, the vertex is optional at any 
of the 4 corners, as long as one corner is chosen. An ellipse has 
no vertices, so brackets are not allowed. For all other shape 

types, the vertices are not optional and a bracket will always be 
applied. 

 

Border Style 

Select a style from the dropdown list. A preview of the style will appear in the 

bottom area of the properties window. A weight factor from 1 to 4 can be applied to 

set the thickness of the border. Any color can be assigned to the border content as 

long as the border wasn’t defined as a multi-color format. The RGB (red-green-

blue) value of the color is shown next to the color swatch. 

If the border was created using dashed lines, the end caps on each dash segment 

can be set to either a flat, round or triangle format. 

The corner setting determines how vertices are joined together. The miter format is 

the default. 

The miter limit is used to limit the extent of the corner applied to a vertex when the 

angle of the join is small, which tends to result in the join extending quite far. This 

is noticeable with diamonds and triangles with thick lines at sharp angles. When the 

miter limit is reduced a point will be reached where the vertex will be drawn with a 

bevel instead of a corner join. Miter limit only applies to miter joins. 
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Brackets 

Brackets are line segments which join at the vertices of the shape. Ellipse shapes 

have no vertices so brackets are disabled for this shape type. 

 

Setting the color, weight, line ending, corner style and miter limit is the same as for 

border styles. Click on the down arrow button to choose a bracket weight using an 

approximated point size value – it will be converted to the 1/300 inch weight size 

unit value. 

Brackets can be a specific percentage of the shortest edge of the shape. The 

shortest edge is used since a longer edge with a large percentage could cause the 

lines on the short edge to end up connected as a single solid line. 

Using a specific length can cause the lines to run together on shorter edges if the 

value is at least 50% of the length of the shorter edge. This is permissible and a 

single solid line will be rendered. 

For rectangular shapes, the 4 corner options are enabled. You must choose at least 

one of the 4 corners to set a bracket. Interior color fills have been applied to the 2 

examples below to show how the brackets are drawn relative to the object frame 

size. 
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Polygon Settings 
You must choose the Polygon shape from the properties tab to enable polygon 

shape types. Alternatively, click on the Enable Polygon button to set a polygon 

shape type. 
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Polygon Types 

Choose the polygon type from the Type dropdown list. 

Rectangle 

  

Isosceles Triangle 

  
Right Angle Triangle 

  
Diamond 

  
Parallelogram 

  
Trapezoid 

  
Pentagon 

  
Hexagon 

  
Octagon 

  
 

Constrained/Regular Size 

A common attribute to the polygon type is either constrained aspect ratio or a 

regular size vs. an irregular size. A constrained will keep the shape width and 

adjust the shape height to match. Polygons with 5-8 sides can be regular or 

irregular shapes. Irregular shapes have additional settings for altering the vertices. 

Flipping the Shape 

Some of the polygon types will allow for the shape to flip horizontally and/or 

vertically. 

  



AlbumGen 3 User Guide  P a g e  | 129 

Rectangle 

A rectangle can use squared or rounded corners. When you select rounded corners, 

the Attributes box expands and you can set the radius the same for each corner if 

you check the 'Use a separate radius for each corner'. The Attributes box expands 

further and you can then se, or use an independent radius for each corner. A radius 

of zero will create a square corner. 

Isosceles Triangle 

A midpoint vertex on the baseline edge can be dded by checking the 'Apply 
Midpoint indent to Long Edge' check box.  The Attributes box will expand, allowing 
you to specify an indent percentage of the base toward the opposing vertex. 

 

Right Angle Triangle 

A midpoint vertex to the long edge can be applied and shifted inward to the 

opposing right angle vertex. Click on 'Apply Midpoint Indent to Long Edge' to 

expose the input box for the percentage shift desired. 

Diamond 

A shift of the 2 side vertex points can be applied with percentage shift upwards or 

downwards. 

Parallelogram 

This shape can have a horizontal or vertical orientation with a positive or negative 

shear angle. 

Trapezoid 

The top edge of the trapezoid can be set as a percentage of the bottom edge. 

Pentagon 

The side vertices can be shifted upwards or downwards and the base width can be 

set to a percentage of the object width. Select the 'Irregular' button to modify these 

settings are not used for a regular pentagon. 

Hexagon 

A hexagon can have a vertical or horizontal orientation. If the top and bottom 

edges are linked, then the edge width along with vertex shift can be applied. If they 

are not linked, then the top and bottom edge width can be independently set as a 

percentage of the object width. Regular hexagons can only be adjusted for 

orientation. 

Octagon 

A regular octagon has no additional attributes. If sides are linked, the edge vertices 

can be shifted and the size of the edge can be adjusted. When not linking edges, 

they can be adjusted for width only as a percentage of object size. 
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Image Links 

 

Images are not embedded into an album file. The image path and image name 

(without an extension) are stored in the album file. If you have the same image 

name under two or more different types (i.e., a JPG and TIF file with the same 

name) in the same location, AlbumGen has a specific priority by image format: 

• JPEG (Extension must be one of JPG, JPE or JPEG) 

• Portable Network Graphics (Extension must be PNG) 

• Bitmap (Extension must be BMP) 

• Tagged Image Format (Extension must be TIF or TIFF) 

• Graphics Interchange Format (Extension must be GIF) 
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Assigning an Image by File 

Click on the Change button to add a new image or change the current one if 

present. This will display the image browser window. 

 

The dropdown list contains all of the recent locations you have visited with the 

browser. Picking a path from this list will change to that location. The current 

location is shown in the status bar at the bottom. 

The left side list contains all recognized image files found in the current location. 

The total number of valid image file names is shown in the status bar. 

Selecting a single image in the list will show a preview of the image. If the image is 

smaller than the preview space, it will not be resized to fill the preview area. The 

remaining space is filled with a color setting from the General Settings window. 

You can resize the browser window and the image will scale to fit the new preview 

size as long as it’s larger that the preview width and or height. 

The image size will be shown below the preview area. The size in the current 

display units set in the Options menu, either millimeters or inches. 

The DPI value is the resolution embedded in the image file. If no embedded DPI 

value can be found, the General Settings window has an option to set a value 

(default is 72 DPI). 

The DPI value is important only if you choose the Print Size aspect adjustment. 
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You can change the current image file location using any of the 3 buttons on the 

left. 

• Click on Browse to use a folder browser window. 

• Click on File to find any image file which will set the location once you select 

an image file. 

• Click on Path to manually enter a location. 

Click on None to remove the existing image link for the object. 

Click on OK or double click the name of the image in the list to assign it to the 

object. 

Assigning an Image from the Clipboard 

If a compatible image is present in the Window clipboard, you can click on the 

Clipboard button. 

 

The default location for images taken from the clipboard will be an AlbumGen-

specific folder under your Windows Documents folder. You can change the default 

save location using the Browse, File or Path buttons. 

If possible, the DPI of image will be taken from the image content in the clipboard. 

You can override this DPI value by entering a new one in the provided field and the 

size will change accordingly in the image format line. 

You need to provide a file name (without extension) and a save format (JPEG, TIFF 

or PNG). For JPEG format, select a quality level from the dropdown list. 
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The Browse button on the image link tab will open the location in File Explorer. 

The Remove button will remove the current image link for the object. 

Aspect Adjustment 

There are 5 options which control how the image is drawn which in turn affects how 

the object can be resized to maintain an image’s width to height aspect ratio. 

Stretch Version 2 of AlbumGen only allowed images to be stretched to fit 

inside the object frame. In stretch mode, the image will fit inside 
the shape, minus any space taken by the inside border or text 
content. 

Preserve The aspect ratio of the image will always match the ratio of 
width to height of the original image dimensions, no matter what 

the width or height of the object are. Extra space will be added 
to the sides or top/bottom of the image area to keep the ratio 

preserved. 

Keep Width These two modes are essentially the same in that the shape of 

the image is modified to preserve the aspect ratio of the image. 
By keeping the width, the height is the value that will 
automatically be adjusted. Keeping the height will allow the 

height to be change and the width will be automatically 
adjusted. 

 
Note that drag sizing with the mouse in the workspace will allow 
the width and height to be dragged, but the size will be based on 

the shortest distance of movement with the mouse. 
 

For example, if the width is dragged to the right by 10 mm and 
the height is dragged down by 4 mm, the adjustment to the 
height will be 4 mm, and the width will be adjusted to keep the 

image aspect ratio. 

Keep Height 

Print Size This mode preserves the original image aspect ratio, but the 

image print size determines the maximum size the image will be 
inside the object frame. 

 
For example, consider an image that is 700 x 500 pixels and is 
300 DPI. This equates to an image that is 2.33 inches wide and 

1.67 inches tall. 
 

If the available image space inside the object frame is 3 x 2 
inches, the object will fit inside this space with some extra area 

on all sides. 
 
If the available image space is 2 x 1 inches, the print size is 

larger than the available space, so will be reduced to fit inside 
the object area without any cropping on the edges. 
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Rotating the Image With the Shape 

If you check this option, the image will be rotated to match the angle that the 

border/bracket content is rotated. 

To avoid distorting the image due to the rotation, 3 of the 5 modes for aspect 

adjustment are not allowed with image rotation: 

• Stretch 

• Preserve Aspect 

• Print Size 

EzStamp Warning Icon and Missing Size Information 

This checkbox option indicates the display of the warning icon when creating 

objects using the EzStamp import options from the Extras menu. Most pre-supplied 

stamps provided by SoftPro will contain width and height information to generate a 

properly sized object in AlbumGen. In some cases, the source stamp may not have 

sizing content and this forces AlbumGen to use a pre-defined width and height that 

you can adjust. 

 

The missing size warning icon will only appear in the workspace and be displayed as 

a small image in the bottom right corner of the object frame as shown in the 

sample above. 

You can turn this warning icon on a per-object basis. To turn off the icon for all 

objects, you can either disable the option from the EzStamp Import window from 

the Extras menu (see below) or use the Search and Replace options from the 

Utilities menu. 

 
(the above is a snippet from the Multi Import screen) 
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Text Content 

 

Text content is placed into one of 4 areas for a shape object. 

Above 
Shape 

The text sits above the border frame and any optional bracket or 
border style. 

Below 
Shape 

The text sits below the border frame and any optional bracket or 
border style. 

Inside 
Shape 

The text sits inside the image frame, aligned to the top, middle or 
bottom. If an image is present, a middle alignment is forced to the 

bottom. 

Over 

Image 

The text sits on top of an image, aligned to the top, middle or 

bottom of the image. If no image is present, then the text content is 
ignored. Text over an image can use a solid color or transparent 
background. The default is white background to match version 2 of 

AlbumGen. 

 

There is no restriction on the width and height of text content in any area, as long 

as the text doesn’t exceed the width or height of the page, or any font size for the 

text falls below 2 points or is larger than 144 points. 

For text inside the frame, it will be clipped on the sides, top or bottom if it exceeds 

the available space. 
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Text Alignment 

Text can be aligned to the left, center or right for all 4 areas. 

Vertical Alignment 

This alignment only applies to the text inside the frame and over the image. Center 

alignment doesn’t apply to Inside Shape text if an image is present – the alignment 

will be treated as a bottom when rendering the shape. 

Font Scaling 

This is a general reduction or increase to all fonts for the text area. For example, if 

the inside shape text used 3 font sizes of 10, 12 and 14 points, and you applied a 

125% scaling value, the 3 fonts would have sizes of 12.5, 15 and 17.5 points. 

Text Gaps 

Text gaps are additional blank space areas for 3 of the 4 text areas. Above Shape 

text gaps are added between the top of the frame/border and the baseline of the 

last text line. Below Shape gaps are added between the frame/border bottom and  

the top of the first line of text. For Inside Shape text, the gap is extra space 

between the image and the text content. 

Spacing Adjustment 

This value is a percentage increase or decrease of the space between each line of 

text. If an area only contains 1 line of text, this adjustment has no effect. 

Character Width Adjustment 

This setting creates expanded or compressed versions of the font characters. 

Background Fill 

For Inside Shape and Over Image text areas, you can fill the area behind the text 

content with a solid color. The default fill options are the same as version 2 of 

AlbumGen: transparent for Inside Shape and white for Over Image. 
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Extending the Fill 

If a background fill is used, you may extend the fill to the edges of the object 

frame. An example of this is shown below (with a 1 mm inside spacing amount). 

 

X and Y Shifting 

These values apply to the Inside Shape and Over Image areas and allow adjusting 

the vertical and horizontal position of the text. This can be useful for non-

rectangular or rotated shapes. 

Height Spacing Adjust 

The spacing adjustment for the height is intended to complement the text when a 

background is filled. The previous example with a 1mm height adjustment is shown 

below. 
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Comments, Title Names and Bookmarks 

 

These 3 attributes are available to the following object types: 

• Image 

• Shape Types 

• Paragraph 

• Table 

• Text 

They are not printable, and 2 of the 3 attributes (Comments and Bookmark) are 

strictly for information purposes. The Title attribute is used as a name, and 

optionally for building a table of contents at the object level. 
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Comments 

Comments can contain up to 16,000 characters of text. When comments are 

present for an object, a small icon will appear in the bottom left corner of the object 

frame in the page workspace: 

 

Use the comments shortcut in the top toolbar to access the attributes for the 

comments along with the title and bookmark. 

 

This will present an alternate sizeable window from the object properties window. 
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Title/Name 

A title can be up to 128 characters in length. The primary purpose is to create a 

second level for a table of contents for objects, which needs to be enabled via the 

TOC checkbox. If the TOC option isn’t enabled, the title will act as non-printable 

information for searches and will be displayed in the page navigation window. 

In the example TOC preview page, the page title appears with the object titles 

indented to the right. 

 

In the page navigator, if a name or bookmark is assigned it will be shown as below   

 

 

Bookmarks 
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A bookmark is provided to mark an object with a keyword or phrase and is intended 

to aid in album searches. 

The Search utility is described in detail in a separate help topic. 

 

 

 

 

 

 

 

 

  



AlbumGen 3 User Guide  P a g e  | 142 

Text Object Properties 
The properties window is accessed from the Settings submenu under the Object 

menu when you select only one Text object or by right-clicking on the text object 

and selecting Settings-->Properties from the pop-up menu. Selecting multiple text 

objects will display a different window. 

Properties 

 

Refer to the shape object properties window for the details on the Undo and 

Preview buttons. 

Text Position and Alignment 

Text objects have no set width or height like a paragraph or shape objects. The 

position of a text object is based on its horizontal and vertical alignment. The 3 text 

objects below all have the same Horizontal Position, but 3 different alignments, all 

aligned to the vertical red line. 

 

When you change an alignment, the position of a text object doesn’t change, only 

how it’s rendered relative to its alignment. 
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The following example shows the 5 vertical alignment types all with the same 

Vertical Position aligned to the horizontal red line. 

 

For users migrating from version 2 of AlbumGen, there was no vertical alignment – 

the only alignment was top alignment. 

Top Baseline will place the text such that the first line of text has its baseline sitting 

on the vertical position. 

Center Aligned positions the text lines so that the midpoint of the overall text 

height intersects the vertical position. 

Bottom Aligned places the text so the bottom of the last line rests on the vertical 

position. 

Bottom Baseline Aligned only applied when there are 2 or more text lines for the 

object. In this case, the baseline of the last line of text rests on the vertical 

position. 

Note that object distributions and alignment to other objects are dependent on the 

alignment of the text, not its size. Some alignment options may give results you 

may not expect if using an incorrect horizontal or vertical alignment. 

The shift values for location can be used to move the text object by a specific 

amount using positive or negative values. 

Font Scaling and Frame Width 

The checkbox option at the top of the settings window is checked by default when 

drag selecting a sizing rectangle on new object creation and unchecked otherwise. 

This setting determines if all font sizes used in the text content will automatically be 

scaled to exactly fit into a specific frame width. The height of a selection rectangle 

is not used to scale the fonts. 

The Frame Width setting will be enabled when the 'Set the size for all fonts..." 

checkboxoption is checked, and a valid width in the current display unit type (IN or 

MM) must be provided. 

Text Rotation 

Text content may only be rotated in 90-degree increments (none, 90, 180 or 270 

degrees). If you need text rotated at odd angles, you will need to convert the text 

object to a clipboard image from the Edit menu (Copy to Image) and place it on 

the page as a rotated Image object. 
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Spacing Adjustment 

This value is a percentage increase or decrease of the space between each line of 

text. If the object only contains 1 line of text, this adjustment has no effect. 

Character Width Adjustment 

This setting creates expanded or compressed versions of the font characters. 

Text Content 
This tab contains the standard multiline text edit window as described in the Album 

Text Content help topic. 

 

The options shown in the above illustration, on the toolbar, just below the menu (B-

Bold, I-Italics, U-Underline, etc.) are identical to the text options for Shape Object 

Properties.  Please refer to the Text Content section under Shape Object Properties 

for complete details. 

 

Selection Size Rectangle 
The selection rectangle in the workspace which indicates the frame size of a text 

object is based on the print size area. Depending on zoom level and font choices, 

the text may be smaller than the selection container – this is a limitation of the font 

rendering by AlbumGen to your screen and is not necessarily indicative of how it 

will print. The Print Zoom magnification level will always show the text as it would 

be drawn at the print resolution value in the AlbumGen General Settings window. 
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Paragraph Object Properties 
The properties window is accessed from the Settings submenu under the Object 

menu when you select only one Paragraph object. Selecting multiple paragraph 

objects will display a different window. 

 

A paragraph is like a Text object in terms of creating the text content, using 

combinations of fonts, colors and sizes. The key differences are that a paragraph is 

a framed container for text with a set width and height and that word wrapping 

without hard-line breaks is expected to be used to group lines of text together. 

Paragraphs automatically use word wrapping to fit the text into the frame. 

Being a framed object, a paragraph may use the same border styles as shape 

objects. 

Text is not scaled automatically when drag sizing a rectangle to a new width and/or 

height in the page workspace. The text may extend off the edges of the paragraph 

frame and you are expected to apply scaling or other sizing options from the 

properties window to ensure the text will fill the frame the way you want. 

Refer to the shape object properties window for the details on the Undo and 

Preview buttons. 

The object position is always the upper left corner of the frame size. Enter shift 

values into the corresponding fields to nudge the current position by a specific 

positive or negative amount. 

The Text Margins are spacing inside the frame to allow indents to be applied 

inside the frame edges. If word wrap mode is not enabled, text may run into the 

margin space and possibly off the right edge of the frame without scaling the text 

to fit. The same applies to the vertical margin. Too much text content may cause 

some of the lines of text to run off the bottom of the frame until resized. 
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Properties 

 

 

Alignment 

The text content can be aligned both vertically and horizontally within the margins 

(if defined) of the object frame. 

Word Wrap 

By default, Word Wrap is enabled, which means words will not be broken at the end 

of each line unless a line break (pressing ENTER) or a hyphen is encountered in a 

word. The text will automatically wrap to a new line when a spaces or hyphens are 

encountered. 

Word Breaks and Full Justification 

Note that non-breaking hyphens (En Dash and Em Dash) and non-breaking spaces 

will not wrap to the next line if those are the last characters before a line break 

would be applied. 

Full justification is generally not recommended unless you are creating paragraphs 

of sufficient width so that enough words per line are being used to create inter-

word spacing that is not too extreme. AlbumGen doesn’t auto-hyphenate words, so 

word wrap is based on the sizes of individual words for each line. 

Spacing Adjustment 

This value is a percentage increase or decrease of the space between each line of 

text. If the object only contains 1 line of text, this adjustment has no effect. 

Character Width Adjustment 

This setting creates expanded or compressed versions of the font characters. 
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Font Scaling 

This setting is applied to the current font sizes in the paragraph text to reduce or 

enlarge the text uniformly. 

Zoom Factor and Word Wrap 

AlbumGen will always break lines on spaces or normal hyphens using the sizes of 

each word based on the current printer and print resolution defined in the 

AlbumGen General Settings. 

Depending on the choice of words in the text content, the size of the frame, the 

size and style of the font, and the current zoom magnification level, the spacing 

between individual words may appear slightly different as you zoom in and zoom 

out. The Print Zoom magnification level will always show the word spacing as it 

would appear in printed output. 

Text Rotation 

Text can be rotated at 90-degree angles within the paragraph frame. The frame 

itself will not be rotated. 

Fit Text Method 

This option provides a choice on making automatic adjustments to the text or frame 

size. The choices depend on the word wrap option. 

Word 

Wrap 

Fit Text 

Method 

Description 

Both No 

Adjustment 

No changes will be made when you click the OK or 

Preview buttons. 

Yes Resize Frame 

to Fit 

The frame height (width if rotated text at 90 or 270 

degrees) will be increased or decreased to encompass the 
text at the current point size(s). There is a small amount 
of white space compensation applied, so you may want to 

resize the frame afterwards if you want to eliminate the 
extra spacing. 

Yes Resize Text to 
Fit 

The frame size will not change. The text point sizes will 
change to ensure the text will fit into the available space. 

As with the previous option, a small amount of white 
space compensation will be applied. 

No Increase 
Frame Width 

The frame width will be expanded (frame height if text is 
rotate at 90 or 270 degrees) to ensure the text will fit. 

No Resize Frame 
to Fit 

The frame width and height will be adjusted to enclose 
the size of the text content. 

 

With any of the sizing methods, a check is made to ensure that the frame size will 

not exceed the page width or height, and that the point size of any font used will 

not fall below 2 points or above 144 points. 
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Color Fill 

By default, the background behind the text content is transparent. You can choose 

a color for the background and optionally extend this fill into any margin space you 

may have added. For users of AlbumGen version 2, the margin area could never be 

filled, so you may want to review any paragraph objects from upgraded album files 

which used color fills. 

Bullets and Numbering 

When this option is checked, the Format button to the right of the checkbox will be 

enabled, allowing for customizations to add indented lists of sequential numbers or 

bullet characters. 

Use the first option to choose Bullets or Numbering. 

For Bullets, you can choose the font and character to use for the bullet. For 

Numbered lists, you can choose one of 3 different representations, along with the 

character pattern for the format and whether to apply upper/lower case format for 

letters and roman numerals. 

In either case, the Indent value is the total width of the indent to the left of the 

paragraph text. The Shift amount is how far to move the bullet/number text from 

the left side of the indent, based on the percentage of the indent width. Please note 

that the larger the font size being used for the initial word in the paragraph text, 

you may need to increase the indent amount to compensate to avoid the bullet or 

numbering information from overstriking the text content. 

The font size may not be changed for bullets/numbers and will be the same as the 

first font used on the first word of any line/paragraph with the bullet/numbering 

marker character. You can choose to apply bolding to the bullet/indent text. 

 

 

Patterns for numbering lists is any literal text characters not counting the # 

symbol. This symbol is the placeholder for the sequential value, which begins with 
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the Start Number value and increments by 1 for every occurrence of the marker 

character at the start of each line/paragraph where you want to apply an indented 

bullet or sequence. 

Two common patterns would be #. and (#). 

Indenting for bullets and numbered lists requires a leading marker character on the 

first line of each text paragraph or individual text line. This character can be a 

hyphen (-) or either variation of the standard bullet character (· or •). 

If this character is detected, it will be removed from output on the screen or printer 

and a bullet/numbered indent will be applied. 

Example: The line below will be indented with a bullet or number sequence: 

-The quick brown fox. 

Note that the marker character must be in the same font and color as the first 

character which follows it in the text line, or the indentation will be ignored. 

Indents will not be applied if twice the indent size is greater than the available 

width for text in the paragraph object. 

 

 

Don’t Break Words on Hyphens 

To preserve AlbumGen Version 2 behavior, word breaks will not be applied when 

hyphens are encountered between characters with word wrap enabled. This option 

must be unchecked on the settings window to apply word breaks when hyphens are 

detected. If you want to preserve a hyphen with this option unchecked and not 

break the word, you should use a non-breaking hyphen. 
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Text Content 

 

The text edit tab is the same as that used for the Text object with one notable 

difference. 

If word wrap is enabled, then it will also be enabled in the edit window and no 

horizontal scroll bar will appear. 
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Border Style 

 

Paragraphs can use an optional border with the same style choices used for the 

shape object types. 

Refer to the shape object topic for details on border style settings. Note that 

paragraphs may not use the shape’s bracket type for a border. 

Without a border style, the paragraph will always appear in the workspace with a 

dotted red outline. 

 

Comments, Name and Bookmark 
This tab is the same as for Text and Shape objects. Refer to the general help topic 

for Comments, Title Names and Bookmarks within the 'Shape Object Properties' 

topic. 
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Line Object Properties 
The properties window is accessed from the Settings submenu under the Object 

menu when you select only one Vertical or Horizontal line object or by right-clicking 

on the line and selecting Settings-->Location/Size OR -->Properties from the pop-

up menu. Selecting multiple line objects will display a different window. 

A line is a simple set of segments grouped as solid/dashed line patterns optionally 

separated by intervening space segments, in a single color or with multiple colors. 

If you only require a single or solid dashed line segment in one color, with 

additional line endings and rotational options, use the plain line object type. 

Location and Size 

 

Undo/Default 

The Default button will undo any line object property changes made and revert 

them back to the settings at the time the properties window was first displayed if 

editing an existing object. For new object placement, clicking the Default button 

will reset all settings for the object to default values. 

Preview 

The Preview button will open the Object Preview window and show the line by itself 

on the current page, allowing you to determine whether any additional adjustments 

are needed before clicking on the OK button. 

Position 

The position is always relative to the upper-left corner of the page, depending on 

the grid selection (Page, Margin or Border) and is based on the orientation and 

opposite rendering order (see the properties tab). 



AlbumGen 3 User Guide  P a g e  | 153 

The values at the bottom of the window show the current position of the line on the 

page after shift amounts (set in this window as positive or negative adjustments) 

have been applied. The page position is also based on the page origin (page, 

margin or border). For example, with a left margin of 25.4 mm and a border of 5 

mm, a horizontal location of 0 would be 30.4 mm relative to the left edge of the 

page. 

Line Length 

The length of the line includes the end cap size. The entire line will fit within the 

length value. 

Properties 

 

Line Style 

Select a style from the dropdown list. A preview of the style will appear in the 

bottom area of the properties window. A weight factor from 1 to 4 can be applied to 

set the thickness of the line segments. Any color can be assigned to the line as long 

as it wasn’t defined as a multi-color format. The RGB (red-green-blue) value of the 

color is shown next to the color swatch. 

Orientation 

Lines can be horizontal or vertical. If you need to rotate this object type at any 

angle, you will need to use the Copy to Image option from the Edit menu and 

then place the rotated image into an image object. 

Alignment 

The standard draw direction of the line/space segments is from top to bottom or 

left to right. If you need to draw from bottom to top or right to left, check the 

alignment option to flip the drawing direction. 
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Line Color 

As long as a line style isn’t created using multiple colors, you can choose a single 

color to apply by clicking on the color swatch. 

Line Ending 

The endings of each line segment can be set to square, round or triangular. 

Dashed Line Style 

This setting only applies to line styles which contain dashed segments. This will set 

the end style of each dash in the segment, using the same 3 choices as the line 

ending. 

  



AlbumGen 3 User Guide  P a g e  | 155 

Plain Line Object Properties 
The properties window is accessed from the Settings submenu under the Object 

menu when you select only one plain line object. Selecting multiple plain line 

objects will display a different window. 

A plain line is a single line with a specific thickness and color, either solid or dashed, 

with a choice of line endings. 

 

Location and Size 

 

 

Position 

The position is the starting point where the mouse was clicked on the page in the 

workspace, taking into account any alignment to a page grid point. A shift value 

moves the entire line in a positive (right/down) or negative (left/up) direction. 

Moving the line using a mouse drag or the starting point by itself in the workspace 

affects its position. Moving the end point by itself will only affect the length of the 

line. 
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Length and Angle 

The length will be the distance between the two end points, not the width or height 

of the dashed selection rectangle in the workspace. The length doesn’t include the 

full size of the end styles. Depending on the type of end style (i.e. an arrow), the 

line ending may extend the overall length of the line on the page. 

The angle is any value between -359.99 and 359.99 degrees. Use the down arrow 

button to choose from preset angles. 

Drag Rectangle Placement 

For new plain line placement, there are 2 ways to set the angle and length of the 

line. 

• Clicking once without dragging a rectangle to a specific size will create a line 

of length and angle identical to the previous line placed. This is useful for 

repeat placement of the same line on the page. 

• Clicking with the mouse button and dragging while holding the mouse button 

down will create a rectangle selection that will set the line angle and length 

based on the connection points of the opposing corners in the direction of the 

mouse drag. 

When the plain line properties dialog is presented when the mouse button is 

released, a checkbox option will be visible to set the length and angle of the line 

based on the dragging rectangle. This checkbox option is not visible for changing 

properties on an existing object, nor is it visible when clicking without dragging to 

create the selection rectangle. 

If this option is checked, then line is drawn based on the opposing corner points of 

the drag rectangle. If not checked, then a straight line is always drawn. The 

checked status is persistent when the dialog window is closed. 

Templates 

Lines attributes (not counting length, position and color) can be saved to a name 

template, and will appear in the dropdown list. SoftPro provides a handful of 

common size solid and dashed lines. Click on the Styles button to create custom 

line formats and save them to a template. 

Swap Ends 

If the line has different styles at each end, you may want to swap the line endings. 

Click this button to swap the endings. 

Undo/Default 

The bottom left button will undo any changes made and revert back the settings at 

the time the properties window was first displayed if editing an existing object. For 

new object placement, the button is named Default and clicking in it will reset all 

settings for the object to default values. 
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Preview Area 

The bottom area for both the location and properties tabs will show a preview of the 

line. This will not necessarily be the actual size on the page and is indicative of the 

format of the line rather than a 100% size preview. 

Properties 

 

Thickness 

The thickness is in 1/300 inch units with one unit being approximately ¼ point in 

size. The maximum thickness is 150 units or ½ inch. 

Line color 

Lines may only be one color. Click on the swatch to set a new color. 
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End Caps 

The end of each line can have a unique end cap style. The Match End Caps option 

ensures the ending cap style will be the same as the starting style. The samples 

below include the selection marquee to indicate how the end cap extends past the 

end of the start/end points of the line. 

Style Sample Description 

Flat 

 

A flat end cap stops at the length of the line 

with no extension. 

Square 

 

A square end cap has ½ its size extending past 
the end points of the line. 

Round 

 

A round end cap has ½ it’s radius extending 

past the end points of the line. 

Triangle 

 

A triangle end cap extends 100% past the end 
points of the line. 

Diamond 

 

A diamond end cap has ½ its size extending 
past the end points of the line. The inner half of 

the diamond shape merges into the line 
according to its thickness. 

Rectangle 

 

A rectangle end cap has ½ its size extending 
past the end points of the line. 

Circle 

 

A circle end cap has ½ it’s radius extending 
past the end points of the line. Unlike the round 

end cap, a multiplier setting allows the end cap 
to be larger than the width of the line. 

Arrow 

 

Arrows have a width, length and concavity 
setting, and the inner vertex/edge will intersect 
the end of the line. 
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Multiplier 

This setting applies to the Diamond, Rectangle and Circle end caps. Increasing the 

multiplier will increase the size of the end cap. This multiplier is relative to the 

current thickness of the line. 

Unit Width, Length and Concavity 

These settings only apply to the arrow end cap style. 

Unit width is the width of the arrow perpendicular to the line. This is a multiplier of 

the current line thickness. 

Unit length is the size of the arrow parallel to the line. 

Concavity is a factor between -100 and 50 that defines a vertex that moves inward 

or outward from the arrow vertices perpendicular to the line. 

Dashed Lines 

A dashed line is based on pairs of dash and space segments. There can be from 1 

to 3 pairs. 

By default, dashed line sizes scale to the thickness of the line and the dash-space 

segment sizes are relative to the line thickness. The dashes and spaces will look the 

same regardless of the line thickness. 

By checking the option to not scale the dashes and spaces, the segment sizes are 

always treated as 1/300 inch units. 
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Consider the same dash and space size for both scaled (unchecked) and unscaled 

(checked) options: 

Scaled 

 

Unscaled 

 

 

Style Selection and Line Attributes 

An important difference between the plain line style and shapes/normal lines which 

use style templates is that the plain line copies the template attributes to the album 

page and saves them to the album file. Once a template is selected, the current 

attributes are copied from the template. At this point, any additional attribute 

change you make apply only to the selected plain line object and have no effect on 

the template the attributes were copied from. 

Line Styles Editor 

The Styles button is a shortcut to the Line Styles Editor available under the 

Utilities menu.  There is a separate help topic which covers this editor.  
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Label Object Properties 
The properties window is accessed from the Settings submenu under the Object 

menu when you select only one object which is of the label type. Selecting multiple 

label objects will display a different window. 

 

The position is the starting point where the mouse was clicked on the page in the 

workspace, taking into account any alignment to a page grid point. A shift value 

moves the label in a positive (right/down) or negative (left/up) direction. The 

position is always relative to the upper left corner. 

Labels are lightweight text objects which have several limitations when compared 

to a normal Text object: 

• No horizontal or vertical alignment. 

• One font choice with a single size and set of font attributes. 

• One color choice. 

• A single line of text. 

Labels can be rotated at any angle. 

Label text is drawn with a small amount of white space on the sides. Given this and 

a lack of alignment choices, aligning a label with other objects is not going to 

necessarily be accurate when compared to Text and Paragraph alignments to other 

objects. 

A label is intended to provide simple text markups on your album pages. You 

should always use a Text or Paragraph object type for complex text content. 

If you need to insert special characters or symbols click on the  button. 



AlbumGen 3 User Guide  P a g e  | 162 

Image Object Properties 
The properties window is accessed from the Settings submenu under the Object 

menu when you select only one image object. Selecting multiple image objects will 

display a different window. 

An image is a very simple object type. It has a width and height, a rotation angle, 

and always contains an image. There are no border styles or text content. As with 

shape objects, choosing optimal image cache settings in the Performance Settings 

under the Options menu based on your PC’s performance capabilities will ensure 

the best experience when working with these object types. 

Location and Size 

 

Undo/Default 

The bottom left button will undo any changes made (except horizontal or vertical 

positions) and revert back the settings at the time the properties window was first 

displayed if editing an existing object. For new object placement, the button is 

named Default and clicking in it will reset all settings for the object to default 

values. 

Sizes 

This button launches the Object Size Manager from the Utilities menu, allowing 

for custom sizes to be added to the Sizes dropdown list. 

Preview 

This button will preview the current object by itself on the current page with any 

new changes, allowing you to determine if you have to make additional 

adjustments before clicking on the OK button. Refer to the Shape Object Properties 

help topic for details on the preview window. 
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Position 

The position is always based on the top left corner of the image, without 

consideration for the object rotation. 

The values at the bottom of the window indicate the page position after rotation 

and shift amounts (set in this window as positive or negative adjustments) have 

been applied. The page position is also based on the page origin (page, margin or 

border). For example, with a left margin of 25.4 mm and a border of 5 mm, a 

horizontal location of 0 would be 30.4 mm relative to the left edge of the page. 

Image Size 

The size of the image is based on the frame width and height that was created by 

dragging the size with the mouse or by a single click using the previous image 

object size or a predefined object size. 

There are pre-supplied sizes provided by SoftPro selected from the dropdown list. 

To use a value from that list, select it and then apply it with the Set button. To add 

new custom sizes, click on the Sizes button. The Object Size Manager found 

under the Utilities menu is described in detail in a separate help topic. 

Properties 
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Images are not embedded into an album file. The image path and image name 

(without an extension) are stored in the album file. If you have the same image 

name under two or more different types (i.e., a JPG and TIF file with the same 

name) in the same location, AlbumGen has a specific priority by image format: 

• JPEG (Extension must be one of JPG, JPE or JPEG) 

• Portable Network Graphics (Extension must be PNG) 

• Bitmap (Extension must be BMP) 

• Tagged Image Format (Extension must be TIF or TIFF) 

• Graphics Interchange Format (Extension must be GIF) 

Assigning an Image by File 

Click on the Change button to add a new image or change the current one if 

present. This will display the image browser window. Refer to the Shape Object 

Properties help topic for details on this window. 

Assigning an Image from the Clipboard 

If a compatible image is present in the Windows clipboard, you can click on the 

Clipboard button. 

The default location for images taken from the clipboard will be an AlbumGen-

specific folder under your Windows Documents folder. You can change the default 

save location using the Browse, File or Path buttons. 

If possible, the DPI of image will be taken from the image content in the clipboard. 

You can override this DPI value by entering a new one in the provided field and the 

size will change accordingly in the image format line. 

You need to provide a file name (without extension) and a save format (JPEG, TIFF 

or PNG). For JPEG format, select a quality level from the dropdown list. 

The Browse button Properties tab will open the location in File Explorer. 

Unlike shape objects, you may not remove an image link from an image object. 
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Aspect Adjustment 

There are 4 options which control how the image is drawn which in turn affect how 

the object can be resized to maintain an image’s width to height aspect ratio. 

Stretch In stretch mode, the image will fit inside the object frame size. 

This choice will distort the image from its defined aspect ratio. 

Keep Width These two modes are essentially the same in that the shape of 

the image is modified to preserve the aspect ratio of the image. 
By keeping the width, the height is the value that will 

automatically be adjusted. Keeping the height will allow the 
width will to be automatically adjusted. 
 

Note that drag sizing with the mouse in the workspace will allow 
the width and height to be dragged, but the size will be based on 

the shortest distance of movement with the mouse. 
 
For example, if the width is dragged to the right by 10 mm and 

the height is dragged down by 4 mm, the adjustment to the 
height will be 4 mm, and the width will be adjusted to keep the 

image aspect ratio. 

Keep Height 

Print Size This mode preserves the original image aspect ratio, but the 

image print size determines the maximum size the image will be 
inside the object frame. 
 

For example, consider an image that is 700 x 500 pixels and is 
300 DPI. This equates to an image that is 2.33 inches wide and 

1.67 inches tall. 
 

Unlike images used by shape objects, the image object frame 
size is always adjusted to the print size of the source image. 

 

Rotating the Image 

As long as the stretch aspect option is not chosen, you can rotate the image at any 

angle between -359.99 and 359.99 degrees. 

Note that when resizing a rotated image in the workspace using a mouse drag 

action, the frame size will be enlarged or reduced by an equal amount on the 

opposing edge(s) to ensure the center point of the image remains unchanged. 

  



AlbumGen 3 User Guide  P a g e  | 166 

EzStamp Warning Icon and Missing Size Information 

This checkbox option displays of the warning icon when creating objects using the 

EzStamp import options from the Extras menu. Most pre-supplied stamps provided 

by SoftPro will contain width and height information to generate a properly sized 

object in AlbumGen. In some cases, the source stamp may not have sizing content 

and this forces AlbumGen to use a pre-defined width and height that you can 

adjust. 

 

The missing size warning icon will only appear in the workspace (not on the printed 

page) and be displayed as a small image in the bottom right corner of the object 

frame as shown in the sample above. 

You can turn this warning icon on/off a per-object basis. To turn off the icon for all 

objects, you can either disable the option when importing from EzStamp (see 

below) or use the Search and Replace options from the Utilities menu. 
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Table Object Properties 
The properties window is accessed from the Settings submenu under the Object 

menu when you select only one table object. Selecting multiple table objects is not 

allowed for making property changes. 

Tables are based on a specific frame size which will contain a number of rows and 

columns. These rows and columns make up a number of cells which contain text 

content only. Each cell has the following attributes: 

• Borders on each side. A border can be optional or unique for any of the 4 

sides. 

• Both horizontal and vertical alignment of text. Horizontal alignment allows for 

an option for text in a single cell to span across multiple adjacent columns 

(aka across the cell selection). 

• A fill color for the cell background. 

• Color for the text. 

• Font setting applied to the text. 

• Unique formatting options for individual cells to allow for embedded text 

content to resemble that of a paragraph object. 

 

Inheritance of Attributes 
With default settings for a new table, the cell borders are based on the grid line 

specification for the table. The font, fill color and text color will also generic table 

values. 

Each column and row have unique attributes for every attribute a cell has, 

excluding text content. 

When a cell has no unique attributes specific to that cell, it will inherit the 

containing column or row attributes. If the containing column or row attribute is not 

unique, the cell uses the table attribute. 

Consider the following example: 

The table default is Arial 10 point, which would be applied to every cell. 

Column 2 is set for a small Arial 8-point font size. Any cell under column 2 would 

use this smaller point size unless it has a unique font. 

The cell for column 2, row 3 uses Times 8 point for the font. For this one cell, Times 

would be the font, but for all other rows, Arial 8 point will be used. For cells in all 

other columns, Arial 10 point will be used. 
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Limitation of an AlbumGen Table 
Tables in AlbumGen should not be mistaken for a functional spreadsheet object. 

There is no concept of data types or formulas. All content is plain text and what is 

placed in each cell can’t be manipulated mathematically. Table cells may not 

contain data other than text. 

Without using the special paragraph format option, an individual cell can use only 

one text color, one font, and a single line of text. 

Table Design Presentation 
There are several settings windows for table object design and given the amount of 

customizations allowed, the main AlbumGen window will be hidden when the 

various table properties windows are displayed. Given this presentation style, a 

preview option is also available from the table design windows to provide visual 

feedback of your modifications. 

Location and Size 

 

  



AlbumGen 3 User Guide  P a g e  | 169 

Undo/Default 

The bottom left button will undo any changes made and revert back the settings at 

the time the properties window was first displayed if editing an existing object. For 

new object placement, the button is named Default and clicking in it will reset all 

settings for the object to default values. 

For new table objects, the default settings for rows and columns are both set to 2:  

2 rows by 2 columns for a total of 4 cells, with the row heights and column widths 

being equal. 

Position 

Tables can contain an optional border style. The actual position for a table is the 

upper left corner inside the border (if present). 

The values at the bottom of the window indicate the page position after shift 

amounts (set in this window as positive or negative adjustments) have been 

applied. The page position is also based on the page origin (page, margin or 

border). For example, with a left margin of 25.4 mm and a border of 5 mm, a 

horizontal location of 0 would be 30.4 mm relative to the left edge of the page. 

Table Size 

The size of the table is based on the frame width and height without regard to a 

border style. Tables can have extra padding space between the border style and the 

start of the cell grid. See the 'Extra padding...' option on the Border tab add or 

adjust this value. 

Note that resizing a table in the main workspace using a mouse drag action will 

apply a uniform scaling to the entire table, including its border (if present), without 

changing the aspect ratio of width to height. 

The resize table option in the table properties window allows for non-uniform 

scaling of the table and its content. 
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Resizing a Table 

Click on the Resize Table button to scale the table and optionally the font sizes 

within the cells. 

 

Size Change Method 

Width and Height allows you to scale the width and height independently. 

Choose Width Only or Height Only to scale in one dimension. 

Uniform Percentage will disable the width/height change options, as the 

percentage increase or decrease will determine the new table size. 

Width Change 

New Size will allow a specific width (in the current workspace unit type) to be set. 

Percentage Increase and Decrease will scale the column widths uniformly to set 

a new overall table width. 

Height Change 

New Size will allow a specific height (in the current workspace unit type) to be set. 

Percentage Increase and Decrease will scale the row heights uniformly to set a 

new overall table height. 
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Font Scaling Change 

Do Not Scale will keep all text font sizes intact. When resizing the table with the 

other options, the cell sizes will change but the text sizes will not. Note that 

reducing the table size may cause clipping of the text in one or more cells unless 

you change font sizes through other table property windows. 

Scale Uniformly is enabled only when the Uniform Percentage size change method 

is chosen, and will ensure the fonts are sized to preserve their relationship with the 

cell size change. 

The Scale by Width and Height options are enabled only when the width and 

height size change option is enabled. When checked, the font size is adjusted by 

the width OR height change of the cell size. If a Width Only or Height Only option is 

specified, only the corresponding font scaling option is enabled. 

Width, Height and Font Change Status 

The bottom part of this window contains before and after size information. You will 

see changes here only after you click on the Apply button. This action will 

determine if the size changes are acceptable.  

Size changes will be denied if any font size would be smaller than 2 points or larger 

than 144 points, or if overall table size exceeds the page size or is smaller than ¼ 

inch. 

Once a size change is accepted, the OK and Preview buttons will be enabled to 

allow the changes to be applied to the table. 

Click on Reset to clear the window of all sizing selections and values and set the 

scaling options to default values. 
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Properties 

 

Table Size 

The size of the table is based on each column’s width and each row’s height. For 

new table objects, the size is created from the drag rectangle on the main 

workspace with a preset configuration of two rows and two columns. You will then 

set the rows and columns in this window. The size of the table will change if you 

make column width and/or row height adjustments. 

For an existing table already present on an album page, setting the Rows or 

Columns to a different value from the current row/column count will enable the 

Apply button. When clicked this button will add or remove columns/rows to match 

the 2 text field values. When rows are added, they inherit their properties from the 

bottommost row. For new columns, their properties come from the rightmost 

column. You may not add rows or columns which would result in a table size 

exceeding 150% of the page size. 

The Delete button can be used to remove one or more rows or columns from the 

table using a selection grid window. 
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To delete rows or columns, you need to first set the selection in the grid and then 

click the Row+ or Column+ buttons. The cells affected by the deletion would be 

shown with a “Delete” caption. To undo any marked rows/columns, use the Row- 

and Column- buttons. Click Delete to remove the rows and/or columns from the 

table. 

Cell Text Indent 

Within the individual cells, there can be a white space border above, below and to 

the sides or any entered text. The default indent/border is 1/16 inch or 1.59 mm. 

Default Grid Lines 

Grid lines are set using the 3 checkbox options. If you uncheck an option, there will 

be no default lines drawn for that option. Note that individual row, column and cell 

attributes can enable grid lines discretely. 

If grid lines are enabled, then the settings for each type are modified in the 3 

tabbed areas at the bottom. 

A grid line has a weight from 1 to 8 (each weight unit is 1/300 inch), a color and 

can be dashed or solid, using a single line or double line format. 

A dashed line is based on pairs of dash and space segments. There can be from 1 

to 3 pairs. 

By default, dashed line sizes scale to the weight of the grid line and the dash-space 

segment sizes are relative to the line thickness. The dashes and spaces will look the 

same regardless of the grid weight. 
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By checking the option to not scale the dashes and spaces, the segment sizes are 

always treated as 1/300 inch units. 

Double lines are 3 times the thickness as single lines, as the intervening white 

space is the same weight as a single line format. 

Default Fill Color 

If this option is enabled, a color can be used to fill all the cells, assuming that there 

are no column, row, or individual cell fill color overrides applied in other settings 

windows. 

Default Table Text 

These options set the font, size, and text color for all cells. As with other default 

settings, any individual settings at the column, row or cell levels will override the 

table default values. 

Styles 

Every grid line style variation is stored with the table settings in the album page. 

You can build custom grid line styles for reuse via the Styles button. 
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Precedence on Color, Font, and Grid Lines 
There is a priority on how colors, fonts, grid line borders are applied to the 

individual cells in a table. A default table has no customizations at the row, column 

or cell level, so the settings in the properties tab for the table will always be used. 

• If attributes are set at the cell level, they have highest priority. 

• Column level attributes have the next highest priority. 

• Row level attributes have the next highest priority. 

• Table level attributes have the lowest priority. 

Consider this sample table: 

 

The blue fill is set for column 2, it will have priority over the yellow fill of row 3. 

However, the middle cell has it’s own fill color, so it has the highest priority. 

The same scenario applies for the grid lines styles, font, text color, and text 

alignment, which are all unique to the middle cell. 

If the middle cell has no custom attributes, then it would have the following 

attributes: 

• The default font of column 2. 

• Center alignment from column 2. 

• Blue full from column 2. 

• Violet left and right grid lines from column 2. 

• If column 2 was set to default values, then the middle cell would inherit the 

settings from row 3. 

• If row 3 and column 2 were set to default values, the middle cell would 

inherit the settings from the general table properties. 
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Table Border Styles 
The grid lines which surround cells are defined by a border style. Custom border 

styles can be defined which will are available from a styles definition window and 

accessed from all of the table configuration windows which allow borders to be set 

at the table, column, row and cell levels. From the main properties window, click on 

the Styles button to choose a border style from the current ones assigned to the 

table or from a custom style definition. 

 

Custom border styles are available in the top dropdown list. Any existing border 

styles defined in the selected table are shown in the Current Table dropdown list. 

To create a custom style, change the attributes as needed in this window, then click 

the New button. 

Click on Delete to remove the selected Custom Border Style. 

Click on Rename to change the name of the selected Custom Border Style. 

The Export and Import options are useful for sharing custom styles. 

The dash line setup for table border styles is identical to that used for plain line 

objects. 

Applying Style Changes to Multiple Edges 

This group of icon buttons only appear for column, row and cell property windows. 

For the main table properties, this area will be blank. When selecting rows and 

columns in the table designer window, these icons will appear to indicate the 

available border sides which can receive the style setting. A green checkmark 

appears below any edge which will receive the new border style. 
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Borders, Name, Comments and Bookmark 
The Borders and Comments tab in the properties window are the same as for the 

Paragraph object. 

Table Designer 
The table designer is used to customize the format of rows, columns and cells for a 

table object, and enter any text values to individual cells. The designer is accessed 

from the Designer button in the table object properties window. 

 

The top area is a preview of the current selected cell’s attributes. If more than one 

cell is selected in the data grid, then only the attributes common to the selection 

are shown. When an attribute is different between selected cells, an icon will appear 

above the grid: 

 

Hover over the icon with the mouse to see which attribute is not shared in the 

status bar at the bottom of the designer window. 

Text Data Grid 
The data grid for entering text shows the current column and row setup for the 

table. This is not a 100% accurate preview of the table. Only the following 

attributes will be represented in the data grid: 
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• Background color 

• Text color 

• Border style, but in a single pixel width only 

• Text alignment 

Entering text is relatively simple. Highlight a cell and start typing, or press F2 to 

edit the cell contents. Press Esc to cancel the edit. You can also perform two slow 

left clicks on a cell (not a double click) to edit the cell. 

Table cells can only contain one line of text. If you need complex content inside a 

cell with multiple fonts, colors and lines of text, you will need to create a composite 

of a blank table and place paragraph or text objects on top of cells followed by 

grouping the objects together. 

Grid Size and Format 
Choose the Cell Edit Size option from the Help menu to customize the display 

format of the data grid. 

 

You can set the cell width (in terms of average character size), row height (in font 

point size) and the font style with a point size range from 8 to 16. 

 

 

Column, Row and Cell Content 
The options in the designer window are tied to the current cell selection. 

Column adjustments only require selecting one row for the columns to adjust. 

Row adjustments only require selecting one column in the rows to adjust. 
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Cell adjustments require at least one cell to be selected. The cells do not have to be 

adjacent to make adjustments. Use combinations of Ctrl, Shift and the left mouse 

button to make compound selections. 

Selected rows and columns will be shown the top and left side caption area as C# 

and R# values with a different background color. 

 

Designer Actions 
The following table summarizes available actions for the table designer. Options 

only available from the menu will not have a button icon association. 

Button Action Shortcut Description 

 

Preview Ctrl + P Page preview of the table with changes applied. 

 

Import  Import cell text content from a file. 

 

Paste Ctrl + Shift + V Paste cell text content from the Windows clipboard. 

 

Row 
Heights 

Ctrl + Shift + H Adjust selected row heights. 

 

Column 
Widths 

Ctrl + Shift + H Adjust selected column widths. 

 

Row 
Format 

Ctrl + Shift + R Modify selected row attributes. 

 

Column 

Format 

Ctrl + Shift + C Modify selected column attributes. 

 

Cell 
Format 

F4 Modify selected cell attributes. 

 

Special Text 
Formatting 

F5 Allows you to define content for a cell using multiple 
fonts, colors and lines of text similar to a paragraph 
object. 

 

Reset Selected 

Rows 

Ctrl + F2 Reset one or more cell attributes for the selected 

rows. 

 

Reset Selected 

Columns 

Ctrl + F3 Reset one or more cell attributes for the selected 

columns. 

 

Reset Selected 
Cells 

Ctrl + F4 Reset one or more cell attributes for the selected 
cells. 

 

Clear Text Ctrl + Del Clears the text content for selected cells. 

 

Undo Ctrl + Z Undo the most recent row, column or cell format 
changes. 

 

Apply Ctrl + S Apply all design changes to the table. 
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Button Action Shortcut Description 

 

Close Ctrl + W Close the designer and discard any changes. 

 

Help F1 Show the designer help topic. 

 Undo All Ctrl + Shift + Z Undo all row, column and cell formatting changes 
since the designer window was first displayed. 

 Reset All Rows  Reset one or more cell attributes for all rows. 

 Reset All 
Columns 

 Reset one or more cell attributes for all columns. 

 Reset All Cells  Reset one or more cell attributes for all cells. 

 Cell Edit Size  Edit the visual format for the text data grid. 

 Edit Shortcuts  Modify the keyboard shortcuts for the designer 
window. 

 

Resetting Cell Attributes 
A given column or row can have unique attribute settings which supersede the 

generic default values for the table. 

A given cell can have unique attributes settings which supersede both unique 

row/column attributes and generic default values for the table. 

When you reset attributes for rows and columns, you are only affecting the values 

applicable to each row/column and not any unique cell attributes. 

When you reset attributes for cells, you will not affect any unique row/column 

attributes which the cell is part of. 

The reset windows contain a simple set of checkbox options to reset specific 

attributes. 
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Row Heights 
This window provides various methods to set the heights for selected rows in the 

designer data grid. 

 

The left side is a list of the rows in the table. The selected rows from the designer 

grid will be pre-selected in the list (in the example screen capture, row 2 (R2) was 

selected in the designer window). 

The vertical bar with gray shading indicates the relative size of rows to each other. 

Dark grey is for selected rows, light grey for even rows and white for odd rows. 

The right size shows the adjustment choices, a unit size preference, and the 

current/revised table height. 

Height Adjustments 

The height adjustment choices are made by selecting one or more rows to apply 

the adjustment type to. If no rows are selected, the adjustment options are greyed 

out. In some cases, the adjustment type will affect all rows in the table. In other 

cases, setting a specific adjustment type on selected rows will cancel an adjustment 

type on other rows. 
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For example, setting largest font size on row 2 would auto cancel the variable 

height setting for all other rows and revert them back to a specific height. This 

would be due to the variable height setting being applicable to all rows. 

If you want to cancel any current adjustments and reset the row and table height, 

click on the Reset button. 

The icon next to each row in the list indicates the type of adjustment being applied 

to that row. 

Icon Adjustment 

 
Specific height 

 
Variable height 

 
Ratio to other rows 

 
Largest font size in the row 

 
Set height by the point size of fonts 

 

Specific For each selected row, enter a new size value in inches or 
millimeters. The overall height of the table may not exceed the 

height of the page and is shown under the Revised Table Height 
value. 

 
You can set one size for specific rows by selecting them. This will be 
reflected in the New Height column in the row list. 

 
You may also set an overall table height in the New Table Height 

field. This will effectively change each row’s height to an equal 
amount of New Height / Number of Rows. 

Variable Each row size is based on the table height and will be of equal 
value. You can change the current table height by entering a new 
value in the New Table Height field. 

Ratio Each row must have a percentage allocation for the height such that 
the sum of all row percentage values equals 100. 

 

  
Font Each column for a given row may use its own font size. This 

adjustment type ensures that the row height will fit the largest 
point size of the fonts used in the row, including any adjustment for 

the vertical cell indent setting from the table properties window. 

Points The row height is based on a point scale for the fonts, where 1 point 

equals 1/72 inch. The adjusted height will include the vertical cell 
indent. For example, a 12 point adjustment with a 1/16 inch vertical 
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cell indent will have a new row height of 12/72 + 1/16 * 2 or .2197 

inches (~7.4 mm). 

 

Column Widths 
This window provides various methods to set the widths for selected columns in the 

designer data grid. 

 

The left side is a list of the columns in the table. The selected columns from the 

designer grid will be pre-selected in the list (in the example screen capture, column 

3 (C3) was selected in the designer window). 

Horizontal bar below the list indicates the relative size of columns to each other. 

Dark grey is for selected columns, light grey for even columns and white for odd 

columns. 

The right size shows the adjustment choices, a unit size preference, and the 

current/revised table width. 

Width Adjustments 

The width adjustment choices are made by selecting one or more columns to apply 

the adjustment type to. If no columns are selected, the adjustment options are 

greyed out. 
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If you want to cancel any current adjustments and reset the column and table 

width, click on the Reset button. 

The icon next to each column in the list indicates the type of adjustment being 

applied to that row. 

Icon Adjustment 

 
Specific width 

 
Variable width 

 
Ratio to other columns 

 
Auto fit the contents of the column 

 
Set the width using a pattern string 

 

Specific For each selected column, enter a new size value in inches or 
millimeters. The overall width of the table may not exceed the width 
of the page and is shown under the Revised Table Width value. 

 
You can set one size for specific rows by selecting them. This will be 

reflected in the New Width column in the column list. 
 
You may also set an overall table width in the New Table Width 

field. This will effectively change each column’s height to an equal 
amount of New Width / Number of Columns. 

Variable Each column size is based on the table width and will be of equal 
value. You can change the current table width by entering a new 

value in the New Table Width field. 

Ratio Each column must have a percentage allocation for the width such 

that the sum of all column percentage values equals 100. 

Autofit For each text value for all rows in the selected columns, a 

measurement of the length of the text will be made. The longest 
measured width of all row text values is used to set the column 
width, plus the additional cell indent value from the table properties 

window. Since it’s possible that no rows for a column contain text, 
there is a minimum column width value which must be specified. 

Pattern The pattern you enter can be any combination of characters. This 
pattern is then measured using the same method as  the autofit 

option – in this case, all rows for the column are assumed to 
contain the same text value equal to the pattern. 

 

Row Attributes 
This window provides options to change the formatting for selected rows from the 

designer data grid. 
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All settings are controlled through mouse clicks on any of the window elements: 

• Icon Buttons 

• Sample Grid Lines 

• Color Swatches 

• Font Description 

• Cell Preview Area 

Icon Action Description 

 

Undo Undo any change to the associated option. 

 

No Attribute Clear the attribute value. 

 

Default Row Border Remove any custom style and use the default 
border style for the table. 

 

Default Row/Column Remove the custom color attribute and use the 
default column/table color setting. 

 

Set Option Change the associated attribute for the row. 

 

 

Vertical Alignment Change the text cell alignment vertically to 

top, centered or bottom. 
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Icon Action Description 

 
 

Border Styles 

A table row has 3 border sides running horizontally. The shared border style only 

applies when 2 adjacent rows are selected in the designer data grid. For example if 

rows 2 and 3 are selected, then the shared border represents the bottom border of 

row 2 and the top border of row 3. Changing the shared border style would affect 

one border side of both selected rows. 

The current border style is shown in the sample swatch on the left with the button 

groups and also in the cell preview area on the right. 

The lack of a border style will show no content in either area. 

You can remove border sides by clicking the no attribute buttons or by clicking near 

the border edges/middle of the preview sample area. Clicking in the preview area 

where no border side exists performs the same action as clicking one of the Set 

Option buttons – a style selection window will provide a choice of border styles to 

use. 

The preview area will indicate if any row border uses 2 or more different styles 

using a grey hatch pattern as shown below. 

 

Default Row Settings 

Border styles, colors and fonts are by default not set for a row in the table. The row 

will inherit any custom settings from the table columns. If no unique settings are 

assigned to a column, then the row inherits the settings from the table defined in 

the table properties window. The default row/column buttons will remove any 

custom setting. 

Click on the Default button to remove all customizations for the selected rows. 

 

Column Attributes 
This window provides options to change the formatting for selected columns from 

the designer data grid. 
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All settings are controlled through mouse clicks on any of the window elements: 

• Icon Buttons 

• Sample Grid Lines 

• Color Swatches 

• Font Description 

• Cell Preview Area 

Icon Action Description 

 

Undo Undo any change to the associated option. 

 

No Attribute Clear the attribute value. 

 

Default Column 

Border 

Remove any custom style and use the default 

border style for the table. 

 

Default Row/Column Remove the custom color attribute and use the 

default column/row color setting. 

 

Set Option Change the associated attribute for the 

column. 

 

 

Horizontal Alignment Change the horizontal alignment of the text 

within the cell to left, centered or right. 
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Icon Action Description 

 
 

Border Styles 

A table column has 3 border sides running vertically. The shared border style only 

applies when 2 adjacent columns are selected in the designer data grid. Changing 

the shared border style would affect one border side of both selected columns. 

The current border style is shown in the sample swatch below the button groups 

and the cell preview area at the bottom. 

The lack of a border style will show no content in either area. 

You can remove border sides by clicking the no attribute buttons or by clicking near 

the border edges/middle of the preview sample area. Clicking in the preview area 

where no border side exists performs the same action as clicking one of the Set 

Option buttons – a style selection window will provide a choice of border styles to 

use. 

Default Column Settings 

Border styles, colors and fonts are by default not set for a column in the table. The 

column will inherit any custom settings from the table rows. If no unique settings 

are assigned to a row, then the column inherits the settings from the table defined 

in the table properties window. The default row/column buttons will remove any 

custom setting. 

Click on the Default button to remove all customizations for the selected rows. 
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Cell Attributes 
This window provides options to change the formatting for selected cells from the 

designer data grid. 

 

Cells contain 4 border sides, which may be shared with adjacent columns or rows. 

Changing shared border styles will affect the adjacent cell border styles. 

All settings are controlled through mouse clicks on any of the window elements: 

• Icon Buttons 

• Sample Grid Lines 

• Color Swatches 

• Font Description 

• Cell Preview Area 

• Border Presets 

Icon Action Description 

 

Undo Undo any change to the associated option. 

 

No Attribute Clear the attribute value. 
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Icon Action Description 

 

Default Column/Row 
Priority 

Remove any custom style and use the default 
border style for the table. For parent priority, 

determines if the row or column has priority. 

 

Default Row/Column Remove the custom color attribute and use the 

default column/row/table color setting. 

 

Set Option Change the associated attribute for the 

column. 

 

 

 

Horizontal Alignment Change the text cell alignment horizontally to 
left, centered or right. 

 

 

 

Vertical Alignment Change the text cell alignment vertically to 
top, centered or bottom. 

 

Border Styles 

A table cell has 4 border sides, 2 horizontal and 2 vertical. The shared border style 

only applies when 2 adjacent cells are selected in the designer data grid. Changing 

the shared border style would affect one border side of both selected cells. 

The current border style is shown in the sample swatch to the right the button 

groups and the cell preview area at the bottom. 

The lack of a border style will show no content in either area. 

You can remove border sides by clicking the no attribute buttons or by clicking near 

the border edges/middle of the preview sample area. Clicking in the preview area 

where no border side exists will perform the same action as clicking one of the Set 

Option buttons – a style selection window will provide a choice of border styles to 

use. 

Default Column Settings 

Border styles, colors and fonts are by default not set for a cell in the table. The cell 

inherits any custom settings from the column in which the cell is located. If no 

unique settings are assigned to the column, the cell inherits any custom settings 

from the row in which the cell is located. If neither the cell’s row or column have 

unique settings, then the cell inherits the settings from the table defined in the 

table properties window. The default row/column buttons will remove any custom 

setting. 

Click on the Default button to remove all customizations for the selected rows. 

  



AlbumGen 3 User Guide  P a g e  | 191 

Border Presets 

There are 4 types selected using one of the preset buttons and the current border 

styles set for Outline, Rows and Columns. 

First, set the border style for one of the 3 preset border types. Then click the preset 

button to apply it to the cells border sides, including any shared borders. 

 

Will apply the outline border preset to all perimeters of the cell selection 
in the designer grid. Any shared border sides will be cleared. 

 

Will remove all border sides for selected cells and any shared border 
sides for adjacent cells. 

 

Will apply the outline, row and column border styles to all border sides 
for the selected cells and shared border sides for adjacent cells. 

 

Will remove the borders for the cells with border sides that outline the 

cell selection group, and apply the row and column styles to only shared 
border sides with adjacent cells. 

 

Unique Attribute Indicators 

When 2 or more cells are selected, any attribute which is not common to every 

selected cell will be identified by status icons at the bottom of the window. You can 

hover the mouse over these icons to see what attribute value isn’t shared by all the 

selected cells. 

 

Default Settings 

Click on the Default button to undo all changes made in this window. 

Preview 

Click on the Preview button to show a page preview of the table with pending 

changes applied. Click on OK to apply the changes and close the window. 

Column vs Row Priority 

When a cell has no unique value assigned for an attribute, the attribute will be 

inherited from either the column or the row the cell belongs to. If both the column 

and row have no unique value assigned for the same attribute, the cell will inherit 

the default table attribute. The priority is set by default to take column over row, 

but can be changed with the setting below. 
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Column Priority 

 

Row Priority 

 

 

Paragraph Format Style 
A checkbox option is provided in the cell attribute window to format a cell using the 

same text content option as that for the paragraph object. 
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When you check this option, an additional button will appear at the bottom with the 

name Text. Click on this button to define the text content using a window similar to 

the one used for the paragraph object. 

Formatting Restrictions 

The selection of cells from the main table designer window must be continuous in 

both the row and column directions. The first example is allowed. The second 

example is not. When the feature is not allowed, the checkbox and Text button will 

not be shown. 

 

 

You may not select 2 or more cells which are both defined for paragraph style text 

formatting. 

If a selected cells is currently set with paragraph style text formatting, it must 

always be the top left cell of the selection. 
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Formatting Cell Text as Paragraphs 

 

Rotation 

Text can be rotated at 90 degree angles within the cell frame. 

Word Wrap 

By default Word Wrap is disabled, which means words will not be broken at the end 

of each line unless a line break (pressing ENTER) or a hyphen is encountered in a 

word. The text will automatically wrap to a new line when a spaces or hyphens are 

encountered. If you enter too much text for a cell’s dimension it will automatically 

be clipped on the right and/or bottom of the cell frame. The available text area is 

reduced by the cell text indent values. 

Column and Row Merging 

If you want to extend the text content to render into cells to the right or below, set 

the Row and Column values to the “area” where the text content will be displayed. 

The Set button is used to force the row and column values to the current selection 

area of the main table designer window. When setting text content for the first time 

for a cell, the row and column values will be preset from the cell selection. 

Thereafter, the column and row values will remain static. You will need to use the 

Set button or enter values manually into the fields provided. 

Spacing Adjustment 

This value is a percentage increase or decrease of the space between each line of 

text. If the object only contains 1 line of text, this adjustment has no effect. 
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Character Width Adjustment 

This setting creates expanded or compressed versions of the font characters. 

Text Content Edit Window 

The text edit toolbar and edit window are the same as that used for the Text object.  

If word wrap is enabled, then it will also be enabled in the edit window and no 

horizontal scroll bar will appear. 

Alignment of Text 

The horizontal and vertical alignment are take from the cell alignment settings for 

the cell edit window, and will use the column/row alignments if there is no unique 

cell alignment. 

If the cell was previous set to use the horizontal alignment across a selection of 

cells, it will be replaced with center alignment automatically. 

Attribute Reset for a Selected Cell Group 

AlbumGen imposes no restrictions on formatting cells which are part of the cell 

group after you have applied paragraph style formatting to a cell. However, certain 

settings will be automatically adjusted once you click the OK button when multiple 

rows and/or columns are set for a cell group. 

If the text in the sample screen were used on a group of 2 rows by2 columns it 

would appear on the page like this: 

 

Notice that the font size is slightly too large and will clip the bottom edge of the 

cell. There is no provision to autofit cell text. You must decide on the appropriate 

font size to use for proper fitment. 

Also notice that the connecting borders and any cell text content in the cells to the 

right and below the top left cell are cleared. The font, alignment and color choices 

for those affected cells are left unchanged. 
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Special Formatting Visibility in the Design Grid 

Cells containing content with multiple fonts, sizes, colors and lines of text will not 

be displayed in the designers data grid. Instead any cells which are part of the 

selection group will be shown with the generic indicator text of *M*, as shown 

below: 

 

If you attempt to place normal single line text into cells (R2, C2), (R3, C1) or (R3, 

C2), it will be accepted, but not displayed in the designer preview grid as the 

special format indicator text will always take precedence. 

In addition, if you want to reapply the interconnecting borders, you may choose to 

do so. Keep in mind, if you go back into the edit window to change the paragraph 

style text content, the borders and individual cell text content will be removed once 

more when you click the OK button. 
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Cell Text Content 
Each cell can have optional text values. Only a single line of text is permitted unless 

special paragraph style formatting is used. If the text is wider than the available 

cell space it will be cropped on one or both sides depending on the alignment. 

You edit a cell’s value by performing 2 slow clicks on the cell, pressing F2, or simply 

start typing when the cell is highlighted. If the cell contains paragraph style 

formatting, the edit will be blocked until you use the Clear Text or Reset Cell option. 

Paste from Clipboard 

You can paste text from the clipboard using Paste from Clipboard from the 

Options menu or pressing Ctrl + Shift + V. The paste option will check for tab-

delimited format text and use that to split the text into separate columns. Line 

breaks will split the text into separate rows. 

If there are more tab and line breaks in the clipboard content than available 

columns and rows in the table, the remaining data in the clipboard is ignored. 

Applications such as Excel will place a row/column selection on the clipboard into a 

text format suitable for pasting. 

Non-text content may not be pasted into a table and any font, color or size 

information will not be applied. The clipboard content must be plain text. 

Import from File 

You can also import a delimited text file into a table using the Import Text File 

from the Options menu. 

 

As with the clipboard paste option, if the number of rows or columns in the text file 

is greater than the table can accommodate, the extra content in the file will be 

ignored. 
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Clearing Text Content 

Use the Clear Selected or Clear All items from the Cell menu to clear the text 

values in the table. 

Resetting Custom Attributes 
There are Reset Selected and Reset All options under the Row, Column and 

Cell menus for removing all custom settings at the row, column and cell level. 

When resetting at the cell level, any custom column and row custom settings are 

not touched. 

When resetting at the row level, custom cell and column settings will remain. 

When resetting at the column level, custom cell and row settings will remain. 
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Properties for Multiple Object Selections 
If more than one object is selected in the workspace, the settings choices from the 

Objects menu will either present an alternate properties window or some cases 

such as for table objects, not be permitted. 

Objects must also be of the same type to set the properties. If you have a selection 

which consists of different object types, you will need to choose which ones from 

the selected to make property changes. A pick list will be presented in this scenario. 

  

The list presents the selected objects in the order they were placed on the page. If 

you need to view the selected object in the list in a page preview, select it (only a 

single item may be selected at a time), then click on the View button. 

You will only be able to select objects of the same type for property adjustments. 

Property adjustment windows will be a different format and targeted to the changes 

applicable to the object type. The methods for making property changes basically 

remain unchanged – the only significant difference is the provision of checkbox 

options to enable a change on a per attribute basis. 
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For example, the properties adjustment for text content on shapes is shown below: 

 

When checked, the outlined checkboxes enable attribute changes for all selected 

shapes. Unchecked attributes will not be changed. 

Some of the adjustment windows may use dropdown lists for choices for an 

attribute change. The position/size window below is an example of this type of 

adjustment. 

 

Page Preview 
Each dialog window for changing multiple selected object properties will have a 

Preview button. This will show a page preview of only the objects which were 

selected with any adjustments applied. All other page objects will be suppressed. 

Note that if you have set objects as non-printable, they will not appear in the page 

preview. 
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Single Font/Color Changes 
For the Text, Paragraph and Shape object types, the dialog window for multiple 

selected object properties will have a Font button. This allows you to apply the 

same font attributes to all associated text for the selected objects. For Shape types, 

the font/color changes are individually applied for each text area (Above, Below, 

Inside and Over Image). 

If you have AlbumGen version 2 album files which were upgraded, these object 

types only allowed one font and color setting per object in version 2. To allow for 

easier adjustments of font/color settings for multiple selected objects, you can use 

this feature to bypass the normal version 3 text edit window and apply the settings 

to all text content at one time. 

 

Check any option to enable it’s associated settings controls. You can change the 

font name, text color, font size or font attributes individually. 

Once applied to the object, all font and colors used for the associated text data will 

use just one font and one color. If the object text contained multiple fonts, sized 

and colors, they will all be replaced with a single setting. 

The Undo button is enabled when an existing set of changes were applied on a 

previous display of this window. You can click the Undo button to cancel the 

pending changes for the font/color. 
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Object Sets 
This option is available from the side toolbar and the Object menu as 

Shape/Paragraph Set. 

 

An object set is a replication of a single selected shape or paragraph object. 

 

The settings shown in this example replicate the object in the upper left corner as 

shown on the following page image. (no other objects are present in the example, 

but any other existing page content would not be altered). 

Note that the image link option was not checked for this example, so only the 

shapes (with text) are replicated across and down the page. 
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Placement Origin 

The origin only has impact when the Left/Top Aligned or Right/Bottom aligned 

options are chosen. This will determine the starting point for object placement. 

Replication begins at an object's designated origin as specified by the Horizontal 

and Vertical Placement options, relative to the Placement Origin option chosen 

(Borders, Margins or Page Edges). The original source object will be moved to the 

origin point before copies are created. 

Keep Image Link 

For shape objects, check this option to retain the same image link for the duplicates 

objects. 

Replication Direction 

Choose horizontal, vertical or both directions. At least one of the two directions 

must be chosen. 

Ignore Above/Below Text 

For shape objects, you can choose to ignore the height of text above and below the 

object frame to set the vertical spacing between objects. 

Placement Options 

The alignment can be left, centered, or right within the page, margin or border 

areas. The At First Object option will keep the source object location locked in 

place and all replications will proceed to the left and/or down from this position. 

The Offset/Padding option provides is extra space between the page/margin/border 

edges. This padding option ensures that the replicated objects will not touch the 

margin/border areas edges 

Spacing gaps ensure that objects will have sufficient blank space from one another. 

Columns and Rows 

You can choose to set a specific number of rows down and columns across to create 

the duplicate objects. Or you can choose to fit the objects within the available page 

space (after deductions for spacing, margins, borders and padding). 

If you choose a specific number of columns or rows, the duplication will be stopped 

if the available page space is reached – the objects will not run off the right or 

bottom of the page. 

Template Files 

Use the Load and Save options for managing settings as a re-usable template. 
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Attribute Replacement 
The way familiar to most for multiple object attribute replacement is through the 

Search and Replace options under the Utility menu. 

An additional method is available under the Object menu as Replace Attributes 

and also on the side toolbar. 

 

 

When an object is selected and this option applied, it will be marked by a unique 

outline in the workspace, and this marked status remains until you disable it, close 

the album or choose a different replacement source. 
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Once an object is marked, you may proceed to use it as an attribute source on the 

current album page or any other page. 

As long as a replacement source is active, the object settings menu choices are 

replaced with different windows with choices of content to replicate. 

 

 As an example, a shape object has the following attribute window for the 

Properties menu choice (Shift + P): 

 

All of the replication windows are similar in presentation: A set of checkbox options 

for what to copy and two shortcut buttons to turn on or off all of the options at 

once. 
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To turn off the replication object, simply choose the replace option attribute a 

second time and click the Disable button. 
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Search 
Search is found under the Utilities menu. The search feature allows you to locate 

pages and objects on pages using multiple search categories and attributes. 

 

A search type can be by page or by object. When searching by page, only matching 

page numbers are returned. When searching by object, matching pages and the 

matching objects for those pages are returned. The Matches Found total in the 

status bar at the bottom indicate the results of the most recent click on the Find 

button. 

Not every attribute which makes up a page or object in an album can be searched. 

Choices are confined to the more common attributes to avoid complicated search 

inputs. If demand dictates attributes not present in the current list, more may be 

added in a future release. 
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Search Window Areas 

Page and Object Filter 

Objects to Search On allows you to restrict the search to specific objects on the 

pages in the album. For page type searches, the object options are disabled as they 

are not part of the search. 

 

Search Criteria 

The upper right area of the Search window will be populated with the necessary 

inputs based on the category and type of attribute that is being searched. The 

caption in this group area will contain the search level (1-5) and the type of search 

being used. In this example, a text content search for the first level. 

 

Title/Shape Filter 

For page searches, a title area filter will appear below the search criteria. This 

allows you to restrict the text searches to specific title and subtitles in the header 

and footer areas. 
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For objects searches with a shape type in scope for searching, the 4 text areas can 

be filtered to restrict the search to specific areas. 

 

Search Levels 

For users familiar with the EzStamp application, this type of search is similar to a 

Power Search in EzStamp. Up to 5 levels can be combined into a single search and 

a match condition only happens when all conditions are met for each search level. 

 

To set the number of search levels, select one of the 5 radio buttons at the top. 

Choose a category and then an attribute within the selected category. 

Once both are selected, the search criteria will be provided for your input. 

The Show radio button is used to indicate which level is currently being assigned 

for the search criteria area, as not all 5 levels can be shown at the same time. 

When two or more search levels are used, a join condition is shown as two radio 

buttons with the names AND and OR. This specifies the matching scenario between 

the search level where the choice needs to be made and the search level below it. 

The screen example shown above is a 2 level search where both search conditions 

must match on text content. If either search condition is considered a match then 

the OR choice should be made. 

Search Actions 

These action buttons appear at the bottom of the window. 

 

Last Search 

This recalls the settings from the most rcent search. 

Reset 

Resets the search window to default values. 

Save 

Saves the search settings to a template file. 
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Load 

Loads a search template from file. 

Find 

You must click Find to start a search for matching pages/objects. If any matches 

are found, the Show button will be enabled and the total matches found will be 

shown in the status bar. 

Show 

Search results are displayed in a search results window in the main AlbumGen 

window. See the Floating Windows help topic for more details.  

Cancel 

Closes the search window. 

Page Search Attributes 
The following list summarizes the attributes which are available for a page search. 

A page search doesn’t have multiple categories, so will always shown the dropdown 

list as the general “Page” type. 

Attribute Type Description 

Page Border Style Border The page border style based on patterns and 
lines 

Page Border Color Color Border color 

Border Weight (1-6) Number The weight of a border style (1-6) - doesn't apply 
to image borders 

Image Border Style Image 
Border 

The page border style using a defined 
template..." (otherwise, returns all pages without 
an image border if no template is selected) 

Page Margins Margins The page margins 

Page Borders Inside the Margins Borders The page borders 

Title and Subtitle Fonts Font The font used in titles and subtitles 

Title and Subtitle Text Content Text The text content used in titles and subtitles 

Text Color for Titles and Subtitles Color The text color used in titles and subtitles 

Page Orientation Orientation Page orientation 

Paper Width Unit The paper width, regardless of page orientation 

Paper Height Unit The paper height, regardless of page orientation 

Header Size Unit Title header size 

Footer Size Unit Title footer size 

Page Name Text An optional name for the page to apply to titles 
and table of contents 

Page Bookmark Text An optional bookmark for the page 

Page Comments Text Optional page notes 

Vertical Shift for Titles Unit A vertical shift of the page header or footer 
content 

Spacing Adjustment for Titles Unit A spacing adjustment to apply between title and 
subtitle lines 

Font Compression or Expansion Number The font expansion or compression factor for text 
content (-50 to 50%) 

Internal Page ID Number Number Internal Page ID Number 
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Object Search Attributes 
The following list summarizes the attributes which are available for an object 

search. Object searches are based on one of 5 categories: 

Text Font, color, size and alignment options related to objects which 

contain text elements. 

Border Style attributes related to object borders, including styles for the Line 

object type. 

Image For Image and Shape objects, these attributes are related to the 

image link assigned to the object. 

Size Size attributes where the values are represented in the Inch or 

Millimeter units. 

General This category includes any remaining object attribute which doesn’t 

clearly fit into the previous four. 

 

Category Attribute Type Description 

Text Text Content Search Value Text Text data used by the object 

Text Text Color Color Text color(s) used by the object 

Text Horizontal Text Alignment Alignment The horizontal alignment for text content 

Text Vertical Text Alignment Alignment The vertical alignment for text content 

Text Font Attributes Font Font(s) used by the object 

Text Extra Spacing Between 
Text Lines 

Number The line spacing adjustment for text 
content (-50 to 100%) 

Text Font Compression or 
Expansion 

Number The font expansion or compression factor 
for text content (-50 to 50%) 

        

Border Object Border Style Border The style for line objects 

Border Object Line Style Border The border style for the object (not 
including Lines) 

Border Border/Line Style Color Color Border/line style color 

Border Border Weight (1-4) Number The weight factor of a border/line style 

Border Shape Bracket Status Yes/No Indicates the shape is using a bracket style 

instead of a border 

Border Border Corner Join Line Join How the vertices of borders are joined 
together 

Border Dashed Line End Cap End Cap The end cap format for dashes in dashed 
lines with border/line styles 

Border Line End Cap End Cap The format of the line end caps 

Border Miter Limit (0 - 100) Number The tolerance for a miter join applied to the 
vertices of borders (0-100) 

        

Image Image Location Text The path where an image is located 

Image Image File Name (no 
extension) 

Text The name of the image linked to the object 

Image Image Aspect Ratio 
Adjustment 

Aspect How the image is placed in the object 
based on aspect ratio 

Image Rotate the Image with the 
Shape 

Yes/No Indicates that the image is rotated with the 
shape 

        

Size Extra Spacing Above the 
Shape Frame 

Unit Extra spacing between the top of the 
border frame and the Above text data 
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Category Attribute Type Description 

Size Extra Spacing Below the 
Shape Frame 

Unit Extra spacing between the bottom of the 
border frame and the Below text data 

Size Extra Padding Inside the 
Border 

Unit An extra amount of interior frame padding 
where no image/text data will exist 

Size Extra Padding Inside the 
Frame 

Unit An extra amount of padding added before 
the shape border begins 

Size Object Height (not 
counting border) 

Unit The height of an object, not counting the 
border or bracket style 

Size Extra Spacing Between 
Image and Text 

Unit Extra spacing between the image and the 
text Inside the frame 

Size Line Length Unit The length of the line 

Size Paragraph Left/Right 
Indent 

Unit The left/right margin space between the 
paragraph text and the border 

Size Paragraph Top/Bottom 
Indent 

Unit The top/bottom margin space between the 
paragraph text and the border 

Size Text Height Padding 
Adjustment 

Unit The height padding adjustment for inside 
frame or over image text 

Size Inside Frame Text 
Horizontal Shift 

Unit The horizontal shift of inside frame or over 
image text 

Size Inside Frame Text Vertical 
Shift 

Unit The vertical shift of inside frame or over 
image text 

Size Object Width (not 
counting border) 

Unit The width of an object, not counting the 
border or bracket style 

        

General Object Bookmark Text Optional bookmark name for an object 

General Object Comments Text Optional notes for an object 

General EzStamp Import Indicator Yes/No Indicates that the size/image/text content 
originated from an EzStamp import 

General EzStamp No Sizing 
Indicator Visibility 

Yes/No Indicates no sizing information was 
provided from an EzStamp import 

General Object Fill Color Color The object fill color 

General Fill Paragraph Margin 
Space 

Yes/No Indicates that the paragraph fill color is 
also applied to the margin area 

General Color Fill Width of the 
Frame 

Yes/No Indicates that the fill color for inside frame 
or over image text fills the frame 

General Object Group Status Yes/No Indicates the object is grouped with one or 
more other objects 

General Inside Frame Text 
Background Color 

Color The fill color applied to the background of 
inside frame or over image text 

General Horizontal Line Direction 
(No = Vertical) 

Yes/No Indicates the direction of the line is 
horizontal (No = vertical) 

General Alternate Starting Edge 
for Line Render 

Yes/No Indicates the line is rendered from the 
opposite edge of its frame 

General Object Movement Lock 
Status 

Yes/No Indicates the object is locked from being 
moved 

General Object Name Text A name identity to attach to an object 

General Object Rotation Angle Rotation Object rotation angle 

General Object Selection Lock 
Status 

Yes/No Indicates the object is locked from being 
selected 

General Table of Contents Display 
Status 

Yes/No Indicates that the name identity will appear 
in a table of contents 

General Rotation of text content Rotation Text rotation angle 

General Paragraph Text Word 
Wrap 

Yes/No Indicates that word wrap is applied to the 
text content for a paragraph 
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Attribute Filters 
The available attributes for a given object filter will automatically be filtered to 

remove ones which are not in scope for the object types. For example, a search 

against only the Text object type would remove all filters related to Image and 

Border categories. 

Search Results 
Search results are displayed in a special window in the main AlbumGen workspace. 

 

Details on this search window can be found in the Floating Windows help topic.  

Search and Replace 

In AlbumGen, the replace option is separated from the search option and use a 

separate window to perform replacements. However, replacements can link to any 

matched objects from the search windows, yet have the ability to replace attributes 

which were not part of the original search. 

 

 

 

 

 

 

 

Replace 
This can be found as the Replace item under the Utilities menu. Replacements 

can be applied to album pages and objects on the pages. 
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Choose replacement by object or page. 

Scope 
The scope is based on the type of search. 

Search Matches Replacements will be applied to all matching pages or objects 
from the most recent search results as they appear in the 
Search Results window. 

Current Page Replacement is confined to the current page. For object type 
replacements, the replacement affects only the selected 

objects. 

All Pages All pages in the album will be subject to replacements by 

page attribute. If you need to replace by a specific set of 
pages, use the Search utility coupled with the Search 

Matches option. 

Marked Objects The replacement will be against all bookmarked objects 
across all pages in the album. 
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Category 
The category choices are the same for both page and object replacement. The 

default None value is not a valid selection. 

Text Attributes are based on objects with text content or page 

titles and subtitles. 
 

This can include the text data, alignment, spacing, size and 
font choices. 

Color Color choices for attributes such as text, border, line or fill 
color. 

Measurement A measurement is a position or size value where a unit value 
in inches or millimeters is expected. 

Attribute This is any attribute that doesn’t fit within the first 3 
categories. Common types are a Yes/No condition, a choice 
from a set of options, pick list value, text value, or numeric 

value. 

 

Once a category is selected, the available attributes for replacement are shown in 

the list on the left, with the valid inputs as a set of various element types in a group 

on the right. The example below is a search and replace for a font under the Text 

category. 

 

Enabling Attributes 

Some of the attribute types will require a choice to enable the value to be replaced, 

such as a checkbox to replace the font name. Until you enable a replacement 

checkbox option, the associated attribute may not be replaced or may not appear 

at all. 

Search and Replace 

Some of the attribute types will allow for a matching search condition. Generally a 

replacement based on the preceding Search with the Search Matches scope will 

take care of any need to perform a direct search within the replacement window. 

However, you still have the option to add a search where applicable instead of an 

outright replacement. Where possible, results from a text search will retain history 

in the dropdown list. 
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Attributes 
The attribute list for a replacement is summarized by page and object type below. 

Page Replacement Attributes 

Category Type Attribute Description 

Attribute Orientation Page Orientation Page orientation (paper size remains 

unchanged) 

Attribute Border Pattern Border Style Page borders which are based on geometric 
patterns and lines 

Attribute Integer Border Weight A weight factor from 1 to 6 for pattern 

border styles  

Attribute Border Image Border Style Page borders which use image content as a 
source 

Attribute Text Page Name Naming an album page allows it to be used 
in building an album table of contents 

Attribute Text Page Bookmark A bookmark which can be used in searches 
to locate a page in the album 

Attribute Text Page Comments Comments which can be used as reference 
information for this page 

Color Color Text Color The color for title or subtitle text 

Color Color Border Color For pattern border styles which are not 
defined with custom color settings 

Measurement Units Paper Width Physical paper width regardless of 

orientation 

Measurement Units Paper Height Physical paper height regardless of 
orientation 

Measurement Units Page Margins Page margins are extra padding inside the 
physical page 

Measurement Units Page Borders Page borders are extra padding inside the 
margins 

Measurement Units Header Area Title and subtitle text area at the top of the 
page 

Measurement Units Footer Area Title and subtitle text area at the bottom of 
the page 

Text Text Title/Subtitle Text Text content for title and subtitle areas, 
including macro keywords 

Text Font Title/Subtitle Font The font to use for title or subtitle text 

Text Number Expansion/Compression Text expansion/compression factor (-50 to 
+50 percent) 

Text Units Header/Footer Offset Vertical shift of the title and subtitle text 

Text Units Header/Footer Spacing Spacing between the title and sub title text 
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Object Replacement Attributes 

Category Type Attribute Description 

Attribute Border Border Style The border style for applicable object types 

Attribute Line Style Line Style The line style for line object types 

Attribute Number Border/Line Weight Border style weight (a value from 1 to 4, in 
1/300 of an inch) 

Attribute Text Image Path The location where the image can be found 

Attribute Text Image Link The name of the image (without any file 

extension) 

Attribute Number Object Rotation Object rotation (-359 to +359 degrees) 

Attribute Number Text Rotation How text is rotated relative to the album page 

Attribute Yes/No Image-Shape Rotation Rotate the image with the shape object rotation 

Attribute Aspect Image Aspect Ratio 

Type 

How to set the size/aspect ratio of images 

Attribute Yes/No Fill Paragraph Margins Will fill in the interior paragraph margin space 

with the fill color if used 

Attribute Yes/No Text Word Wrap Text will automatically wrap to the next line in 

the absence of line breaks 

Attribute Yes/No Extend Inside Fill Extend the background color fill for the text 
inside the shape frame to it's width 

Attribute Yes/No Extend Over Image Fill Extend the background color fill for the text on 
top of the shape image to it's width 

Attribute End Cap Dashed Line End Cap For dashed lines, how the end of each dash is 
drawn 

Attribute End Cap Line End Cap For line objects, the type of end cap to be used 

Attribute Join Line Corner Join Type How lines are joined at their vertices for border 

styles 

Attribute Number Corner Join Miter Limit The miter limit applied when joining vertices for 
border styles (0 to 100, default is 10) 

Attribute Text Object Name Naming an object allows it to be used in 

building an album table of contents 

Attribute Text Object Bookmark A bookmark which can be used in searches to 
locate an object in the album 

Attribute Text Object Comments Comments which can be used as reference 
information for this object 

Attribute Yes/No Show Object in TOC Indicates that this object will be included in an 
album table of contents if named 

Attribute Yes/No Show EzStamp No 
Sizing 

Indicates that this object was imported from 
EzStamp without stamp sizing data 

Color Color Text Color The color for the object text or one of its text 
areas 

Color Color Border Color Border color 

Color Color Line Color Line color 

Color Color Interior Fill Color Interior fill color 

Color Color Inside Fill Color Background fill for text inside the shape frame 

Color Color Over Image Fill Color Background fill for text on top of the shape 
image 

Measurement Units Object Width The width of the object, without consideration 
of the thickness of any border styles 

Measurement Units Object Height The height of the object, without consideration 
of the thickness of any border styles 

Measurement Units Line Length The length of the line 

Measurement Units Text/Image Padding Extra spacing inside the shape frame before the 

start of image/text content 
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Category Type Attribute Description 

Measurement Units Border Padding Extra spacing between the shape frame and the 
start of the border style 

Measurement Units Paragraph Indent X The amount of padding on the left/right side of 
the paragraph text 

Measurement Units Paragraph Indent Y The amount of padding above and below the 
paragraph text 

Measurement Units Above Text Gap The amount to vertically shift the text above 
the shape frame 

Measurement Units Below Text Gap The amount to vertically shift the text below the 
shape frame 

Measurement Units Inside Text Gap The amount of extra spacing to apply between 
the image and the inside frame text 

Measurement Units Inside Text Shift X Horizontal shift of the text inside the shape 
frame 

Measurement Units Inside Text Shift Y Vertical shift of the text inside the shape frame 

Measurement Units Inside Text Padding Extra padding above and below the text inside 
the shape frame 

Measurement Units Over Image Text Shift 
X 

Horizontal shift of the text on top of the shape 
image 

Measurement Units Over Image Text Shift 
Y 

Vertical shift of the text on top of the shape 
image 

Measurement Units Over Image Padding Extra padding above and below the text on top 
of the shape image 

Text Text Text Content The text context for the object or one of its text 
areas 

Text Font Font Settings The font for the object text or one of it's text 
areas 

Text Alignment Horizontal Alignment Horizontal alignment of text 

Text Alignment Vertical Alignment Vertical alignment of text 

Text Number Line Spacing Line spacing adjustment (-50 to +100 percent) 

Text Number Expansion/Compression Text expansion/compression factor (-50 to +50 
percent) 

 

Title/Shape Filter 

For page replacements, a title area filter will appear below the replacement criteria. 

This will restrict the text replacements to specific title and subtitles in the header 

and footer areas. 
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For object replacements with a shape type in scope, the 4 text areas can be filtered 

to restrict replacements to specific areas. 

 

Performing Replacements 
Unlike the Search utility, replacements can be repeated without closing the 

replacements window. Click on Replace and any replacements which were actually 

made are shown in the bottom of the window. 

 

If you had any search conditions present, it’s possible the number of replacements 

made could end up at zero. 

The replacement criteria values entered are preserved between replacement 

actions, even after you close the replacement window. 

When you are done with replacements, click on the Close button. 

Undoing Replacements 

Each click of the Replace button creates an undo level in the workspace. For 

example, if you replaced fonts, colors and border styles for objects in 3 separate 

clicks of the Replace button, there will be 3 undo levels added and each 

replacement action can be rolled back from newest to oldest. 

There is no undo action from the replacement window. You need to always perform 

undo actions from the main application window. 
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Album Backups 
Album backup options are provided under the Utilities menu. Note that cloud 

backups, which store the album archives on a remote location, is a subscription-

based service from SoftPro which requires a small annual fee to store and manage 

your album files in a secure repository. Cloud backups are described in a separate 

help topic. 

\ 

Album Backup 
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Backups are saved in a compressed archive format containing any selected albums 

and optionally all AlbumGen data files stored under the settings folder (the contents 

of this folder can be viewed in File Explorer by choosing the Open Settings 

Location from the Options (Settings) submenu). 

A backup must have a file name (do not enter any file extension) and a description. 

If no description is provided, a default will be provided at the time the backup is 

closed as per the format below: 

 

Application Data Backup 

A checkbox option is provided to add all AlbumGen settings files, which would be 

the contents of the Settings folder. An example of this location is shown below. 

 

Any customizations and settings associated with each window in AlbumGen (i.e. 

size, position and monitor) are stored under the Settings home folder or one of its 

subfolders. If you used any of the export options which allow you to set a location 

elsewhere on your PC, any exported files which are not under the Settings home 

folder will not be part of any backup. 

It's recommended that you always backup the application data and the default 

status will always be checked, unless your backups are specifically targeting album 

files only. A full backup would always include all album files on your PC and all 

application data files. 
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The backup window is divided into 2 lists with album files. The top list is the current 

list of albums which were opened in AlbumGen at some time, or added to the album 

browsing history (see the help topic for Browse Albums). 

The bottom list contains the albums you want to backup. 

The columns of information in the album lists are summarized as follows: 

File The name of the album file 

Description The optional description 

Size The size of the file 

Version The content format version of the album file. AlbumGen can 
open any version starting with 3.0 as long as the application is 

regularly updated to handle versions higher than 3.0. 

Opened When this album was last opened in AlbumGen. 

Created When the album was first created. 

Modified When the album last had at least one change saved. 

Pages The number of album pages, not including the cover page or any 

table of contents. 

Images The number of image links across all pages. Images are not 
stored in album files – only the location and name of the image 

is stored. 

Pwd This is an indication if an album is protected by a password. 

Comments This is an indication if the album contains summary comments. 

Location This is where the album currently resides on your PC. The 
browsing history keeps track of all locations from where an 
album was last opened. 

 

Backup Options 
Icon Menu Item Shortcut Description 

 

Add to Backup Ctrl + Ins Add selected albums from the available list to the 
backup list. You may also double click or right click 
with the mouse to add files. 

 

Remove from Backup Ctrl + Del Remove selected albums from the backup list. 

 

Add Every Album Ctrl + E Add all available albums to the backup list. 

 

Clear Backup List Ctrl + L Remove all albums from the backup list. 

 

Start Backup Ctrl + S This will start the backup job. A confirmation dialog 
will be presented for confirmation. 

 

Set Backup Location Ctrl + O Change the location where backup archives are 
saved. 

 

View Backup Location Ctrl + B Open the current backup location in File Explorer. 

 

Refresh List F5 Checks the status of all album files in the list and 
refreshes the information in the data grid. 

 

Add by File Ctrl + F If you need to add album files which are not in the 
current list, use this option to browse by file. Select 
any album file once you find the correct location and 
all album files from that location will be added. 
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Icon Menu Item Shortcut Description 

 

Add by Folder Ctrl + D This option will add new album files using a folder 

browser dialog. Select a path where album files can 

be found. 

 Clear Backup Locations  When you choose a new backup location, it will be 
added to a recent list accessed from the Backup 
Locations dropdown list. Use this option to clear 

that list. 

 

Help F1 Show the help topic for this window. 

 Edit Shortcut Keys  Change the keyboard shortcuts for this window. 

 

Starting a Backup 

Click on the start backup button from the toolbar or choose the start backup menu 

item. A confirmation dialog will be displayed. 

 

If the description is left blank, it will be set to a default description when the backup 

is created. 

Click Begin to start the backup. 

Backup Restrictions 

Backups will not be allowed for albums if one of the following transpires: 

• The album file can’t be opened due to data corruption. 

• The album file is a demo version and you are using a registered version of 

AlbumGen. 

• The album file was created with a registered version of AlbumGen and you 

are using a trial version. 
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Album Restore 

 

The current backup location is taken from the last location used for a backup. It will 

be displayed in the title bar. 

Once a restore location is selected, any existing backup archives will be available in 

the Backup File dropdown list. 

Select a backup archive from the list and it will be verified for content and any 

description will be displayed, along with any available album files in the top list. If 

any application file data was part of the backup, the Restore App Data checkbox 

option will be enabled and automatically unchecked. 

The Restore Location will always have at minimum 2 entries in the dropdown list. 

The default selection will be where the album files were backed up from. Unlike the 

previous version of AlbumGen, backup files for a single archive can be from multiple 

locations on your PC, as the location of the original album file is part of the backup. 

If you look at the rightmost column in the album listings, it will show the original 

location for the album. 

The second entry will be the current location where album files are opened from, as 

defined in the File Locations settings from the Options menu. 

You can add additional restore locations as needed. 

Restore Options 
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Icon Menu Item Shortcut Description 

 

Set Backup Location  Sets a new location where backup archives can be 

found. AlbumGen backup files have an extension of 

.AGPB 

 

Set Restore Location  Sets a new restoration location. Note that when 
restoring to a single location, this would cause all 
album files to be extracted to one folder even if the 

original source album files were distributed over 
several locations on your PC. 
 
You will need to take care of managing albums in 
this scenario as you would be keeping different 
versions of the same album in different locations 
unless you remove them from the original backup 

location. 

 

Add for Restoration Ctrl + Ins Add selected albums from the available list to the 
restoration list. You may also double click or right 
click with the mouse to add files. 

 

Remove from 

Restoration 

Ctrl + Del Remove selected albums from the restoration list. 

 

Restore Every Album Ctrl + E Add all available albums to the restoration list. 

 

Clear Restore List Ctrl + L Remove all albums from the restoration list. 

 

Start Restore Ctrl + S This will start the restoration job. A confirmation 
dialog will be presented for confirmation. 

 

Help F1 Show the help topic for this window. 

 Edit Shortcut Keys  Change the keyboard shortcuts for this window. 
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Starting a Restore 

Click on the start restore button from the toolbar or choose the start restore menu 

item. A confirmation dialog will be displayed. 

 

 

Click Begin to start the restore. 

Restoration Restrictions 

Backups will not be allowed for restoration if one of the following transpires: 

• The archive backup can’t be opened due to data corruption. 

• The archive is a demo version and you are using a registered version of 

AlbumGen. 

• The archive was created with a registered version of AlbumGen and you are 

using a trial version. 
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Restore Auto-Backup 

 

If you have automatic backups enabled (a single backup copy is enabled by default 

unless you change the settings), you may replace a current album file with a 

previous version which was saved into a subfolder of the album file location. 

See the topic 'Auto-Save for Recovery' under the section AlbumGen Album Files 

for an example of how automatic backups work and are configured. This help topic 

relates to the restoration process. 

The restoration window shows all recent album files accessed (the same list for 

normal backups and the album browser window), with an automatic backup file 

status for each one. 

If an automatic backup file is present, a green checkmark icon will appear next to 

the file name in the list. The total number of available backups for each file, if any 

is shown in the Backups column. 
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Restore Options 
Icon Menu Item Shortcut Description 

 

Restore Ctrl + R Restore an automatic backup file for the selected 

album. 

 

Open Ctrl + O Close the window and open the selected album file 
in the workspace. 

 

Properties Ctrl + P Show the properties for the selected album. 

 

Add by File Ctrl + F If you don’t see the albums you want to restore 
backups from, use this option to add all albums from 
a specific location using a file browser dialog. 

 

Add by Folder Ctrl + D Use this option to add all albums from a specific 
location using a folder browser dialog. 

 

Help F1 Show the help topic for this window. 

 Edit Shortcut Keys  Change the keyboard shortcuts for this window. 

 

Only one album file may be selected at a time from the list. Once selected, click on 

the Restore button to see a confirmation window. 

 

All of the available automatic backup files for the selected album will be displayed in 

a list, where the topmost entry is the most recent backup and the bottom entry is 

the oldest. If you only use a single level of automatic backup, the list will never 

contain more than one entry. 

Select a file to restore and choose to replace the current active album or save it 

under a new name as shown in the File Name field. Then click on the Restore 

button.  
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Merge Albums 
This option is found under the Utilities menu. Two album files can be merged 

together by page range. The destination album can be a new album file or the first 

album can be merged into the second album. 

 

Merging to a new album is the safest method as the original album files are left 

intact. Merging the first album into the second album will only leave the first album 

intact. There is no way to undo an album merge if you choose the latter method, so 

please ensure you have a backup available if you are not satisfied with the merge 

results. 

To set the source albums, click on the ellipsis buttons to the right and this will 

display the album browser window. When you choose the Open option from that 

window, the album will be placed in the input field. 

If you choose the new album merge option, enter an album file name (without an 

extension) in the field provided. 

Page Range 
You can choose all pages from the first album or a specific range. 

Merge Position 
This option sets the insertion point within the second album. The before or after 

options require you to set the page number and it must be within the range of the 

current page total of the second album. 
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Cover Page and Table of Contents 
If either album has a cover page and/or table of contents defined, you will need to 

choose which album will be used to retain these page types. 

Merge and Auto-Recovery 
Click on Merge to start. If there is any error in completing the merge, the second 

album will be restored from a temporary backup. If merging to a new album, the 

new album will be automatically deleted if any error occurs. 
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Adjust Image Links 
This option is accessed from the Utilities menu. You can use this utility to review 

and adjust the image link locations for all image references in the current open 

album file. 

 

All image paths will be shown in the dropdown list. To relink an image to a new 

location, enter the new value into the field provided. Use the Browse button to set 

the path or enter it directly into the field. 

If you don’t want to change a current image location, click the Don’t Change button 

to erase the new location, or simply don’t enter any path in the field. Repeat this 

for each image link path in the dropdown list. 

Click on the Files button to show all image names linked to the current path in the 

album file. 

Click Apply to change the links for any paths where a new location was entered. 

There is no undo option for changing image links. The album file won’t be saved 

after applying the changes. If you aren’t satisfied with the path changes, simply 

close the album file and reopen it. 
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Invalid Paths When Opening Albums 
When opening an album using any of the methods available, you may received a 

popup window with a message describing image locations which are not currently 

detected on your PC. 

 

There can be several reasons for which this window may be displayed: 

• The images are on a network share and the share is unavailable. 

• The images are on a removable media drive which is not powered on or 

connected. 

• The images are on a USB flash drive not plugged into a USB port. 

• You have relocated the images to a new folder or drive. 

• The folder location was deleted. 

• The album file was shared from someone else who has a different storage 

setup for their image files. 

For whatever the reason, you have 2 choices when this window appears. 

Click on Exit and the image link references in the album file will remain as is. Any 

links which are invalid will show a generic missing placeholder image in the 

workspace. 

Click on Update Links to go to the Relink Images window. 
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Image Conversion 
Version 2 of AlbumGen only supported the Bitmap (.BMP) file format. In order to 

support importing to AlbumGen from EzStamp, the images in EzStamp were also 

provided in Bitmap format. 

If you need to convert image files linked to Shape and Image objects using a 

different file format, then the convert image option from the Utilities menu can be 

used to perform a batch image file conversion. 

 

The conversion process is “in place”. This means that as images are converted from 

one format to the other, the original file is backed up, and the file under the new 

format takes its placed in the source location. 

You will need to provide an empty backup path and source path containing at least 

one image file of the source formats. 

For JPEG format conversions, choose one of four possible quality levels. Higher 

quality JPEG files will be larger. 

Check the Process Sub-Folders option to convert any images in file folders under 

the source path. 

Click on Verify to check the source path for compatible files based on the checked 

source formats. Images already in the same format as the target conversion type 

will be ignored. 

The total files and size of files verified will be shown in the bottom status bar. 
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Click on Convert to start the conversion. A progress bar will be displayed with 

elapsed time. 

 

Use the STOP button to stop the conversion. Any files already converted will be left 

as is, with the original files located in the backup folder. 
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Line Styles Editor 
This option is available under the Utilities menu and the name Plain Line Styles. 

It can also be accessed from the plain line object properties window. The editor 

allows for creation of custom plain line style templates which can complement the 

pre-supplied types provided by SoftPro. 

 

This window is similar in design to the properties tab for the plain line object. In 

fact the only attribute not applicable to a plain line template is the color of the line. 

A template is defined by its name and will appear in the Style dropdown list. To 

create a new template, click on the New button. 

The Default button will reset the line attributes to default values with a predefined 

standard thickness. 

The List button will present a preview window with any templates you've 
created...(basic templates pre-supplied by SoftPro are not listed) in a summary list. 

The preview window provides options to manage the current template list. 
The Rename button allows you to change the name of a template provided that 

the new name isn’t already in use and that the template is not pre-supplied from 

SoftPro. 
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Thickness 
The thickness is in 1/300 inch units with one unit being approximately ¼ point in 

size. The maximum thickness is 150 units or ½ inch. 

End Caps 
Each end of a line can have a unique end cap style. The Match End Caps option 

ensures the ending cap style will be the same as the starting style. The samples 

below include the selection marquee to indicate how the end cap extends past the 

end of the start/end points of the line. 

Style Sample Description 

Flat 

 

A flat end cap stops at the length of the line 
with no extension. 

Square 

 

A square end cap has ½ its size extending past 
the end point of the line. 

Round 

 

A round end cap has ½ it’s radius extending 

past the end point of the line. 

Triangle 

 

A triangle end cap extends 100% past the end 
point of the line. 

Diamond 

 

A diamond end cap has ½ its size extending 
past the end point of the line. The inner half of 

the diamond shape merges into the line. 

Rectangle 

 

A rectangle end cap has ½ its size extending 
past the end point of the line. 

Circle 

 

A circle end cap has ½ it’s radius extending 

past the end point of the line. Unlike the round 
end cap, a multiplier setting allows the end cap 
to be larger than the width of the line. 
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Arrow 

 

Arrows have a width, length and concavity 

setting, and the inner vertex/edge will intersect 
the end of the line. 

 

Multiplier 

This setting applies to the Diamond, Rectangle and Circle end caps. Increasing the 

multiplier will increase the size of the end cap. This multiplier is relative to the 

current thickness of the line. 

Unit Width, Length and Concavity 

These settings only apply to the arrow end cap style. 

Unit width is the width of the arrow perpendicular to the line. This is a multiplier of 

the current line thickness. 

Unit length is the size of the arrow parallel to the line. 

Concavity is a factor between -100 and 50 that defines a vertex that moves inward 

or outward from the arrow vertices perpendicular to the line. 

Dashed Lines 
A dashed line is based on pairs of dash and space segments. There can be from 1 

to 3 pairs. 

By default dashed line sizes scale to the thickness of the line and the dash-space 

segment sizes are relative to the line thickness. The dashes and spaces will look the 

same regardless of the line thickness. 

By checking the option to not scale the dashes and spaces, the segment sizes are 

always specified in 1/300 inch units. 
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Consider the same dash and space size for both scaled (unchecked) and unscaled 

(checked) options: 

Scaled 

 

Unscaled 
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Line Styles Preview 
This window is accessed from the List button in the line styles editor. It provides a 

list of all templates you have created and a preview area at the bottom for the 

current selected style. Templates are stored in a single library file in the AlbumGen 

settings folder. When making changes from this window, clicking the Apply Changes 

button will save all changes at one time. Cancelling out of this window will undo all 

changes collectively. 

 

Button Action Shortcut Description 

 

Rename Ctrl + R Rename the selected template. Templates provided by 
SoftPro may not be renamed. 

 

Delete Ctrl + Del Delete selected templates. Templates provided by SoftPro 
may not be deleted. 

 

Undo Ctrl + Z Restore any changes made (rename, import or deletion 
options which were applied) to the point when this 
window was initially displayed. 

 

Select F5 The selected template will be applied as the current 
dropdown selection in the line styles edit window. 

 

Export F2 Selected templates will be saved to an export file. This 
file can be shared with others via the import option. 

 

Import F3 If you have an export file, you can import templates to 
be added to the current style list. If there are any name 
collisions to existing styles, you will be shown a 
confirmation dialog with 3 choices: 
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Button Action Shortcut Description 

 

 

Apply 

Changes 

Ctrl + S Saves all templates changes to the plain line styles 

library file. This file is named LineStyles.pls and 

appears in the AlbumGen settings folder. 

 

Close 
Window 

Ctrl + W Close this window and discard any changes. 

 

Topic 
Help 

F1 Display this help topic. 
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Object Size Manager 
This option is available from the Utilities menu. You can define a custom width and 

height for any of the following object types: 

• Shape (Rectangle, Ellipse, Triangle, Diamond, Polygon) 

• Paragraph 

• Image 

• Table 

SoftPro provides a set of pre-supplied sizes carried forward from the previous 

version of AlbumGen. The object size manager provides options for managing 

custom sizes for each applicable object type. Pre-supplied sizes from SoftPro may 

not be modified. 

 

Sizes have a name, width and height. When defining a size, the unit type (inches or 

millimeters) must also be chosen. The icon to the left of each size indicates a pre-

supplied (S) or custom (C) size type. The pre-supplied types may not be modified 

but can be removed from the listing. 

The current object type is shown in the dropdown list. 
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Button Action Shortcut Description 

 

Export  Saves all custom sizes to a tab-delimited text file in UTF-

8 format. 

 

Import  Imports custom sizes from a text file. 

 

Revert Ctrl + R Discard any changes since the window was displayed. 
Making any size changes while in the edit window are not 
saved until you choose the Save option. 

 

Sort Ctrl + O Sorts all sizes in the current object type list by name 

order. 

 

Update Ctrl + U Update the name, width, height or unit type for the 
selected size entry. Pre-supplied sizes from SoftPro may 
not be modified. 

 

Delete Ctrl + Del Remove the selected sizes from the list for the current 
object type. 

 

Add Ctrl + N Add a new object size. The name must be unique and the 

width and height may not be the same as any other 

existing size. 

 

Copy Ctrl + Shift + C Copy sizes from the current list to other object types. 

 

Move to 
Top 

Ctrl + Home Move the selected sizes to the top of the list. 

 

Move Up Ctrl + Up Move the selected sizes up one position in the list. 

 

Move 
Down 

Ctrl + Down Move the selected sizes down one position in the list. 

 

Move to 
Bottom 

Ctrl + End Move the selected sizes to the bottom of the list. 

 

Save Ctrl + S Applies all changes to the size lists for all object types 
and closes the editor window. 

 

Close Ctrl + W Close this window and discard any changes. 

 

Help F1 Show the help topic for this window. 

 Merge 
Pre-

supplied 

 This menu option will restore pre-supplied sizes from 
SoftPro if they were previously removed from the size 

list. 
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Copying Size Lists 
When choosing the copy option, a window with copy options will be displayed. 

 

The copy selected option will not affect unique sizes for the target object sizes. The 

replace option will completely replace the size lists for target object types with the 

list from the source object type. 

Note that tables are a different type of object as their size has nothing in common 

with other object types, so it doesn’t appear in the choices as a destination for the 

copy option.  
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Font Mapper 
When opening an album file, it’s possible that there will be references to fonts 

which aren’t installed on your PC. When this happens, you will need to provide a 

substitution for the font using one that is installed on your PC. 

 

You will not be able to open the album file until you assign an available font to 

replace a missing font. Choose each entry in the left dropdown list, and selecr a 

substitution font from the right dropdown list. 

If you intend to find/install the missing font(s), cancel out of this window, install the 

font and restart AlbumGen. 

Once a font substitution is made, it will be added to an internal font mapping 

collection within AlbumGen and not visible to any other application. 
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You can access the Font Mapper from under the Utilities menu. 

 

You can clear the current list, delete selected entries, or assign a different font for 

mapping. 

Click on OK to commit all mapping changes. 

If you remove a font from the list, this won’t affect any album files which were 

already mapped when you tried to open them. AlbumGen will replace the fonts in 

the album file at the time the file is opened. The font substitutions will not be saved 

until you resave the album file. 

This allows you to backout from mappings you may have made in error (assigning a 

different font then intended). However, once that first save is made, the original 

font names are discarded for the album. 
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Grid Paper 
This option is available from the Utilities menu. A carryover from AlbumGen 

version 2, this utility allows you to print standard row/column grid paper using 

variable or fixed width cell sizes in inches or millimeters. 

 

Templates 
There is always a default unnamed template used when there is no custom 

template selected. To see the settings for a custom template, select one from the 

dropdown list. SoftPro provides a handful of pre-supplied templates. You can add 

new ones on top of this list. 

Paper Size 
Select the unit type then set the width and height, followed by the paper 

orientation. 

Borders 
The borders represent a perimeter around the edges of the paper where the grid 

will not be drawn. If you have a printer with borderless printing capability, you will 

be able to fill the grid on the page without borders. Most printers have a small area 

of space around the edges of the paper where content will never appear. If you see 

the grid lines being cropped before the edges of the paper are reached, you will 

need to set some border spacing. 
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Levels 
This is the number of grid line variations by style and divides regions of cells into 

smaller regions of cells. The example below uses 3 levels, with the smallest cell size 

at level 3 using green dashed lines. 

 

 

Grid Spacing Type 
Grid cells using variable spacing will have a set number of rows and columns and 

the size of each cell will be the available grid area width (page width less border 

width) / number of columns and the available grid area height / number of rows. 

If your cell sizes need to be exact, choose the fixed spacing type. 

Grid Lines to Print 
You can choose to print horizontal or vertical lines only, or all lines. If you check the 

Truncate Edges option, then partial cells of less than the expected unit size will be 

removed from the grid and extra border spacing will be introduced. 

Primary Grid Spacing 
For fixed spaced cell sizes, you will specify the primary cell size before any smaller 

divisions, if using level 2 or 3 grid line subdivisions. 

If you uncheck the Square Grid option, then the cell width can be set to a different 

value then the cell height. 

If the variable spacing type is used, then the grid spacing requires that you provide 

both values for the number of columns across and rows down the page. 
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Level 2 and 3 Units 
These are divisor values from the primary spacing. The primary spacing is divided 

by a level value to make smaller cells using the level 2 grid line style. If a level 3 

grid is chosen, then the level 2 cell size is further divided by the level 3 unit value 

to make smaller cells with grid lines of the level 3 style. 

Consider a grid with 1 inch primary spacing. If the grid is one level, then the cell 

size will be 1 inch square using only the one grid line style (blue). 

 

If you set the grid to 2 levels with a Level 2 Unit value of 2, then the cells will 

become ½ inch square, with 2 styles of grid line (blue and magenta). 

 

If the grid is 3 levels with a unit 3 divisor of 4, then you will see the following grid 

(blue, magenta and green). 

 

If you look a the status bar, the size of each cell division will be shown for each grid 

line style. 

 Primary cell size 1”, second level 0.5”, third level 1/8”. 
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Border Type 
No Outline No outline will surround the grid. 

Primary Grid Lines The level 1 grid line style will be used. 

Separate Border A distinct border line style will be used. 

 
You will need to set a border weight and color for this 

option. 

 

Alignment 
This option only applies when using the fixed size spacing type. Note that the 

truncated edges option will omit partial grid cells and create extra border space. 

Edge to Edge Grid lines are drawn from left to right and top to bottom. 

This may result in partial grid cells at the right and bottom 
edges of the grid. 

Midpoint to Edge The first grid lines are drawn from the center point of the 
available grid area. Then lines will be drawn from center to 

top, center to bottom, center to left and center to right. 
This creates a balanced grid with any partial cells having 
the same level of cropping on all sides. 

Centered Grid lines are drawn centered in the page such that any 
partial cells will automatically be dropped from the grid. 

The truncated edges option is ignored for this alignment.  

 

Line Styles 
The grid line styles are set in the 3 tabs at the bottom of the window. 

Weight 

Line weights are specified in points, where one point is 1/72 inch. 

Color 

Click on the swatch to set a line color. The RGB value of the color is shown next to 

the color swatch. 
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Dashed Lines 

When enabled, you will have up to 3 pairs of dash/space sizes available. You always 

need to provide a dash size and space size for the pair. When the dash sizes are 

unscaled, the dash/space unit size is 1/300 inch. When scaled, the dash/space size 

is a relative ratio based on the weight of the line. The following example shows a 

12-6 single pair dashed line (blue lines) with a weight of 1 point. 

Scaled 

 

Unscaled 
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Available Actions 
Button Action Shortcut Description 

 

Preview Ctrl + P Preview the current grid template. This option uses the 

standard page/object preview window with zoom and pan 
capabilities.  
 
Note that if you zoom out too far, grid lines with small 
weights may not appear until you zoom in. 

 

Print Ctrl + Shift + P Print the current grid template. 

 

Default Ctrl + D Reset the grid settings to a single level default grid. 

 

New 
Template 

Ctrl + N Create a new grid template. The current grid settings will 
be copied into this new template. 

 

Delete Ctrl + Del Delete the current template in the dropdown list. 

 

Rename Ctrl + R Rename the current template in the dropdown list. 

 

Update Ctrl + U Save any changes for the grid settings to the current 
template in the dropdown list. 

 

Export F2 Export the current grid template to a file. 

 

Import F3 Import a grid template from file. 

 

Close Ctrl + W Close the window and discard changes. 

 

Help F1 Help topic for this window. 

 Edit 
Shortcut 

Keys 

 Edit the shortcut keys for this window. 
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AlbumGen Options 
This section provides a summary of the items under the Options menu. Some of 

these items are described in detail in the AlbumGen Workspace Guide. Refer to 

that help topic for more information. The Application Settings submenu is also 

described in a separate help topic. 

Keyboard Shortcuts 
Every window in AlbumGen which contains a menu bar can have the keyboard 

shortcuts customized. 

 

As a convenience, every window with a menu has an item in the Help menu to 

directly access this edit window directly from the window you want to change the 

shortcuts to. 

The dropdown list will always show the current window the editor was launched 

from. You can access any window’s shortcut settings by selecting from the 

dropdown list. 

Menu items which are assigned a keyboard shortcut will be shown in a white 

background. Those without a shortcut will be shown in gray. 
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Available Actions 
Button Action Shortcut Description 

 

Set 

Shortcut 

Ctrl + Ins Assign a shortcut key for the selected menu item. Note 

that some windows will allow any single unqualified 
shortcuts, such as the letter “A” by itself. The main 
AlbumGen menu is an example. When this is allowed, the 
status bar will show the All Keys indicator: 
 

 

 

Remove 
Shortcuts 

Ctrl + Del Remove shortcuts for the selected menu items in the list. 

 

Undo 
Changes 

Ctrl + Z Undo all changes for the current window in the dropdown 
list. 

 

Clear 

Shortcuts 

 Clear all shortcut keys for the current window in the 

dropdown list. 

 

Export to 
File 

 Export keyboard shortcuts to a template file. 

 

Import 
from File 

 Import keyboard shortcuts from a template file. 

 

Save 
Changes 

Ctrl + S Save all keyboard shortcut changes for the current 
window in the dropdown list. The edit window will not be 

closed, to allow you to select other windows as needed 
for changes. 

 

Close 
Window 

Ctrl + W Close the window and discard changes. 

 

Help F1 Help topic for this window. 

 Revert 

Shortcuts 

 Restores the original shortcuts based on a fresh 

installation of AlbumGen for the current window in the 
dropdown list. 

 Revert All 
Shortcuts 

 Restore all keyboard shortcuts to the settings from a 
fresh installation of AlbumGen. All customized shortcuts 
for all windows will be replaced with the original settings. 

 Edit 
Shortcut 
Keys 

 Edit the shortcut keys for this window. 
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Side Toolbar Shortcuts 
The AlbumGen workspace window uses a top toolbar and a side toolbar. The top 

bar is fixed and can’t be changed. However, the side toolbar can be customized. 

You can access the side toolbar configuration from the Options menu or by right 

clicking in a blank area of the side toolbar panel. 

 

Buttons which can be assigned as shortcuts to the side toolbar are shown in the left 

list. Current assigned shortcut buttons are on the right. 

A preview of the revised toolbar is on the right, with any selected entries in the list 

appearing in a “pressed” visual appearance. 
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Available Actions 
Button Action Shortcut Description 

 

Assign Ctrl + Right Assign the selected shortcuts from the left list to the 

toolbar. You may also right click or double click entries to 
assign them. 

 

Unassign Ctrl + Left Remove selected shortcut buttons from the toolbar. You 
may also right click or double click entries to the right list 

to remove them. 

 

Insert Ctrl + Ins Inserts the selected shortcuts in the left list to the spot 
before the selected item in the right list. 

 

Exchange Ctrl + E Swaps two selected shortcut buttons in the assigned list. 

 

Gap Ctrl + G Inserts a gap below the selected shortcut in the assigned 
list. 

 

Undo Ctrl + Z Undo all changes made to the shortcut button 
configuration since the editor window was first displayed. 

 

Clear  Remove all current assigned shortcuts. 

 

Move to 
Top 

Ctrl + Home Move selected shortcuts in the assigned list to the top. 

 

Move Up Ctrl + Up Move selected shortcuts in the assigned list up one 
position. 

 

Move 
Down 

Ctrl + Down Move selected shortcuts in the assigned list down one 
position. 

 

Move to 
Bottom 

Ctrl + End Move selected shortcuts in the assigned list to the 
bottom. 

 

Export to 
File 

 Save the shortcut assignments to a template file. You 
only provide a name, not a location. 

 

Import 
from File 

 Import shortcut assignments from a file. This option will 
display a standard template browser window. 

 

Apply 
Changes 

Ctrl + S Save changes and close this window. 

 

Close 
Window 

Ctrl + W Close this window and discard changes. 

 

Help F1 Help topic for this window. 

 Revert  Restore the shortcut assignments to the default buttons 
as per a fresh installation of AlbumGen. 

 Edit 
Shortcut 
Keys 

 Edit the shortcut keys for this window. 

 

Available Button Space 

The side toolbar has a finite amount of space, even with a high resolution 4K 

display. Both the edit window and the main AlbumGen window will show as many 

buttons as the current size allows, even if you assign more buttons than can be 

shown. If you need more space for buttons, use the custom shortcut button window 

as the shortcuts window can be resized. 

 

 



AlbumGen 3 User Guide  P a g e  | 257 

Custom Shortcut Buttons Window 
A floating window is available from the View menu as Shortcut Buttons. This 

window can be sized and positioned around the screen independent of the main 

workspace window. 

 

There can be up to 5 unique button configurations, accessed  by the “1” to “5” 

buttons at the bottom. This current set with its button count is shown in the title 

bar. This window can be resized, and should be enlarged if the total buttons shown 

in the title bar are more than what you see in the window. AlbumGen will autohide 

buttons if they would end up off the screen or partially cropped. 

The rightmost button at the bottom is a shortcut to the Shortcut Button Manager 

window, the same one accessible from the Options menu. 
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The left side list shows available shortcuts to assign as buttons. The right side list is 

the current assigned list based on the set number (as indicated in the “SET” label in 

the status bar at the bottom). When you select an item from either list, it’s Hint 

Label (what appears when you hover over any button in AlbumGen) is shown in the 

status bar and the short description of the shortcut is shown below the toolbar. 

Available Actions 
Button Action Shortcut Description 

 

Change 

Set 

Ctrl + 1 to 

Ctrl + 5 

The 1 to 5 buttons will change button sets and update 

the available and assigned lists accordingly. 

 

Assign Ctrl + Right Assign the selected shortcuts from the left list to the 
assigned list. You may also right click or double click 
entries to assign them. 

 

Unassign Ctrl + Left Remove selected shortcut buttons from the assigned list. 
You may also right click or double click entries to the 
right list to remove them. 

 

Insert Ctrl + Ins Inserts the selected shortcuts in the left list to the spot 

before the selected item in the right list. 

 

Exchange Ctrl + E Swaps two selected shortcut buttons in the assigned list. 

 

Undo Ctrl + Z Undo all changes made to the shortcut button 
configuration since the editor window was first displayed. 

 

Clear  Removed all shortcuts from the assigned list for the 
current set. 

 

Move to 
Top 

Ctrl + Home Move selected shortcuts in the assigned list to the top. 

 

Move Up Ctrl + Up Move selected shortcuts in the assigned list up one 
position. 

 

Move 
Down 

Ctrl + Down Move selected shortcuts in the assigned list down one 
position. 

 

Move to 
Bottom 

Ctrl + End Move selected shortcuts in the assigned list to the 
bottom. 

 

Export to 
File 

 Save the shortcut assignments to a template file. You 
only provide a name, not a location. 

 

Import 
from File 

 Import shortcut assignments from a file. This option will 
display a standard template browser window. 

 

Apply 
Changes 

Ctrl + S Save changes and close this window. 

 

Close 
Window 

Ctrl + W Close this window and discard changes. 

 

Help F1 Help topic for this window. 

 Edit 
Shortcut 
Keys 

 Edit the shortcut keys for this window. 
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Application Shortcuts 
This option is for creation of Windows shortcuts for AlbumGen. 

 

AlbumGen creates shortcuts in the Windows start menu and optionally on your 

desktop when the application is installed. 

These shortcuts will only be applied to the user who installed AlbumGen. This 

shortcut creation option is available to account primarily for 3 scenarios: 

• You want to provide shortcuts to AlbumGen for more than one Windows user 

account on the same PC. 

• The existing shortcuts were deleted or no longer work. 

• You want a desktop shortcut but didn’t check that option during the 

installation for AlbumGen. 
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Page Grid 
Grid Size The grid size is a visual guide only to show grid lines at 

regular intervals in the page workspace. You must 
enable grid lines to be displayed as they are disabled 
by default to match version 2 of AlbumGen. 

Movement Alignment This setting is for when moving selected objects with 
the mouse and determines alignment points in an 

invisible grid (not necessarily the same as the display 
grid size). The default value is 5 millimeters or 0.25 

inches. 

Resize Amount This is the incremental amount an object will be 

resized when click and hold the left mouse button on a 
single selected object while dragging in any direction. 
The default value is 5 millimeters to match that in 

version 2 of AlbumGen. In some cases, such as rotated 
shapes/images and text objects, the resize amount will 

be applied uniformly in the opposing direction. 

Nudge Amount The nudge amount is used with the keyboard as 

opposed to the mouse. Use the cursor keys to nudge 
selected objects in any direction by the amount set by 
this value. 

 

Display Guides 
Rulers Show or hide the workspace rulers. 

Grid Lines Show or hide the workspace grid lines. 

Margin Colors Show or hide the margin fill color. Margin colors don’t  
apply to image-based page border styles. 

Border Colors Show or hide the border fill color. 

 

Display Units 
Most windows in the AlbumGen application will use the display units setting from 

the Options menu for all size and position information. Some windows may have 

override settings to allow inches or millimeters to be used without changing the 

workspace units setting in the main menu. 

Grid Origin 
The grid origin represents the (0, 0) coordinate for objects on the page. Object 

alignment options related to the page are dependent on the grid origin. The origin 

also determines the grid alignment when placing, moving and resizing objects with 

the mouse. 

Page The origin is the physical upper left corner of the page. 

Margins The origin is the left and top margin. 

Border The origin is the left margin + border and the top 
margin + border. 
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Reset Application Windows 
Most windows in AlbumGen consist of 3 primary categories of changes which are 

saved after the window is closed: 

Position of window, which is based on the current screen of the current monitor the 

window resides in. 

The size of the window including if the window is maximized to the screen size. 

Position and size are not applicable for non-sizable windows. 

Attributes on the window such as but not limited to: 

• Checkbox/Radio button status. 

• Dropdown list item last chosen. 

• Text input field content. 

• Widths of individual columns in windows which contain data grids 

(spreadsheet style content with rows, columns and cells of text). 

A fresh installation of AlbumGen will not contain any of these change values, as no 

choices or adjustments would have been made. 

 

When you Reset the windows, AlbumGen will remove all the files under the 

application Settings folders related to individual window changes, in effect making 

each window behave as if you were using AlbumGen for the first time. 

The individual window settings are always part of backup archives if you choose to 

backup all of the AlbumGen settings content. 
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Refresh Printers 
AlbumGen creates an initial printer profile the first time you launch the application. 

This will consist of all installed printers and their paper size lists. 

If you install or remove printers after installing AlbumGen, you will need to refresh 

the printer profile. All of the windows in AlbumGen which provide printing actions 

will have a shortcut to refresh the printer list, which is the same as this refresh 

option. 

 

Remove Temporary Files 
AlbumGen makes use of temporary files for image caching, the undo/redo history 

and backup files used for automatic rollback if a task would fail to complete. These 

files can remain behind if AlbumGen was terminated unexpectedly or if you 

manually remove or move album files outside of AlbumGen. 
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Cover Pages 
A cover page is a new feature added to AlbumGen. When enabled, the first page of 

an album is used specifically for adding content that is not tied directly to the other 

pages in an album. The initial content is a blank page. Cover pages contain no title 

or sub title content, so the header/footer values have no meaning. 

The margins and borders are still used, and you can choose a border style for the 

cover page. 

When selecting this option, a window is displayed allowing you to enable or disable 

the cover page. All albums contain a cover page. It simply has to be enabled to see 

it. 

 

If you uncheck the cover page option, it will be hidden, but the content will still 

remain saved with the album file and can be enabled at any time. 

Click on Preview for a page preview of the cover page. 

Click on Print to print only the cover page. 

Page setup options for a cover page will not include the tabs for the Header/Footer 

title content or any options to set a name, bookmark or comments. 

Cover pages will never show in a table of contents. 
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Table of Contents Pages 
Table of contents pages are generated from page and object names. If you have no 

named pages or objects, then you may not create a table of contents. You can still 

configure the format of a table of contents using this option. 

Page and Object Names 

You can set names for any object or page with a name. This name can appear in 

the table of contents. You will see names in the Page Navigator window. 

 

It’s important to set the TOC option for any object to have visibility in the object 

properties window: 
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General Settings 

 

The General tab is a consolidated version of the page setup window. 

Set a Paper Size and Orientation. 

Set the Margins. 

The Borders are extra white space areas surrounding the page number line content. 

Default Margins will set the page margins to 1 inch on all sides except the right side 

which is 0.5 inches. 

Image Border Margins will set the margins to match the selected image border style 

settings. 

Default Format will reset all attributes to a basic page format. 
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Format 

 

This tab defines all of the content format settings. 

Header 

Caption 

This will appear above the individual page number lines, either 

on the first page only or all TOC pages. Set the alignment, color, 
font and the text to display. 

Line Spacing 
Adjustment 

This is a percentage increase in spacing the page number lines 
apart from each other. 

Indent This is the right indent value for object names from page names. 
If your album has names for objects or pages but not both, this 

setting is ignored. 

Auto Reduce 

Font Size 

If the name for a page or object is long and it doesn’t fit the 

page width for the page number lines area based on the 
assigned font and point size, this option will reduce the font size 
to make the content fit. 

Enable 
Separator 

This option draws a separator line between the page/object 
name and the page number. 

Page and 
Object Font 

The page name lines and object name lines can use separate 
font styles, sizes and colors. 

Separator 
Gap 

This is a small amount of white space between the separate line 
endings and the edges of the page/object names and page 

numbers. 

Separator 

Style 

Use a simple line style window to set the format for the 

separator lines. 

TOC Page 

Number 
Indicators 

This option enables page numbers in the footer area below the 

bottom margin. Page numbers are always shown in roman 
numeral notation to avoid any confusion with regular album 
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page numbers. The page numbers use their own font, size and 

color settings and can be shown with a divider line sitting along 
the bottom margin point. Use the margin gap setting to increase 
the distance between this divider line and the start of the page 

numbers. 

 

Border Style and Image Borders 

These two tabs are identical to the normal album page setup for setting border 

styles. Refer to the Page Setup help topic for details on page border styles. 

Line Styles 

Separators for the page number lines and a page number divider line use the same 

style settings window to define how the lines are drawn for the TOC pages. 

 

Specify a line weight, color, and whether to use solid or dashes lines. 

There are end cap styles for both the end of the lines and the ends of each dash in 

dashed lines. 

When using dashes lines, the dash/space values are always done in pairs, using 

from 1 to 3 pair segments which repeat. 

For lines which are scaled, the dash and space unit values are relative ratios to the 

current weight of the line. For unscaled dashed lines, the unit values are fixed as 

multiples of 1/300 inch per unit. 
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Sample and Preview 

The Sample button will show a dummy TOC page using the current format 

settings. The Preview button will show the real TOC page content, but only if at 

least one object or page has a name defined. 

Printing TOC Pages 

Click on Print to print the TOC pages. The option to print the TOC pages also exists 

in the regular AlbumGen print dialog, but you must choose a Cover/TOC option 

from the dropdown list: 

 

Templates 

When you click on the OK button, the current TOC format settings are saved to the 

current album file and not applicable to any other album file. If you want to apply a 

specific TOC format to other albums, click on Save to store the format to a file. 

Then use the Load option to recall those settings. 
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EzStamp Import 
If you have a registered version of EzStamp, and you have the latest update 

installed which supports the AlbumGen Version 3 export option, you can create 

album pages and objects from EzStamp content using the EzStamp Import option 

from the Extras menu. EzStamp content is placed in the Windows clipboard and is 

shared with other AlbumGen clipboard content such as album pages and objects. If 

you attempt to use the Paste option from the Edit menu for EzStamp content, you 

will see the following window: 

 

You can verify the version 3 export option from the EzStamp preferences window 

under the General II tab. If this option doesn’t appear, or is unchecked, then 

exported content will only work with AlbumGen version 2. 
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Multiple Stamp Import 
If there is more than one stamp reference from EzStamp in the clipboard, you will 

see the following window. The total number of stamp references and image links in 

the clipboard is shown at the top. The estimated number of new pages added to the 

album are shown in the upper right area. Depending on the other settings in this 

window, the page count can vary significantly. 

 

Shape or Image You can import the content as shape or image objects. Note  

that for an image object, only stamp references with image 
links are imported and all text content is ignored. 

Rows Per Page 
and Columns Per 

Page 

When specifying how to fill rows and columns of objects, you 
can either fill across the page and down the page or choose 

to limit the object total to a specific value. 

Place Image Check this option to include the image link. If unchecked, 

the image link is discarded. This option is not applicable to 
image object imports. 

Horizontal and 
Vertical Position 

The placement can be left aligned or center aligned in either 
direction. The offset values are added white space on the 
perimeter of the available page space. 

Gaps Between 
Objects 

This specifies white space between objects. The size of 
objects includes the text above and below the object frame. 

No Sizing 
Information 

Stamp references from EzStamp usually have a width and 
height defined for pre-supplied country stamp data. This size 

will be used to set the size of the object. Some stamp 
records may not have size information. In these cases, a 
default width and height must be applied. 
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Text Placement 

Areas 

There are 4 dropdown pick lists for the Catalog Number, 

Alternate Catalog Number, Year and Denomination/Color. If 
a specific text attribute was not exported from EzStamp, 
then associated pick list will be disabled. 

 
When you choose a value from the dropdown list, it’s 

assigned to one of the 4 areas as per the white assignment 
boxes to the right of the pick lists. 
 

If a text attribute is already assigned to an area, the new 
attribute will be added to it as a multi-line text value for the 

area. For example, catalog number and year can appear one 
below the other in the Below Frame area. 
 

Click on Reset to remove all text area assignments. 

Fill Color for text 

oversize 

Check this option to show a different object fill color if the 

size of the text would exceed the interior object frame width. 
Choose a fill color to use. The default is Red. 

Apply Font 
Reduction 

Check this option to reduce the point size of the font for text 
inside the frame or over the image if it doesn’t fit the width 

of the object frame. Set the minimum point size for the 
reduction. If the text still won’t fit, the reduction will stop at 
this point size. 

Show Missing 
Size Indicator 

Check this option to show the object in the AlbumGen 
workspace with a no-size icon in the bottom right corner of 

the object frame. This setting is saved for each object and 
can be disabled in the object properties window. 
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Shape Defaults 

Click the Shape button to set the default object properties for the import. 

 

Default Size When sizing information isn’t provided from EzStamp, this 

will be the default size. 

Frame Space 

Padding 

This is applied to the interior of the object frame as white 

space where the image or text should not be displayed. 

Interior Fill 

Color 

Enable to set a default fill color for inside the object frame. 

Impact Aspect There are 3 choices in how to fit the image to the shape. The 

default choice ensures that if EzStamp provides a stamp 
size, the image is stretched to the fit that size and if no 

sizing is present, the image will not be stretched and its 
original aspect ratio of width to height will be preserved.  

  



AlbumGen 3 User Guide  P a g e  | 273 

Border Style 

 

The border style settings are identical to the object properties window. You can use 

no border, a standard border style or brackets. Refer to the Shape Object 

Properties help topic for more information. 
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Text Settings 

 

Text Area Choose the format for each of the 4 text areas. When you 
choose an area all other settings in this tab will reflect the 

new area chosen. 

Text Alignment Choose both horizontal and vertical (inside/over image only) 

alignments. 

Inside Frame 

Adjustments 

For inside and over image areas, you have additional 

settings for a background fill color with or without a width 
extension option, shift values in both directions and an 
additional white space increase in the text height. 

Text-Image Gap Only applies to the inside shape area to add a small amount 
of white space between the edge of the image and the text 

content. 

Above/Below 

Gaps 

For text above and below the frame, the gap is a white 

space amount between the frame/border and the start of the 
text content. 

Spacing 
Adjustment 

An increase or decrease of the spacing between multiple 
lines of text based on a percentage of the default font height 

line spacing. 

Width 

Adjustment 

Used to create expanded or compressed fonts. 
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Templates 

Use the Save and Load buttons for saving the import settings as template files. 

Click on Default to reset the import options to match the default settings used by 

version 2 of AlbumGen. 

Starting an Import 

Click Import to start. You may not import content from EzStamp unless all pending 

changes to the album are saved. There is no undo option for the import. If you 

need to revert the album and discard the imported pages, you can do so by any of 

the following methods: 

• Deleting the page range which was inserted using the Delete Pages option 

from the Page menu. 

• Use the Revert option from the File menu. 

• Close the album file and re-open it. 

Note that when you finish an import, the Undo history is automatically cleared. 
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Single Stamp Import 
If only one stamp reference is found in the Windows clipboard from EzStamp, the 

import window will appear as follows: 

 

The options are the same for the import choices, text areas to assign and other 

checkbox choices. You may change the width and height fields as needed. 

Once you click OK, the window will be closed and a special “Ez” mouse cursor will 

be displayed for you to click the drop location in the page workspace. Press the Esc 

key to cancel placement or right click and choose the cancel option from the popup 

menu. 
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Text File Import 
This option is available from the Extras menu. The text import facility has been 

carried forward from version 2 of AlbumGen with a few enhancements. 

 

Import File Click on ellipsis button to browse for a text file or enter the 
location and name of the file directly in the input field. The 
format of the text file can be plain text or UTF-8 format. 

The file must be defined with specific columns based on the 
Import File Field List. Select the fields from the left list to 

add them to the right list. The top-down order in the right 
list will be the left-to-right order of columns in the import file 

Image Link Path The image link column can contain a path to the image file 
or just the image file name only. If there is no path 
component in the import column, the Image Link Path 

value will be used to set the image location. 
 

File Format AlbumGen Version 2 is the format that was used by the 
previous version. When choosing this option, the fields list is 

locked and may not be modified. 
The Custom option will allow you to add and remove fields 
as needed using the 3 buttons between the two lists 

Text Qualifier The qualifier is the character used to surround column 
values which may contain a delimiter (tab or comma). Only 

specify a qualifier type if you are certain the import file 
content uses either single or double quotation marks around 

the field values. 

Delimiter The import file can use either tabs or commas to separate 

the columns. 
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Size Units If you have a width and column specified in the import file, 

you will need to specify the unit type for these columns as 
inches or millimeters. 

Header Row Check this option if the first line in the import file is a header 
row with captions rather than the first object content record. 

 

Starting the Import 
Click on the Import button to start. The contents of the import file will be verified 

for correct format and number of columns. If there are no errors, an import list 

summary window will be displayed. 

 

Click on the Import button in this window to continue. 

This will present the same window used by the EzStamp import option. Refer to the 

EzStamp Import help topic. 
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Album Cloud Backups 
Cloud backups of your albums and application data files are stored securely offline 

in a remote repository. Similar to cloud backup services for other SoftPro products 

like EzStamp and EzCoin, cloud backups must be registered with SoftPro for use 

and involve a small annual subscription fee to use. 

An internet connection is required to both register for and use the cloud backup 

service. 

The backup, restore and registration options are all found under the Extras menu. 

Registration 
When choosing the registration option, a window as shown below will be displayed. 

If you have not submitted a request for cloud backup registration, contact SoftPro 

or use Email button in the window to send a request. 

If you have been notified the cloud backup service is registered for use, click on the 

Register button. Once registration has been verified (an active internet connection 

is required), the backup and restoration options will be functional. 
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Cloud Backups 

 

Cloud backup archives have a few notable differences from standard backups on 

your local PC. 

• Only a single backup for a given album name can be stored remotely. 

• You may only backup albums from a single location at a time. If the same 

album name is located in different folders, the version from the current 

location shown the backup window takes precedence. 

• All application settings files from the AlbumGen Settings folder (press Ctrl+ 

F12 from the main application window to see the Settings folder contents in 

File Explorer) will always be archived. 

• The speed of backups is dependent on your internet connection and on the 

provider SoftPro uses for the secure storage of your files. Given that album 

files are very efficient in storage size in the compressed archive format, the 

amount of data to store is reasonably small per album. 

As with normal local backups, no other file content such as images files are part of 

cloud backup archives. You are responsible for your own backups for these other 

file locations. 
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The backup window is divided into available albums (in the current folder shown in 

the dropdown list) for backup in the top half and albums you assign for the backup 

in the bottom half. 

Before the backup window is displayed, AlbumGen will check the remote repository 

for the current backup status of all album files. 

A status icon and backup date are shown first. If the backup date shows as “None”, 

then the album file has never been backed up to cloud storage. 

The icon has a specific image type to designate the current backup status. Keep in 

mind these status types are tied directly to your current backup location. If you 

change to a location with different albums with different names or the same name 

as a cloud backup, the status will likely be different for a given album file. 

 
There is a backup album in cloud storage and it matches the local version. 

You will not be able to re-backup these albums unless you remove them 
from the cloud server first. 

 
There is a backup album in cloud storage but it doesn’t match the content 
of the local version. 

 
There is no backup of the album file – only the local album file exists and is 
verified to not have any errors. 

 
The backup archive only exists in cloud storage and has no version in the 
current backup folder on your PC. 

No 
Icon 

Album files have not been verified yet against cloud storage. 

 

Available Actions 
Button Action Shortcut Description 

 

Verify F5 Check the current albums in the list against backup archives. 
When this is completed, the status icons will be updated to 
indicate album differences between the local album and any 

backup on the cloud server. 

 

Backup 
Location by 
Folder 

Ctrl + B Set a new backup location for source album files using a 
folder browse dialog. 

 

Backup 
Location by 
File 

Ctrl + F Set a new backup location for source album files using a file 
browse dialog. 

 

View 
Albums 

Ctrl + L Open the current album file location using File Explorer. 

 

Add Albums Ctrl + Ins Add selected albums from the available list to the backup list. 

You may also double click or right click to add files. Files 
which have a match status to a cloud backup may not be 
added as the local and remote copies are identical. 

 

Remove 
Albums 

Ctrl + Del Removes selected files from the backup list and places them 
back into the available list. 

 

Add Every 
Album 

Ctrl + E Add every album to the backup list. 

 

Remove All 
Albums 

Ctrl + Shift 
+ Del 

Clears the backup list. 

 

Remove 
from Cloud 

 Removes the selected album files in the available list from 
the cloud server. The selected albums must reside in cloud 
storage. 
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Button Action Shortcut Description 

 

Start 

Backup 

Ctrl + S Start the backup task. 

 

Close 
Window 

Ctrl + W Close this window and discard changes. 

 

Help F1 Help topic for this window. 

 Clear 

Backup 
Locations 

 This menu option clears the backup location history from the 

dropdown list. 

 Edit 
Shortcut 
Keys 

 Edit the shortcut keys for this window. 

 

Starting the Backup 

Choose the Start Backup option. This will display a confirmation and progress 

window. Once you click the Begin button, progress of the transfer will be displayed 

as the example window below indicates. If you click on the STOP button, the 

current album file will be sent to cloud storage and then the backup will be stopped. 
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Cloud Restoration 

 

The restore window is similar in layout to the backup window. Album files residing 

in cloud storage and the current Restore Location as per the dropdown list selection 

appear in the top list and the albums to restore appear in the bottom list. 

The status icon and backup date are shown like the backup window and the status 

icon has one additional type. 

 
There is a backup album in cloud storage and the content matches the local 
version. Matched albums may not be added to the restoration list. 

 
There is a backup album in cloud storage but it doesn’t match the content 
of the local version. 

 
There is no backup of the album file – only the local album file exists and is 
verified to not have any errors. 

 
The backup archive only exists in cloud storage and has no version in the 
current restore folder on your PC. 

 
The local album file could not be opened for cloud content verification due 
to an error. 

No 
Icon 

Album files have not been verified yet against cloud storage. 
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Available Actions 
Button Action Shortcut Description 

 

Verify F5 Check the current albums in the list against backup archives. 

When this is completed, the status icons will be updated to 
indicate album differences between the local album and any 
backup on the cloud server. 

 

Restore 

Location by 
Folder 

Ctrl + B Set a new restore location for album files using a folder 

browse dialog. 

 

Restore 
Location by 
File 

Ctrl + F Set a new restore location for album files using a file browse 
dialog. 

 

View 
Albums 

Ctrl + L View the current restoration location with File Explorer. 

 

Add Albums Ctrl + Ins Add selected albums from the available list to the restore list. 
You may also double click or right click to add files. Files 

which have a match status or only exist locally may not be 
added as only cloud backups which are different or don’t exist 

in the restore location may be added. 

 

Remove 
Albums 

Ctrl + Del Removes selected files from the restore list and places them 
back into the available list. 

 

Add Every 
Album 

Ctrl + E Add every album to the restore list which is allowed. 

 

Remove All 
Albums 

Ctrl + Shift 
+ Del 

Clears the restore list. 

 

Start 
Restore 

Ctrl + S Start the restoration task. 

 

Close 
Window 

Ctrl + W Close this window and discard changes. 

 

Help F1 Help topic for this window. 

 Clear 
Restore 

Locations 

 This menu option clears the restore location history from the 
dropdown list. 

 Edit 
Shortcut 
Keys 

 Edit the shortcut keys for this window. 
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Starting the Restoration 

Choose the Start Restore option. This will display a confirmation and progress 

window. Once you click the Begin button, progress of the transfer will be displayed 

as the example window below indicates. If you click on the STOP button, the 

current album file being restored will be completed and then the restoration task 

will be stopped. 

By default, the Restore Application Data option is unchecked. It’s assumed that 

the settings data on your PC is always up to date. Unless you are performing a 

clean installation of AlbumGen in which the settings files were removed, you should 

never check this option. 
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Application Settings 
There are many settings in AlbumGen which can be customized to your needs. 

These settings are saved to your PC when the application is closed. They are also 

part of any local or Cloud backup. 

Due to the number of settings available, there are several settings windows 

accessible from the Options menu. You may click on the settings icon in the top 

toolbar for the same choices. 
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The Open Settings Location option will show the current Settings folder for 

AlbumGen in File Explorer. This location contains many types of configuration files 

and templates. The location varies based on the version of Windows you’re using. 

For Windows 10, the location would be: 

C:\Users\<Logon Name>\AppData\Local\SoftPro2010\AlbumGen3\Settings 

The “Logon Name” would be your Windows logon name. 

Please Note: Do not make application settings changes if you have multiple copies 

of AlbumGen running. Changes made in one instance of AlbumGen will not take 

effect in other versions unless those other versions are restarted.  

 

General Settings 

 

Date and Time Format 

Page titles and subtitles use special macro codes to show the current date and time. 

Under version 2 of AlbumGen, the format of the date and time could not be altered 

and would use your default Windows settings. 
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Button Tooltips 

Tooltip text will appear over a toolbar button when you hover the mouse cursor 

over it for brief period. You may disable the tooltip text if you find them distracting, 

or change the duration/delay values as needed. 

Symbolic Font Adjustment for Spaces 

There are two types of symbolic fonts provided in Windows. The width used for the 

space character can be larger than expected. If you need to adjust the width of the 

spaces for either of these font types, you can apply a multiplier from 0.1 (10%) to 

1 (default 100% size). 

File Sizes and Units 

For any windows which may show the size of data files (in bytes, KB, MB or GB), 

there are 2 standards. One (SI Units) assumes 1,000 bytes = 1 kilobyte, the other 

assumes 1,024 bytes = 1 kilobyte. You may choose either unit size factor. 

Automatic Mouse Movement 

Many windows will have a default “action” or “accept” button and a default “cancel” 

or “close” button. By checking this option, AlbumGen will position the mouse cursor 

over either a default action button or another area on the window to minimize the 

amount you must drag the cursor. 

Dialogs which are owned by Windows, such as the File Open dialog window are 

unaffected by this setting. 

Album Description in the Title Bar 

Check this option to show both the album name and description in the AlbumGen 

title bar. 

Image Preview Background Color 

For any windows which show previews of images, this will be the background color 

surrounding the area where the image is not occupying space. 

Default Image Resolution 

AlbumGen assumes all images have a resolution contained in the file in Dots Per 

Inch (aka DPI). For example an image with 300 DPI and 600 pixels wide would be 2 

inches in width if printed at 100% size. 

Most files formats contain embedded DPI values. Older bitmap (BMP) files may not. 

If AlbumGen can’t detect the image DPI, it will need to apply a default value. The 

default value can be set here. 

Tool Button Spacing 

Toolbars can arrange buttons both vertically and horizontally. When buttons are 

segregated into groups based on their function, gaps are inserted which consists of 

a small area of blank space. These gaps can be adjusted and will be applied to 

every window which contains toolbars. 

Image Resolution for Object Copy 

There are 4 object types which can be converted into an image: Shapes, Lines 

(Horizontal and Vertical), Paragraphs and Text. You can copy a selected object of 
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one of these types into the Windows Clipboard as an image. Note that the format of 

this image is tied to AlbumGen only and may not be shared with any other 

application. 

Once an image is copied, it may be linked as an image from either a Shape or 

Image object. This feature is intended for placement of objects at odd angles which 

are not directly supported. 

This setting determines the quality of the image to be created. 

Font Pick List Method 

Objects which use fonts will have a settings window where the choice of font to use 

when editing text is presented in a dropdown list such as the example below: 

 

 

You have 2 options for how to autocomplete the font choice as you are typing the 

font name in the field provided (if you click the down arrow at the right to directly 

pick from the list of fonts, these 2 options have no effect). 

Auto-Fill: The nearest matching font will be automatically filled in with highlighting 

as you type the first and subsequent characters. You can accept the matching font 

by pressing ENTER, TAB, or by clicking any place outside of the dropdown field. 

You may also backspace/delete characters as you type to make adjustments. If no 

matching fonts can be suggested, then no auto-completing of the nearest match 

will be presented. 

Drop-Down: This is similar to Auto-Fill using auto-completion suggesting on font 

names. An additional list of matching fonts based on the characters you type in the 

field will appear as a popup list. You may then choose fonts from the popup list, in 

addition to the methods mentioned under Auto-Fill. 

Current Printer and Resolution 

When AlbumGen is started for the first time, a check for the current default printer 

on your PC will be made. This printer will be assigned to the dropdown list. If no 

printers are installed on your PC, this dropdown list will be empty. 

The printer list is stored in a local AlbumGen printer profile which also contains the 

paper specifications for each printer. If you add or remove printers and they don’t 

appear in the dropdown list, click on the Refresh Printers button. 

The Print Resolution is important for text content inside paragraphs when word 

wrap is enabled, as this value determines word sizes and the point at which lines 

break and wrap to the next line. 
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When choosing a printer, the resolution will be obtained from the printer driver 

settings. You may choose any value from 300 to 2400 DPI if you feel that default 

one from the printer driver is not the value to use. 

If no printer is installed on your PC, the print resolution will default to 600 DPI. 

Alternate Connection Method for Cloud Services 

AlbumGen (and other SoftPro products like EzStamp and EzCoin) uses a provider 

for cloud-based services, which includes cloud backups, application registration and 

free update downloads. 

If you have any difficulty connecting to the cloud for any of these services, it may 

be due to enhanced security attached to connections over the internet, such as a 

private VPN, Firewall rules, or software which blocks specific types of connections 

such as those used by SoftPro products. 

The checkbox option at the bottom of the settings window can be enabled to force 

AlbumGen to use an alternate connection method to the cloud services host and 

alleviate type of blocking on your PC. 

If this option doesn’t solve any connection issues, you will need to contact SoftPro 

for additional assistance. 
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File Locations 
There are specific locations for AlbumGen data files. Some of these locations may 

not be changed. Most of them are based on your Windows logon name.  

 

Album Files 

The default album file location is under the Documents folder for your Windows 

logon name. The AlbumGen installation application allows you to change it as part 

of the installation. You may also change it here at any time. Other windows in 

AlbumGen may also change the default album location. You are free to open album 

files from any location – however you may only have a single “home” location tied 

to the Open option from the File menu. Click on the ellipsis (…) button to change 

this location. Click on the Open button to show the current location contents in 

Windows File Explorer. 

Backup Archives 

For local backups, this will be where you want to store backup archives created 

using the Backup Album Files from the Utilities menu. Backup archives have a 

file extension of .AGPB. 

Image Path 

Shape and image objects are the only two types which allow you to link an image 

by file name and location. You can set a “home” location for images which will be 

used by default when browsing for images to link to the objects. You can link 

images from multiple locations in a single album, so this setting simply provides 

access to the same location without needing to browse for it. 
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Plain Text Export 

Some options in AlbumGen allow you to generate text files with various content. 

This is the default save location. 

Custom Image Border Libraries 

Page image borders are pre-supplied library files installed along with the AlbumGen 

application files. These library files may be updated or expanded as part of future 

application updates. Image borders are generated using a special application not 

provided with the AlbumGen installation. As such, this setting is reserved in case 

the option to create custom image borders is opened to AlbumGen users in the 

future. 

Installation Path 

This path can’t be changed. An Open button is provided to show the location in File 

Explorer. 

Application Settings and Workspace Files 

This path can’t be changed. An Open button is provided to show the location in File 

Explorer. This folder contains a subfolder for application settings (which are part of 

backup archives) and temporary workspace files/folders which are not part of 

backups. Note that your AlbumGen registration and update profile is stored within 

this location. If you delete all of the files from this location or they are lost due to 

unforeseen circumstances, AlbumGen will still function, but you will need to re-

register the software. 

Documents Folder 

AlbumGen will use the Windows Documents location for AlbumGen data, under a 

subfolder of SoftPro2010\AlbumGen3. 

 

Click on the Default button to reset all folders to default locations. 
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Workspace 
The AlbumGen workspace is the area in the main application window not occupied 

by the menu, status bar and any toolbars. 

 

Shape Alignment 

For shape objects, there are two sizes AlbumGen uses when aligning to other 

objects. Shape size is the width and height of the object without including any 

border styles. Border size will include the width of the border style (including its 

weight factor). Text above and below the shape are never used to define the 

alignment size. The default setting uses the border size to be consistent with 

alignment options in version 2 of AlbumGen. 

Decimal Places for Size and Position 

Depending on the display units (Inches or Millimeters), you can set the number of 

decimal places to show on any window where a position or size is present. 
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Object Size and Position Popup Info 

If this option is enabled, then clicking with the mouse on an object will show its 

current size and position at the top left corner of the object’s location, using the 

color and font settings provided in a settings window displayed by clicking on the 

Settings button. 

 

If you resize the object by dragging the mouse, the values will be updated until the 

mouse button is released. 

There is an option to enable/disable this popup when placing new object, as the 

popup might be distracting in this case. 

The font style can’t be changed – you may change the font size from a limited 

selection of choices from the pick list. 

As there is no popup option in version 2 of AlbumGen, this feature is turned off by 

default. 

 

Ruler Size 

The ruler guides above and to the left of the workspace area can be resized up to 

50% larger than default. 
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Selection Anchors 

The size of the corner and edge selection anchors (see example below for anchors 

in blue) can be adjusted between 6 and 10 pixels in size. 

 

Mouse Hover Range for Anchors 

This is a radius of pixels where the anchors will become active for drag-resizing. 

The range can be from 6 to 12 pixels. 

Mouse Wheel Zoom Change 

If your mouse has a scroll wheel, this is used to adjust the zoom magnification for 

the album page when the Ctrl key is held down. This is a fixed percentage value, 

unlike the zoom tool where a mouse click uses varying zoom factors. 

Hiding Grid Lines 

Visible grid lines are disabled by default, as no such option existed in version 2 of 

AlbumGen. When enabled, the grid lines will use the display Grid Size value defined 

in the Options menu (under the Display Guides submenu). Depending on the 

zoom magnification level, the grid line spacing can shrink to a level where all you 

would see is grid lines. This setting ensures that grid lines will be suppressed at low 

zoom levels. 

Detail Zoom Level 

In version 2 of AlbumGen, you could press the Esc key to toggle between the 

current zoom level and 300%, which was the maximum zoom factor. In version 3, 

you must use the SPACE bar for detail zoom toggle. In addition, the zoom factor 

can go as high as 2400%. The default is still 300%. 

EzStamp Size Missing Indicator 

When using the import options from the EzStamp application to place image or 

shape objects (EzStamp import from the Extras menu), the information passed 

from EzStamp includes the width and height for the stamp. Not all pre-supplied 

data from SoftPro for EzStamp will contain a stamp size. In these cases, a default 

size is applied. AlbumGen provides a setting to show a missing size on an import in 

the workspace area. These indicators will not appear in preview windows or printed 

albums. 
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The indicator will appear in the bottom right corner of the object, inside the border 

frame. 

 

 

Comment Indicator 

You may attach comments to any of these object types: Shape, Image, Text, 

Paragraph or Table. A comment is an annotation and will not appear in page 

previews or printed albums. You can search on comments or display their content 

using the appropriate menu item or toolbar button. To see if an object has any 

comments, this indicator can be enabled and will appear in the bottom left corner of 

the object frame. 

 

Position Placement for Single Object Paste  

If you copy a single object to the Windows Clipboard, you can paste it onto the 

page in one of two methods. 

Click placement is the default as this was the only method in version 2 of 

AlbumGen. The mouse cursor will change to a placement icon and you will click to 

set the drop point for the upper left corner of the object frame. 

When unchecked, pasting will place the object at the exact location where it was 

taken from originally. Note that this is the default behavior when a selection of 

multiple objects are copied to the clipboard. To visually tell if the pasted object 

overlaps on the one it was copied from, the selection anchors will be shown in a 

different color. 
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Multiple Object Placement from File 

You may copy a selection of multiple objects to a file. This file will in effect become 

a template for complex compositions which can be re-used. When placing objects 

using the paste from file option, you can choose if the objects will appear in their 

original locations, or shift relative to the upper left corner of the page. 

Rule Unit Font Size 

Check this option to increase the font size of the units in the ruler guides if the 

default size is hard to read. 

 

Non-Printing Object Indicator 

Check this option to show a small icon in the top left corner of the object if it’s 

marked as non-printing. 

 

Non-Printing Object Preview 

Check this option to display non-printing objects in the various page preview 

windows. 

Table Resize Method 

When drag-sizing a table object with the mouse, you can maintain the proportion of 

the cell width and height using either of the first two options. Under these options, 

either width or height are locked from a resize. For the unconstrained option, the 

width and height can be resized independently. In addition, the text font size is not 

resized with this last option as fonts must keep their proportions.  

Matched Object Selection Method from Searches 

The Search option from the Page menu will present all matching pages and objects 

in a search results window. When you select pages from the results windows there 

are 3 choices for how the objects may be chosen on the page in the workspace: 

• Matched objects will be automatically selected – any previous selection is 

discarded. 

• Matched objects will be bookmarked – any previous bookmarks for the page 

are discarded. Bookmarks appear as below, in the upper right corner of the 

object frame: 
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• No selection or bookmarks. None of the matched objects on the page will be 

visually marked or selected. 

 

Click on the Reset button to reset all workspace settings to default values. 
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Performance 
Performance settings are provided for tuning efficiencies for the following key 

areas: 

• Image scaling for large image files 

• Render quality for page preview and the workspace area 

• Undo and Redo 

• Large Fonts and Windows anti-aliasing 

• Data file cache location 

 

 

Cached Image File Scaling 

To improve performance when previewing pages or when building page content in 

the main application workspace, image caching using smaller versions of the 

original image is provided. You can set the width and height limits for an image for 

all 3 areas where page content is displayed. Any images which exceed this limit in 

width or height will result in a scaled image being stored in the cache in TIFF or 

JPEG format. Note that scaling is never applied to printed albums – the original 

image size is always used for maximum possible print quality. 

Note: If you want to sacrifice quality to have the fastest preview times, then set the 

Image File Scaling values for all 3 types (workspace, single/side-by-side and tiled 

preview) to the same pixel limits, as this will enable all 3 view options to share the 

same scaled image file. 
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Cached Image File Retention 

Check this option to retain any scaled images stored in the file cache. If this option 

isn’t checked, all reduced image files for the album will be removed when you close 

the album or AlbumGen. It’s recommended you retain the image cache, as album 

and page loads will be noticeably quicker. If the images used are not larger than 

the limits set in the scaling image size settings, there will be no image caching 

applied. The pre-supplied stamp images used in EzStamp will not require any image 

file caching if the default size limits are not changed. 

You can set a retention period on cached images from between 7 and 300 days, 

assuming the retain cache option is enabled. This setting will have no effect if you 

always have the cache emptied when AlbumGen is closed. 

Click on the Clear button to remove cached images using the window shown below: 

 

Graphics Quality 

If your PC experiences slowness when previewing or building album pages with 

many images, you may need to lower the graphics quality. Text quality is 

unaffected by this setting. This setting applies to 3 different areas: 

• The main workspace 

• Page preview for single page or side-by-side modes 

• Page preview for tiled page mode (multiple rows and columns) 

Image Cache Format 

When using the image cache, you can choose how to store smaller versions of the 

images linked to shape and image objects for your album pages. The JPEG option 

will result in smaller images, at the expense of image quality. The loss of detail is 

highly subjective and based on the content for each image. 
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Undo and Redo Levels 

AlbumGen allows you to undo or redo from 5 to 1000 actions. Each level of undo 

will require more memory to hold the previous album content. AlbumGen will store 

any task which could take a significant amount of memory (i.e., deletion of multiple 

pages) as file content in the current cache location. If your PC has sufficient 

memory, you can set the default number of undo levels to a higher value. 

Undo and Redo Memory Usage 

If you want to limit the amount of undo/redo file caching in AlbumGen, then check 

this option to store the undo changes in memory instead of the file cache. Note that 

some tasks like album page reorganization will still cache undo changes to file 

regardless of this setting. 

Large Font Anti-aliasing 

AlbumGen relies on functionality built into Windows to draw text to the screen 

within the page workspace on the main application window.  

Depending on the Windows version and your display settings, this may affect 

performance when the Windows ClearType settings are enabled and the workspace 

is currently zoomed to a high magnification level. 

By default this setting is enabled when the “zoomed” font size is at least 36 points 

on-screen. For example, if your zoom level is 1000% on a font that is 4 point in 

size, its effective on-screen size is 40 points, so anti-aliasing will be disabled for 

text at this font size. 

Data File Cache Location 

AlbumGen uses a file cache for album auto-recovery, scaled (reduced) images, 

page preview and the undo/redo history. The default location can be changed. Any 

files in the cache will be relocated to the new location. Given this movement 

process, please ensure no other copies of AlbumGen are currently running. You 

may not change the cache location if an album file is currently open. 

 

Click on the Reset button to reset all performance settings to default values. 
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Album Backup Settings 
There are 3 types of backups for albums to your PC (Cloud backups are covered in 

a separate help topic). See the Album Files help topic for examples. 

 

Auto-Save for Recovery 

When changes are pending a save and you have not done so for a period of time, 

AlbumGen will automatically create a temporary save file on your PC in the file 

cache location (see File Locations settings). Once you save changes with the Save 

or Save As option, or close the album file, the temporary save file is automatically 

removed. If for any reason AlbumGen is terminated unexpectedly, any auto-save 

albums are presented for recovery when you next start the application. 

You can choose the time period between an automatic save or disable the option 

entirely. 

Album Auto-Backup 

Automatic backups are done as soon as you open an album file, provided that this 

is either the very first time opening the album, or a specific amount of time has 

passed between the last automatic backup. The settings provided include both the 

number of automatic backups to retain per album, and the duration between 

backups in either hours or days. 

Manual Backup Location 

This is the current default location when manual backup archives are saved. Use 

the Browse button to change the default location. 
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Workspace Colors 
These settings control the colors used in the main AlbumGen window’s workspace 

area. 

 

Click on any of the buttons with the red ? symbol to see small screen capture 

examples of the associated area in the workspace. 

Click on the Reset button to restore all workspace colors to default values. 
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Thumbnail Colors 
The thumbnail preview window shows basic filled rectangles for the size and 

position of objects on the current page. Each object type has a different fill color 

which can be customized. 

 

 

Click on the Reset button to restore the colors to default values. 
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Default Object Fonts 
In version 2 of AlbumGen, the default font was always the same for every object 

type and area where a font is used, which was 8-point Arial. 

In version 3 of AlbumGen, you can set the default font for new objects to any font 

and size of your choosing. 

 

The Text Area dropdown list contains all text areas for all object types which use 

fonts. 

You can set a default color other than black by clicking on the color swatch. 

Use either the Font dropdown list or click on the ellipsis (…) button to set a new 

font. 

Click on Reset to restore the font to 8-point Arial black for all text areas. 
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Data Grids 
Data grids resemble a spreadsheet of rows and columns of text content, and 

optionally an icon on the left side of a row to indicate some type of status. This 

settings window allows for full customization of the color scheme for data grids in 

AlbumGen. 

 

All of the color settings are for filling in the background of cells and setting the text 

color. Selecting a Content Type from the dropdown list will present options for each 

cell type’s text and fill color. 

Content Type Description 

Header Caption Header captions represent the first row of a data grid: a description of what the 

column’s data contains. If sorting is allowed for a data grid, the current sorted 
column will appear in a different text/fill color, the default being white on black. 

Normal Content This represents a standard data grid presentation without any special 
highlighting. A cell/row can be either selected or unselected, and a row can be 
either odd or even, which would require 4 different combinations of text and fill 

colors. 

Special 
Highlighting 

This is an alternate variation of the 4 color combinations used to indicate 
special conditions for rows of data. 

Bookmarked 
Content 

For any data grids where you have an option to bookmark rows, this color 
group will be used. 

Error Conditions For any data grids which mark rows with an error status, such as upgrading 
version 2 AlbumGen album files, this color group will be used. 

Cell Grid Lines This is the color for drawing the lines surrounding the data grid and between 
individual cells. 
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Row Adjustment 

This setting adds some extra space between rows. 

Font Size 

Data grids can use a font size between 8 and 14 points. 

Text Indent 

This setting represents the white space on either side of individual cell text content. 

Foreground and Background Color 

Click on any of the 16 pre-defined color swatches to set the text or fill colors. Click 

on the More button to choose additional colors using the color picker window. 

 

Data Grid Preview 

The data grid shown in the middle of the settings window shows the current color 

scheme as you make changes. You may click on any cell in this data grid to set the 

content type and area directly. A sample of the current text/fill color is displayed 

below this grid along with their RGB values. 

Data Grid Font 

The current font is shown at the bottom of the settings window. Click on the Font 

button to change to a different font. 

 

Click on Default to restore the data grid settings to default color values. 

Click on Save and Load for storing and recalling custom color schemes to a color 

profile. 
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Hint Help Appearance 
The buttons on toolbars can be clicked on with the right mouse button to present a 

small popup help window containing a brief summary of the button’s task and any 

optional shortcut key defined under its menu selection. 

The font, font size and color settings can be changed for this popup window. 
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Font Favorites 
If you create albums with a specific set of fonts which represent only a small 

number relative to the total number of fonts installed on your PC, you may assign 

specific fonts to a favorites list. 

 

This settings window contains a list of all installed fonts on the left side list and the 

current assigned favorites on the right side list. 

Assigning Fonts 

Select one or more fonts in the available list, then click on the single green plus 

button. You can also right click on the selection or double click a single font to 

assign it. Clicking on the double green plus button will move all the fonts into the 

favorites list. 

Removing Fonts 

Repeat the same actions on the favorites list to unassign fonts and place them back 

into the available list. Use the red minus buttons instead of the green plus buttons. 

Saving Favorites 

Click on the green checkmark button to save the favorites list. For font favorite 

template files which you can use to create multiple lists, use the Save and Load 

options from the menu. 
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Font Favorites Selection 

The font favorites list only appears in the font picker window. All of the other 

windows which may have a dropdown list for fonts will always show the full set of 

installed fonts on your PC. 

 

 

The current font might not be in the favorites list when the dropdown is set to only 

show the font favorites, as indicated by the radio button selection above. This font 

will be inserted into the dropdown list, but will not be added to your favorites list. 

When the Font Filter is set to None, Starts With or Contains, the dropdown list will 

contain all installed fonts. 
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Borders Manager 
The Borders Manager is a designer for border styles which can be applied to pages 

and specific object types: Shapes, Paragraphs and Tables. Horizontal and vertical 

line object styles also are managed through the Borders Manager, which can be 

found under the Utilities menu. Use of the manager is optional, as SoftPro 

provides pre-supplied styles for pages and objects which carry forward from version 

2 of AlbumGen. 

Border Definition 
Before going into detail on the various design windows, some basic concepts on a 

border or line style are described. 

Page Borders 

Pages borders are defined by 4 corners and 4 edges. The corners are always 

defined as a pattern of 32 by 32 units. A unit is 1/300 inch if the weight of the 

border is 1, and page borders can have a weight from 1 to 6. The weight is part of 

the page setup for the album and is not part of a border design. The default weight 

is 3, which is 3/300 inch per each unit. 

The edges which connect the corners are up to 32 units in thickness. Both the 

corners and edges can use less units than 32 and the unused unit space will be 

blank and be subtracted from the overall “thickness” of the border. 

Edges can be defined as either lines or patterns. With a line format, each of the 32 

units can be either drawn with a color or as a blank unused area. For the drawn 

units, the line can be solid or dashed. 

Edges defined as patterns are like corners in that the pattern is up to 32 by 32 

units in size. A pattern for the edge is tiled to fill the width or height of the page 

between the corners. 

Only one corner is created in the border designer. This corner is then mirrored left 

to right and/or top to bottom to create the other 3 corners. 

Only one horizontal and one vertical edge is created. The opposing edges (left -> 

right and top -> bottom) are created by mirroring the edge content. 

Object Borders 

An object border is always a line format up to 32 units in thickness. Each unit 

represents a line segment, where each segment can be solid or dashed and have its 

own color. 

Line Styles 

Horizontal and vertical line objects are one-dimensional but their style design is 

created the same way as object borders. 
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Border Designer Window 
The designer window is where you will create new styles or modify existing ones. 

Note that pre-supplied styles from SoftPro may not be modified and all the settings 

options will be greyed out and this will indicated in the status bar at the bottom left 

of the window. 

 

The designer window has 3 tabs for each type of border/line style. Basic settings 

are presented in this window, along with preview areas of the line segment 

patterns, colors, and line formats. 

The dropdown list at the top of each tab is the current styles list. Pre-supplied 

styles are always presented at the top of each list. Custom styles you create are 

placed below the pre-supplied styles. 

You may not modify a pre-supplied style, but you can use the duplicate option to 

create a copy as a custom style which can then be modified. 
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Page Borders 

This tab has 2 preview areas. The large area represents a combination of the top 

left corner, top edge and left edge designs, joined together. The edge content is 

always shown in blue and the corner content in black. 

The bottom area is a sample of the one of the edges. The choice of which edge to 

display is based on the current radio button selection under Edge Direction. If the 

top edge is mirrored to the left edit using the Mirrored setting, then the edge 

direction group is disabled and the left edge in the preview area is a mirror of the 

top edge, rotated counter-clockwise. 

Edge Type 

The top and left edges can be represented by 32 line segments or a pattern of 32 

by 32 units in size the same as a corner pattern. If a pattern is used, it will be tiled 

using one of three edge tiling methods, which repeats the pattern across or down 

the page between the corners. If no corners are defined, the edges will occupy the 

full space between the page margins. 

The option Do not clip the pattern ensures that when the edge tiling reaches the 

start of a corner (or the page margin), it will not be partially rendered and simply 

stop, leaving a possible gap of white space. 

Edge Tiling Method 

Applicable only to patterned edges, this determines the tiling method to use to 

stamp repeated copies of the edge pattern across or down the page. 

Center to Corner The pattern starts in the middle of total edge space and is 

tiled towards the corners in both directions (center to left 
and right or center to top and bottom). The total edge space 
is between the margins, less the corner size. 

Corner to Center The pattern starts at the both corners and is tiled inwards to 
the center point of the edge space. 

Across The pattern starts at the left/top and is tiled across to the 
right and down to the bottom of the edge space. 

 

Mirrored 

When checked, the top edge is mirrored to the left edge using a counter-clockwise 

rotation. All options to edit the left edge are disabled. 

Edge Direction 

This is not a style setting. It’s used to choose which edge to display in the bottom 

preview area. The bottom preview area allows for more space to see dashed line 

settings. 

Corner Gap 

This is in 1/300 inch units. It allows for some white space to exist between the 

corner and edges. 
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Edge Gap 

This is in 1/300 inch units. It allows for white space to be added between each of 

the edge tiles so that they will not join together. If you want the edge pattern to be 

tiled in a seamless manner, ensure this value is zero. 

Weight 

This is a preview setting and is not part of the style design. Use the weight to 

preview the style in the 6 possible factors where a weight of 1 = 1/300 inch. 

Border Colors 

If this option is unchecked, all content for the border will be designed in black and 

white “rectangles” in the various edit windows, and the style itself will be allowed to 

have a custom color set in the page or object property windows. 

If this option is checked, then you must set the color for every non-blank unit in the 

pattern or line design. 

Suppress Sides 

These options will disable the drawing of any of the 4 sides. Note that turning off a 

side will also disable any corner designs tied to the side. For example turning off 

the bottom side of the border will suppress the two bottom corners along with the 

mirrored bottom edge. 

 

Object Borders 
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This tab shows a preview of the border with a rectangle shape in the top area and a 

preview of the line format at the bottom. The unused portion of the 32 segments 

which make up the thickness of a border style are shown in the grey diagonal hatch 

pattern. Any white space in the preview areas represents the part of the border 

style where no content is present. 

Border Size 

The border size is generally the unit thickness where content exists. However, you 

may add some blank space padding to the border thickness by setting the 

dropdown value to anything greater than the content unit thickness. As shown in 

the sample above, this style has 8 extra units of white space. This padding is useful 

if you want to create separation between the object frame content and the start of 

the border style. 

Weight 

The weight is just a setting for the preview size. Object weights are stored with the 

object, not the border definition. 

Border Color Option 

When checked, you may apply multiple colors to the style content. When 

unchecked, the border can only use a single color, which is stored with the object 

and the album file. 

Dashed Line Scaling 

When this option is checked, each unit in the dash/space values are in 1/300 inch 

units as a fixed size. When unchecked, the dash/space values are relative units to 

the weight and size of the border. The sample 2 border style with the option 

checked appears like this: 
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Line Styles 

 

The large preview area shows all 4 variations of horizontal and vertical lines (each 

line orientation has an alternate rendering direction). The bottom preview area is 

the same preview format as used for object borders. 

Weight 

The weight is just a setting for the preview size. Object weights are stored with the 

object, not the style definition. 

Style Color Option 

When checked, you may apply multiple colors to the style content. When 

unchecked, the style can only use a single color, which is stored with the object and 

the album file. 

Dashed Line Scaling 

This option behaves the same as for object borders. 
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Common Actions 

Both the menu setup and the toolbar are organized based on which of the three 

style tabs is currently being displayed. Common actions which apply no matter 

what tab is displayed will be summarized below. Actions which are per style tab will 

be summarized as separate topics. 

Button Action Shortcut Description 

 

New 
Template 

Ctrl + N Create a new blank style template. 

 

Duplicate 
Template 

Ctrl + T Duplicate the current style template as a new template. 

 

Delete Ctrl + Del Delete the current style template. You may not delete 
pre-supplied templates from SoftPro. Note that deleting a 
template which is currently being used by an album will 
result in an automatic reset to the default style for 
affected objects/albums. 

 

Rename Ctrl + R Rename the current style template. You may not rename 

pre-supplied styles. 

 

Sort Ctrl + O Sort the style list. Pre-supplied styles may not be sorted 
and will always appear above custom styles. 

 

Dashed 
Lines 

Ctrl + D For object border and line style types and for line-based 
page border edges, this option adds or removes dash line 
formats. 

 

Preview Ctrl + P Previews the current style at 100% size or a fit-to-

window size. The preview window can be resized as 
needed. 

 

Revert Ctrl + Z Reverts all templates to the previous saved version. Any 
pending changes are discarded. 

 

Apply 
Changes 

Ctrl + S Save template changes. Note that the borders manager 
window will remain option after choosing this option. 

 

Close 

Window 

Ctrl + W Close this window. 

 

Help F1 Help topic for this window. 

 Export 
Style 

 Export the current border/line style to a template file. 

 Import 
Style 

 Import the current border/line style from a template file. 

 Import 
Version 2 
Borders 

 This option should only be used if you have added 
custom border or line styles in version 2 of AlbumGen. 

 Edit 
Shortcut 

Keys 

 Edit the shortcut keys for this window 
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Page Border Actions 

The following actions only apply when the Page Borders tab is active. 

Button Action Shortcut Description 

 

Edit 
Corner 

F5 Display the corner pattern designer window. Only the top left 
corner is created and the remaining corners are created by 
mirroring the upper left pattern. 

 

Edit Top 
Edge 

F6 Display the edge pattern designer window for the top edge. This 
option only applies if the edges are set to use patterns. The 
bottom edge is created by mirroring the top edge. 

 

Edit Left 
Edge 

F7 Display the edge pattern designer window for the left edge. This 
option only applies if the edges are set to use patterns and the 
mirroring for the top edge to left edge option is disabled. The 
right edge is created by mirroring the left edge. 

 

Corner 
Colors 

 Display the color format window for the corner if the color option 
is enabled. 

 

Top Edge 
Colors 

 Display the color format window for the top edge if the color 
option is enabled. 

 

Left Edge 
Colors 

 Display the color format window for the left edge if the color 
option is enabled and the left edge isn’t mirrored from the top 
edge. 

 

Line Style 

Format 

F9 If the edges are defined as line format, this option will display 

the line designer window. This designer allows both edges to be 
defined at the same time. 

 

Object Border Actions 

The following action only applies when the Object Borders tab is active. 

Button Action Shortcut Description 

 

Line Style 
Format 

F10 This option displays the line designer window as it applies to 
object borders. 

 

Page Border Actions 

The following action only applies when the Line Styles tab is active. 

Button Action Shortcut Description 

 

Line Style 
Format 

F11 This option displays the line designer window as it applies to line 
object styles. 
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Version 2 Border Styles 
All of the pre-supplied border and line styles from version 2 of AlbumGen are 

carried forward to ensure upgraded albums will use the same styles without 

change. 

The border styles settings were stored in a plain text file named borders.ini, 

located in the same folder where the AlbumGen 2 application was installed. This is a 

pre-supplied file with SoftPro and wasn’t intended to be customized. However, as a 

plain text format file, savvy users who understood the pattern definition 

specification could add custom styles to this file. 

Any custom styles would not be known to SoftPro and as such would not be 

available when version 3 is installed. If you have made any customizations to the 

version 2 borders file, you must use the import option from the Borders Manager 

before you upgrade you album files. The Import Custom V2 Borders option will 

allow these custom borders to seamlessly integrate with the pre-supplied borders 

from SoftPro. 

 

To import custom border styles, browse to the location where version 2 of 

AlbumGen is installed and select the borders.ini file. Then click Import. If no 

custom styles were detected, you will be notified as such. 
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Corner Pattern Designer 
For page borders, the corners are defined as a 32 x 32 unit pattern. Each unit is 

1/300 inch when a weight factor of 1 is used. Weight factors are set by the album 

and page and not the border styles. 

 

This is a resizable window – it’s recommended that you increase the size if you find 

the 32 x 32 grid cells too small for drawing on. 

The top left section is the drawing grid. There are 2 small side bars 32 units in size, 

to the right and below the drawing grid. These show the current top and left edge 

patterns at the point where they would join the corner, which would be the leftmost 

units for the top edge, and the topmost units for the left edge. 

The top right area is a preview of the corner pattern (in black) as it would join to 

the top and left edges (in blue). 

The area below the preview is used for options tied to the current drawing tool. In 

the sample above, this is the pencil tool, and the buttons set the pencil unit width. 

At the bottom is the current style name and below that is the status bar with the 

cursor X, Y coordinate and any hint messages when choosing a button or menu 

option. 
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Corner patterns don’t have to fill the entire width or height of the 32 x 32 grid. 

Edges will join to the corners where the pattern ends. You can omit corner content 

entirely and define the pattern as 32 x 32 blank cells. The example below generates 

an identical overall page border even though the corner pattern in the top sample 

doesn’t fill the grid width or height. The blue area in the preview shows how the 

edges will extend to meet where the corner pattern cell content starts. 
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Tool Options/Actions 
Button Action Shortcut Description 

 

Black 

Cells 

B Sets the drawing tool to use black cells which represent filled 

pattern content. 

 

White 
Cells 

W Sets the drawing tool to use white cells which represent 
transparent areas in the pattern. 

 

Pencil 
Tool 

D Sets the standard drawing tool as a pencil. This is the default 
tool mode and the current pencil thickness is chosen with the 8 
buttons below the preview area.  

 

Line Tool L Sets the drawing tool for line mode. When drawing a line, click 
once to set the starting click point. The clicked cell will appear 
in filled in red. If you need to set a different starting point, hold 
down the Ctrl key while clicking with the left button. Click a 
second time to complete the line. The default behavior is to 
create a horizontal or vertical line. To create a diagonal line 
between the two points, hold down the Shift key when clicking 

the second point. To cancel the current line point placement, 
click anywhere in the grid with the right mouse button. 

 

Selection 
Tool 

M Use the mouse to click and drag a selection of cells. While 
dragging the selected cells will appear in red, and when you 
release the left button, the selection will be marked in blue. 

 

 
 

 
 
To clear the selection, click anywhere outside the selected cells. 
Hold down the Shift key to add to the current selection. 

Hold down the Ctrl key to subtract from the current selection. 
Use any of the 8 directional arrow buttons below the preview 
area to shrink or expand the selection on a given side. 

 

Movement 
Tool 

V This tool will move the current selected cells in the direction 
you drag the mouse while holding down the left button, or by 
using the arrow keys. Use the Accept or Cancel buttons to 
finish/cancel the move, or press the Enter/Cancel key. 

 

Fill Tool F This tool will use the current black/white cell setting to either 
fill or erase cells in the grid based on a paint fill starting at the 
click point. 

 

Wand 

Tool 

S Selects all bordering cells matching the black/white fill state 

which the mouse was clicked. Hold down Shift to add to the 
current selection, hold down Ctrl to subtract from the current 
selection. 
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Button Action Shortcut Description 

 

Flip 

Horizontal 

Ctrl + Shift 

+ H 

Flips the selected cells horizontally. 

 

Flip 
Vertical 

Ctrl + Shift 
+ V 

Flips the selected cells vertically. 

 

Rotate 
Selection 

Ctrl + 1 
Ctrl + 2 
Ctrl + 9 

Enabled rotation mode. Use the 3 rotation buttons for 90, 180 
and 270 degree rotations. 

 

Mirror 

Edge 

 This option is not applicable to corner patterns and is only used 

when editing the pattern for horizontal or vertical edges. When 
used with edge patterns, the current edge will be mirrored by 
rotation to the other edge (top edge -> left edge or left edge -
> top edge). 

 

Undo Ctrl + Z Undo the last change. Use Ctrl + Shift + Z to undo all changes 
since this window was displayed. 

 

Copy Ctrl + C Copy the selected cells for pasting. 

 

Cut Ctrl + X Copy the selected cells for pasting, and erase the contents of 
those cells. 

 

Paste Ctrl + V Paste the copied cells to a new location. The pasted content will 
“float” over the grid shaded in red. Use the arrow keys or drag 

into place with the mouse. Click on the Accept/Cancel button or 
press Enter/Esc. When you are in paste mode, you can rotate 
the selected cells using the 3 buttons provided. 

 

Apply 
Changes 

Ctrl + S Apply all changes to the corner pattern and close the window. 

 

Close 
Window 

Ctrl + W Close the window and discard changes. 

 

Settings F2 Settings for the designer window. 

 

Help F1 Help topic for this window. 

 Save  Save the current pattern definition to a template file. 

 Load  Replace the current pattern definition from a template File. 

 Import 
Image 

 This option should only be used if a different application was 
used to create a pattern. AlbumGen will attempt to convert the 
image from the Windows clipboard to a black and white pattern 
32 x 32 units in size. Depending on the size and format of the 
image, it may not produce a useable pattern. 

 Select All Ctrl + A Select all cells. 

 Deselect 
All 

Ctrl + D Unselect all cells. 

 Invert 
Selection 

Ctrl + I Invert the selection state of all cells in the grid. 

 Increase 
Selection 

Ctrl + 
Arrows 

Keys 

Increases the current selection in the direction of the arrow 
keys. 

 Decrease 
Selection 

Ctrl + Shift 
+Arrows 

Keys 

Decreases the current selection in the direction of the arrow 
keys. 

 Delete Delete Erases the selected cells with the opposite of current fill style 
(black if drawing with white and vice versa). Hold down Ctrl to 
clear all cells. 

 Edit 
Shortcut 
Keys 

 This window can use unqualified shortcut keys (without Shift, 
Ctrl or Alt) in case you want to use a different shortcut setup. 



AlbumGen 3 User Guide  P a g e  | 324 

Designer Settings 

 

The pencil size can be set from this window or from the designer window using the 

size buttons. 

Pencil tool draws from the center point unless the top left corner option is checked. 

The remaining settings are all for the colors to use for the drawing grid. 
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Edge Pattern Designer 
For page borders, the top and left edges can be defined as a line style format or as 

a 32 x 32 pattern similar to the corner pattern. This designer window is for the 

pattern edges. Object border and line object styles only use the line style format. 

 

Designing edge patterns is identical in terms of available tools and drawing 

methods as for corner patterns. There grid area is slightly different. 

For the top edge pattern, the right edge cells of the corner pattern are shown to the 

left. For a left edge pattern, the bottom edge cells of the corner pattern are shown 

above the drawing grid. This allows you see which grid rows/columns need to be 

set to seamlessly join to the corner. 

The preview area shows both the top and left edge patterns in blue and the corner 

pattern in black. 
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Edge Line Designer 
For page borders, the top and left edges can be defined as a line style format or as 

a 32 x 32 pattern similar to the corner pattern. This designer window is for the line 

style format. 

 

Both the left and top edge lines are set using the smaller side and bottom drawing 

areas which are one cell in size. The page corner pattern makes up the remaining 

space and acts as guide to allow seamless joins between the corner and edges. 

Defining the lines involves setting any of the 32 cells in the side/bottom grids to 

black. Settings colors and dashed lines formats are formatting using separate 

designer windows. 

The preview area shows the corner pattern in blue and the edges in black. 
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Actions 
Button Action Shortcut Description 

 

Black 

Cells 

B Sets the drawing pencil to use black cells which represent filled 

pattern content. 

 

White 
Cells 

W Sets the drawing pencil to use white cells which represent 
transparent areas in the pattern. 

 

Horizontal 
Mirror 

Ctrl + H Copy the left edge content to the top edge. 

 

Vertical 
Mirror 

Ctrl + V Copy the top edge content to the left edge. 

 

Clear All Ctrl + Del Clear all cells to blank content. 

 

Undo Ctrl + Z Undo the last change. Use Ctrl + Shift + Z to undo all changes 
since this window was displayed. 

 

Apply 
Changes 

Ctrl + S Apply all changes to the corner pattern and close the window. 

 

Close 
Window 

Ctrl + W Close the window and discard changes. 

 

Settings F2 Settings for the designer window. 

 

Help F1 Help topic for this window. 

 Edit 
Shortcut 

Keys 

 This window can use unqualified shortcut keys (without Shift, 
Ctrl or Alt) in case you want to use a different shortcut setup. 
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Multi-color Styles 
You need to check the option named This Border Contains Colors in the main 

designer window to enable multiple colors for a page border. When enabled, the 

page setup properties for the album will ignore any border color value – the colors 

are locked in to those set within the color designer window. 

The corner and edge patterns must be defined before applying a color value to each 

grid cell. Define the pattern for both the edges and corners in black and white, then 

use the color options for to fill each cell with a unique color. The window shown 

below is for the page corner pattern. The edge pattern designer window is identical 

in terms of options to apply the colors, so is not shown. 

 

The current color will always be used with the pencil to fill in colors. The white 

areas of the 32 x 32 grid can’t be set to a color as they are not part of the active 

corner pattern. 

To set the current color, click on any of the 32 colors in the palette on the right, or 

click the current color swatch to choose from more colors using a color picker 

window. When you hover over the color in the swatch or any color in the palette, its 

RGB value will be shown in the status bar to the left of the grid mouse coordinate. 
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Actions 
Button Action Shortcut Description 

 

Black 

Cells 

B Sets the drawing pencil to use black cells which represent filled 

pattern content. 

 

White 
Cells 

W Sets the drawing pencil to use white cells which represent 
transparent areas in the pattern. 

 

Clear All Ctrl + Del Clear all cells to blank content. 

 

Color 
Column 

Ctrl + 
Down 

Set all cells in a column you click to the current color. To avoid 
showing the popup hint window, hold down Shift while clicking 
on a cell in the column. 

 

Set 
Gradient 

Ctrl + G If you want to use a gradient of colors within the 32 colors of 
the palette, first define the start and end colors within the 

palette. Right click a color in the palette to change it. Then use 
the gradient option and click the start and end colors to apply a 
gradient between those two colors. 

 

Set Color Ctrl + C Set the current color value in the swatch from a cell that you 
click in the drawing grid. To avoid showing the popup hint 
window, use a right click with the mouse to set the current 
color. 

 

Undo Ctrl + Z Undo the last change. Use Ctrl + Shift + Z to undo all changes 
since this window was displayed. 

 

Reset 
Palette 

 Resets the color palette to the default 32 colors. 

 

Save 
Colors 

Ctrl + Shift 
+ S 

Save the current color palette to a file. 

 

Load 
Colors 

Ctrl + L Replace the color palette which was saved to a file. 

 

Apply 
Changes 

Ctrl + S Apply all color changes to the corner pattern and close the 
window. 

 

Close 
Window 

Ctrl + W Close the window and discard changes. 

 

Settings F2 Settings for the designer window. 

 

Help F1 Help topic for this window. 

 Edit 
Shortcut 

Keys 

 This window can use unqualified shortcut keys (without Shift, 
Ctrl or Alt) in case you want to use a different shortcut setup. 

 

Color Palette Mouse and Keyboard Actions 

To set the current color, left click on any color in the palette or click on the swatch 

to set a value from the color picker window. 

Hold down Ctrl while clicking any color in the palette with the left button to assign 

the current color to the position in the palette. 

Right click any color in the palette to set the value from the color picker window. 

When you click in the drawing grid on a non-white cell, the current color will be 

used to set the color. 
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Object Border Designer 
This designer window is used when the Object Borders tab is active. 

 

The preview area shows the border pattern applied to a shape as per the dropdown 

list choice. 

Setting the pattern for a border object type is done either in black and white format 

or using a color palette if the border is set to use multiple colors in the main 

designer window. 

Setting the pattern of line segments involves setting the pencil to draw mode or 

erase mode, selecting a color (if color mode is enabled) and clicking within the 

single column of cells to the right of the preview area. 
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Actions 
Button Action Shortcut Description 

 

Black 

Cells 

B Sets the drawing pencil to use the current color which 

represent filled pattern content. 

 

White 
Cells 

W Sets the drawing pencil to use white cells which represent 
transparent areas in the pattern. 

 

Clear All Ctrl + Del Clear all cells to blank content. 

 

Color All Ctrl + A Set all cells in the pattern to the current color. 

 

Set 
Gradient 

Ctrl + G If you want to use a gradient of colors within the 32 colors of 
the palette, first define the start and end colors within the 

palette. Right click a color in the palette to change it. Then use 
the gradient option and click the start and end colors to apply a 
gradient between those two colors. 

 

Set Color Ctrl + C Set the current color value in the swatch from a cell that you 
click in the drawing grid. To avoid showing the popup hint 
window, use a right click with the mouse to set the current 
color. 

 

Undo Ctrl + Z Undo the last change. Use Ctrl + Shift + Z to undo all changes 
since this window was displayed. 

 

Save 
Colors 

Ctrl + Shift 
+ S 

Save the current color palette to a file. 

 

Load 
Colors 

Ctrl + L Replace the color palette which was saved to a file. 

 

Apply 
Changes 

Ctrl + S Apply all color changes to the corner pattern and close the 
window. 

 

Close 
Window 

Ctrl + W Close the window and discard changes. 

 

Settings F2 Settings for the designer window. 

 

Help F1 Help topic for this window. 

 Transfer 
Colors 

Ctrl + T Transfer all colors used in the current pattern to the color 
palette, up to a maximum of 32 colors. 

 Edit 
Shortcut 
Keys 

 This window can use unqualified shortcut keys (without Shift, 
Ctrl or Alt) in case you want to use a different shortcut setup. 
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Line Styles Designer 
This designer window is the same one as used for Object Borders with one notable 

difference: The preview area shows the style in horizontal and vertical modes, with 

alternate rendering directions for both, which represent all variations of how the 

style can appear on an album page. 

The sample window below shows this designer in black and white format. 
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Dashed Line Format 
This window defines the dashed lines for object borders, line object styles and the 

page border top/left edges when the line style format is used. 

 

The top left part of this window is used to select line segments for applying or 

removing dashed formats. White areas represent transparent segments of the 

pattern and may not be adjusted. The black areas contain the active segments 

which make up the overall line style. Up to 32 segments make up a line style. Any 

unused segments (i.e., a thinner line) will not appear in this area. 

The current active segment is indicated with a small red indicator box on the left. 

Segments which are set to use dashes have a small blue indicator box on the right. 

Selected segments for applying or removing a dashed format are shown in green. 

When one or more segments are selected, the options on the right will be enabled. 

Choose Solid or Dashed to set the format for all selected segments. For dashed 

segments, set the dash/space values in pairs, up to 3 pairs total. The values for the 

dash/space fields is either relative to line weight or fixed in 1/300 inch units, 

depending on the Unscaled Dashed Lines checkbox option in the main designer 

window. 
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The Copy to Selected button is a shortcut to take the current solid/dashed line 

status from the active segment (the one with the red indicator box) and copy it’s 

settings to all other selected segments (the green lines). 

Use the All Solid or All Dashed buttons to set every non-transparent line segment 

to either a solid format or a dashed format. You may still need to adjust the 

dash/space values after setting all segments to dashed format. 

The bottom half of the window contains a preview of the line style. The unscaled vs. 

scaled dashed lines option will generally look remarkably different from one 

another, so you may wish to check the preview under both types. 

Sorting Borders/Line Styles 
Pre-supplied templates provided by SoftPro will always appear in a specific sort 

order and always appear above any custom templates you create in the dropdown 

lists. For custom styles, you can sort the entries in the dropdown list using the sort 

option. 

 

Only the custom styles will appear in the list on the left. You will need to assign 

every style from the left list to the right list. 

 

 

 

 

Available Actions 
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Button Action Shortcut Description 

 

Assign Ctrl + Right Assign the selected styles from the left list to the right 

list. You may also right click or double click entries to 

assign them. 

 

Unassign Ctrl + Left Remove selected styles from the assigned list. You may 
also right click or double click entries to the right list to 
remove them. 

 

Insert Ctrl + Ins Inserts the selected styles in the left list to the spot 
before the selected item in the right list. 

 

Exchange Ctrl + E Swaps two selected styles in the assigned list. 

 

Clear  Remove all current assigned styles. 

 

Move to 
Top 

Ctrl + Home Move selected styles in the assigned list to the top. 

 

Move Up Ctrl + Up Move selected styles in the assigned list up one position. 

 

Move 
Down 

Ctrl + Down Move selected styles in the assigned list down one 
position. 

 

Move to 
Bottom 

Ctrl + End Move selected styles in the assigned list to the bottom. 

 

Apply 

Changes 

Ctrl + S Save changes and close this window. 

 

Close 
Window 

Ctrl + W Close this window and discard changes. 

 

Help F1 Help topic for this window. 

 Edit 

Shortcut 
Keys 

 Edit the shortcut keys for this window. 
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Style Preview 
This option will show a page or object preview of the page, border or line object 

style at a scaled (fits withing the size of the preview window) or full size (using 

scrollbars) display format. 

 

The status bar shows the current border width in gray shading, the corner and edge 

sizes in inches or millimeters, and the mouse coordinate when you hover the cursor 

over the page area. 

Click the Border button to set a different border size. This is a visual indicator 

which lets you determine the relative thickness of a style when using the default 5 

mm border size from version 2 of AlbumGen. 

Click Full Size or Fit Window to set the corresponding page magnification level. 

Click Print to send the page border style to the printer. 
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The border preview for Line Styles and Page Objects has a slightly different format. 

The preview represents a shape or line object on a normal sized album page. 

 

The Properties button provides options to set the object type, size, corner style, 

line/dashed endings, fill color and weight. 

Check the Centered option to position the object in the middle of the page. 

Otherwise the object is placed at the top left corner. 
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  PLEASE READ CAREFULLY        

SOFTPRO 2001 LICENSE AGREEMENT 

The use of this package indicates your understanding and acceptance of the 

following terms and conditions. This license shall supersede any verbal or prior 

verbal or written statement or agreement to the contrary. If you do not understand 

or accept these terms you must remove this software from any computer system 

that it has been installed on and discontinue its use. 

COPYRIGHT:  This product is Copyright (c) SoftPro 2001, All rights reserved. This 

product is protected by Canadian and United States copyright laws, international 

treaties and all other applicable national or international laws. This software 

application and any accompanying documentation, images or any other component 

may not be copied, translated, or reduced, in whole or part, to any electronic 

medium or machine or human readable form, without prior consent in writing, from 

SoftPro 2001. SoftPro 2001 does not transfer title to the software package to you. 

You have the non-exclusive, non-commercial use of the software package. SoftPro 

2001 retains the full and complete title to the software package, and all intellectual 

property rights therein. 

PROPRIETARY RIGHTS AND RESTRICTIONS: Subject to this Agreement, 

SoftPro 2001 retains all copyrights, trade secret rights, patents, trademarks, and 

any other proprietary rights covering or relating to this software package. You 

acknowledge that the software package includes or incorporates proprietary and 

confidential information belonging to SoftPro 2001. All rights not expressly granted 

by SoftPro 2001. in this Agreement are reserved. All images supplied with the 

software are copyright protected and may not be used for any commercial use. 

EzStamp and all supplied images are strictly for PERSONAL use. You may not 

modify or alter the application executable code or any associated files. You may not 

attempt to unlock or bypass any copy protection or registration authentication 

algorithm incorporated in the program executable. You may not remove or modify 

any copyright notice, nor any dialog screens containing such copyright notices. 

LIABILITY DISCLAIMER: This software package and/or license is provided 'AS 

IS', without any representation or warranty of any kind, either express or implied, 

including without limitation any representations or endorsements regarding the use 

of, the results of, or performance of the product, its appropriateness, accuracy, 

reliability, or correctness. In no event shall SoftPro 2001 be liable for any losses, 

direct, indirect, consequential, or incidental damages arising out of use, the results 

of use, or inability to use this product. SoftPro 2001 does not warrant that the 

operation of the software package will be uninterrupted or error free. The entire 

risk as to the results & performance of this program is assumed by you. 

LIMITED WARRANTY:  SoftPro 2001 warrants that the physical contents 

(CD/DVD/BD) to be free from defects for a period of thirty (30) days from the date 

of purchase.  In the event of notification within the warranty period of covered 

defects in material or workmanship, the defective components will be replaced so 

long as you mail, freight prepaid, the defective material to SoftPro 2001. This shall 
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be the sole remedy for breach of this warranty & shall be limited to the replacement 

of the defective CD/DVD/BD.  

OPERATING LICENSE: One registered copy of AlbumGen may be used by a single 

person who uses the software personally on one or more computer systems or by 

multiple persons on a single workstation non-simultaneously. 

Use of AlbumGen over a LAN (Local Area Network), or a WAN (wide area network) 

is strictly prohibited under any circumstances. 

BACKUP AND TRANSFER OF LICENSE RIGHTS: You may make one copy of the 

program solely for back-up purposes as prescribed by Canadian, United States, and 

international copyright laws. You may not transfer the software package to any 

other person or third party. This license is effective until it is terminated. You may 

terminate the license by destroying the software package in its entirety, including 

any back-up copy you may have made. This license also terminates if you fail to 

comply with any terms or conditions of the license agreement. You agree upon such 

termination to destroy all copies of the software package and any associated 

documentation, or to return them to SoftPro 2001.  

You may not redistribute, sell, decompile, reverse-engineer, disassemble, or 

otherwise reduce the Software to a human-perceivable form. All other rights and 

restrictions not specifically granted in this license are reserved by SoftPro 2001. 

©2023 SoftPro 2001. ALL RIGHTS RESERVED. 

 


